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ABOUT THIS USER GUIDE

This user guide describes the configuration and management of IP/ MS/TP VAV control-
lers connected to a BACnet IP/ MS/TP network via an EAGLEHAWK controller. Configu-
ration, and Management are done using the Niagara IRM Engineering Tool based on the 
Niagara NX framework.

Note: The procedures and screenshots included in this user guide apply in the same way to 
other brands and their products if applied.

Important: In this guide, the MERLIN NX is referred to as an IRMNX controller in a few sections. 
Details of features and configuration provided in this guide are applicable to IRMNX 
Compact VAV controllers, Unitary FCU controllers, and IP/MSTP VAV controllers. 
However, few features might not be supported by VAV or Unitary FCU controllers.

It is recommended to carefully, read, understand, and consider the Notes and Important 
provided to address the differences in supported features per controller model.

Applicable Technical Literature

Other Applicable Technical Literature

Title Reference
IP VAV/MSTP Technical Literature 

IP Product Datasheet EN0Z-1073-GE51
MSTP Product Datasheet EN0Z-1072-GE51
Mounting Instructions EN1Z-1074-GE51
Installation Instructions EN1Z-1076-GE51
Honeywell Connect Mobile VAV Balancing application User Guide EN2Z-1086-IE67
IRM Function Blocks User Guide EN2B-0415-GE51
IRM Migration Guide EN2Z-1061-GE51

Title Reference
NIAGARA IRM Application Guide EN2B-0416-GE51
NX General Security Best Practices EN0Z-1040-GE51
NIAGARA Hardening Guide EN2Z-0985-GE51
MERLIN N4 Product Data EN0Z-1035-GE51
MERLIN N4 Installation Instructions EN1Z-1035-GE51
EAGLEHAWK NX Product Data EN0Z-1039-GE51
EAGLEHAWK NX Installation & Commissioning Instructions EN1Z-1039-GE51
EAGLEHAWK NX Panel Bus Driver User Guide EN2Z-1043-GE51

https://customer.honeywell.com/resources/Techlit/TechLitDocuments/31-00000s/31-00129.pdf
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IRM related technical literature can be downloaded at Product Catalog

System Requirements

EAGLEHAWK NX Onboard IO Driver User Guide EN2Z-1044-GE51
CENTRALINE NX BACNET UTILITIES DRIVER User Guide EN2Z-1020-GE51
ARENA NX / COACH NX Printout User Guide EN2Z-1022-GE51
HAWK 8000 User Guide EN2Z-1030-GE51

Title Reference

Niagara Honeywell N4.9.XX.XXX and higher

Firmware Download the latest firmware version from www.centraline.com

Engineering Tools Download latest IRM TOOL from www.centraline.com

Migration Tool spyderToIrmNxMigrator-wb .jar

Supported Models Controller Model Description

Compact VAV
CLME - VA423B24N IRM Compact VAV controller with integrated actuator
CLME - V423B24N IRM Compact VAV controller without integrated actuator

Unitary FCU Controller
CLME - RL4N
CLME - RL6N
CLME - RL8N

Unitary FCU Controller with large housing 

CLME - RS4N
CLME - RS5N Unitary FCU Controller with small housing 

IPVAV Controller
CLME - VA75124NM IPVAV Controller with IP communication
CLME - VA001B4NM IPVAV Controller with IP communication and BLE supported
CLME - VA751B24NM IPVAV Controller with IP communication and BLE supported

MS/TP VAV Controller
CLME - VA75M24NM MS/TP VAV Controller with MS/TP communication

CLME - VA75MB24NM MS/TP VAV Controller with MS/TP communication and BLE 
supported

CLME - VA00MB24NM MS/TP VAV Controller with MS/TP communication and BLE 
supported

http://173.212.195.200/view/MAST.EN/MAST/group/online/docs/CLNXMERLIN.htm
https://www.centraline.com/partnerweb/

https://www.centraline.com/partnerweb/
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Restrictions and Recommendations
For successful and seamless engineering, it is recommended to note the following inter-
nal system restrictions:

Maximum number of BACnet IP 
devices

Maximum number of BACnet IP devices (15 Proxy points/20 Ref in/out 
per device)
• 100 devices in Daisy chain (Local Station) 

Maximum number of BACnet IP devices EHN4 (15 Proxy points/20 Ref 
in/out per device) / Hawk (15 Proxy points/20 Ref in/out per device)
• 40 devices in Daisy/Ring network.

Depending on the performance needs of the application and bus 
traffic, it is recommended to keep the number of devices below 40.

• 100 devices in Daisy chain (Only in swap out mode) - Engineering 
to be carried out in local station.

Maximum number of BACnet MSTP 
Devices

Maximum number of BACnet MS/TP devices per channel (15 Proxy 
points/20 Ref in/out per device)
• 40 devices with BACnet MSTP router

It is recommended a lower number of BACnet MS/TP devices 
depending on communication needs (traffic) and performance 
needs of the application).

Maximum number of controllers / Hawk 8000 (15 Proxy points/20 Ref 
in/out per device)
• 40 devices with HAWK 8000 

Depending on the performance needs of the application and bus 
traffic, it is recommended to keep the number of devices below 40. 

Maximum number of controllers / EagleHawk (15 Proxy points/20 Ref 
in/out per device)
• 32 devices with ENH4 

Depending on the performance needs of the application and bus 
traffic, it is recommended to keep the number of devices below 32.

Controller Memory Usage

• Compact VAV: 344 KB
• Unitary FCU: 344 KB
• IP/MSTP VAV: 2 MB

Note: Controller memory usage is up to 70% for all the Unitary Control-
lers while working on HAWK/EHN4/Supervisor Station.
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Function Blocks Usage

• Maximum 32 IRM folders overall (IRM CVAV/FCU controller)
• Maximum 100 IRM folders overall (IP/MSTP VAV controller)
• Maximum 100 function blocks per folder
• Maximum 2000 function blocks overall (IRM CVAV/FCU controller)
• Maximum 6000 function blocks overall (IP/MSTP VAV controller)
• Sylk device configuration limited by Sylk power consumption
Note: The WmConfigHvacA function block can be placed max. 3x onto 
the wiresheet, but only 1x it can be configured as a Sylk Wallmodule. 
Instead of a Sylk Wallmodule, the function block can also be configured 
as a wired wall module or as an external wall module (e.g. a Modbus 
Wallmodule). 
Example: One Sylk Wallmodule and two Modbus Wallmodules can be 
used in the same application.

Baud Rate

BACnet MSTP Baud Rate: 9.6 Kbps through maximum 76.8 Kbps 
(Default Baud rate = 38400 Kbps)
Supported Baud Rate: 9600, 19200, 38400 (default), 57600, 76800

Modbus Default Baud Rate: 19.2 Kbps
Supported Baud Rate: 1200, 2400, 4800, 9600, 14400, 19200 
(default), 38400, 57600, and 115200.

Max no of Modbus Registers per 
controller 155

Max no of High Priority Registers per 
controller 6

Maximum Wall Module/device 
(Any Wall module even Sylk)

The maximum number of wall modules depends on the following wall 
module specific information:
• Sylk bus power consumption
• Number of parameters used
• Total config file size. The IRM NX tool has an inbuilt resource 

calculator to calculate the amount of Sylk wall modules

Recommended BLE device discovery 
over Balancing App 5 devices (Based on BLE Signal Strength)

Recommended BACnet device 
discovery over BLE Gateway (IP/
MSTP) through App

Recommended to search with BACnet Instance Range

IP Device as BLE gateway • Max 10 IP devices will be discovered with defined instance range.
• Max 25 MSTP devices will be discovered with defined instance 

range 

MSTP Device as BLE gateway • Max 20 IP devices will be discovered with defined instance rang
• Max 25 MSTP devices will be discovered with defined instance 

range
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Security Best Practices
This section provides the necessary information about the requirements for configuring 
and managing the security when installing and maintaining a product or system.

Honeywell hereby expressly states that its controllers are not inherently protected 
against cyber-attacks from the Internet and that they are therefore intended solely for 
use in private networks. However, even private networks can still be subject to malicious 
cyber-attacks by skilled and equipped IT individuals and thus require protection. Cus-
tomers should therefore adopt the installation and security best practices guidelines for 
Honeywell BACnet MS/TP-based products to mitigate the risk posed by such attacks.

The following checklist describes the General Security Best Practices for Honeywell 
BACnet MS/TP-based products. 

They are listed in order of increasing mitigation. The exact requirements of each site 
should be assessed on a case-by-case basis. The majority of installations implementing 
all of the mitigation levels described here will be far more than that required for satisfac-
tory system security.

Since the attached Modbus network is implemented via SERIAL interface (RS485) no 
security protocol (SSL/TLS) is available. Any vulnerabilities based on the open Modbus 
protocol might damage the application in the IRMNX controller.

Incorporating the security checklist items 1-5 will meet the requirements for most auto-
mation control network installations.

For additional information refer following documents:

• NX General Security Best Practices (EN0Z-1040GE51)
• Niagara 4 Hardening Guide — EN2Z-0985GE51

Security Check List

• Use the latest version of IRM Programming Tool that including firmware and software 
modules.

• Include the CentraLine N4 installation files, configuration files (including station backup), 
certificates, and licenses in the disaster recovery plan.

• Make sure that the PC running CentraLine N4 latest version, make sure to secured against 
unauthorized physical access.

• Make sure that the local Ethernet network that the PC is connected to is secured, for example, 
using firewalls and intrusion detection systems.

• The PC is running the latest version of the Windows operating system, with all updates and 
have virus protection software running.

• Appropriate user accounts are set up on PC and access to files is restricted to only those who 
are authorized.

• CentraLine N4 is configured to use HTTPS using a certificate from a trusted Certificate 
Authority.

• CentraLine N4 is configured to backup data regularly to a secure location as per your 
company's backup policy.

• Ensure that complete commissioning is carried out in a closed local area network without 
connecting to the internet to avoid unauthorized sniffing of BACnet message packets. 

• Use encrypted communication between the Niagara Tool and the controller. See chapter 
"Secure Communication".

https://customer.honeywell.com/resources/Techlit/TechLitDocuments/31-00000s/31-00129.pdf
https://customer.honeywell.com/resources/Techlit/TechLitDocuments/31-00000s/31-00129.pdf
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INTRODUCTION

The IRM Engineering Tool provides flexible, freely programmable, demand-led control 
that delivers tangible benefits to reduce energy spends and drives new levels of func-
tionality and efficiency in today’s buildings. With scalable and freely programmable BAC-
net IP/ MS/TP-based room controllers, smart engineering & commissioning tools, and 
SYLK technology, multiple and flexible configurations can be achieved to address spe-
cific applications.

The IRM Engineering Tool is supported to Compact VAV controllers, IP/MSTP control-
lers, and FCU controllers. 

The IRM Program Tool provides the work environment for engineering the controllers.

Operation in IRM Engineering Tool
Following operation you can perform on the IRM Engineering Tool:

IRM Engineering Tool Operation
Configure BACnet device using online and offline Engineering Mode

Engineering modes

There are two kinds of engineering modes you can use for engineering an IRM 
project:
Offline Engineering
In this mode, you create an empty BACnet device manually, add an application 
(optional) and match it afterward to a device discovered on the bus by using the 
service pin. This is normally applied when doing the engineering in the office 
without having the hardware available but knowing the hardware specification of 
the devices to be used later at the plant.
Online Engineering
In this mode, you discover the devices on the BACnet network in the first step and 
use the devices instantly for application engineering. This is recommended when 
doing the engineering directly at the plant with the devices already installed on the 
BACnet bus
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Synchronicity 
Status Check

The current content of the applications engineered in the project and running in 
the connected IRMNX controller is permanently monitored by the Control 
Manager (Online engineering only). Modifications can be detected in the 
controller, or the project, or both. They can be synchronized by applying the 
following actions: 

• Teach to controller
• Learn from controller
• Clear project (as required)
• Clear controller (as required)

Configurations in IRM BACnet device
Tuning Policies Defines rules for evaluating both write requests, which is to writable proxy points, 

as well as the acceptable “freshness” of read requests that result from polling. It 
includes standard tuning policy properties and additional properties related to 
client-side usage of the BACnet Subscribe COV service.

IP Setting IP Config operation is provided to ease IP configuration for multiple IP VAVs from 
a single window. This feature allows user to perform many productivity operation 
like batch update of IP configuration, auto-increment of IP addresses, visual 
indication of modifications to IP addresses, user errors in IP configuration, offline 
and online IP configuration.

Bluetooth 
Configuration

BLE Config is provided to batch configure BLE configuration for Beats IP and 
MSTP devices. This feature allows user to perform operation like configure the 
BLE enable/disable function, setting password, BLE enable start and end time to 
enable mobile balancing application to connect to the devices over BLE.

Factory Device 
Handling

This section provides information on  Default Factory Device ID Settings, IRM 
Configuration Settings and Assignment of Unique Device IDs.

VAV System A Variable Air Volume (VAV) system allows a single unit to provide the 
appropriate amount of cooling to multiple zones with different cooling loads. The 
VAV regulates the volume of the air to the zone by opening or closing the damper. 
This damper is controlled by a floating motor, which is installed on an integrated 
actuator of the IRM Compact VAV controller.

Link Creation Links are the basic mechanism of execution flow in the Niagara Framework. Links 
allow components to be wired together graphically by propagating an event from 
one slot to another slot. 

Flow Balancing 
View

The Flow Balancing tool can be configured with various parameters and 
indicators to optimize the calibrations, which are used to balance the airflow. 

Modbus Interface 
Engineering

Features a removable non-isolated RS485 interface suitable for Modbus commu-
nication.

Note:  Modbus Engineering interface is supported by IRM Unitary FCU 
controllers (WEB-RL6N and WEB-RS5N).

Configurations in Control Manager
Memory Usage The IRM Engineering Tool provides a memory consumption check of the current 

application in the tool. This is an approximate calculation of the application in the 
tool but not a real-time consumption within the controller.

IRM Engineering Tool Operation
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Flash Memory 
Exceeded FBs & 
IRM Folder

Using the details from Flash Memory Exceeded FBs & IRM Folder section, the 
user can verify the property sheet and re-configure the respective Function block, 
IRM folders, or subfolders to the defined limit.

Application Details The Application Details property sheet allows you to keep a record of application 
version details. 

Custom Sensor 
Configuration 
Details

If the sensor does not meet any standard characteristics of the available sensors, 
you can select the Type as Custom Sensor and set its characteristics. There are 
three types of custom sensors available Current, Voltage and Resistive.

Day Light Savings 
Day Light saving 
setting

Daylight saving setting is a part of the control manager and enables the user to 
configure the day light setting when comes into effect.

Global Balancing 
Object

The Global VAV Balancing tool is an intuitive tool developed to perform balancing 
and calibration for VAV controllers. You can perform Setpoint balancing, Max-Min 
balancing, Zero calibration, and Move damper procedures. For more details, refer 
to Global VAV Balancing tool- EN2B-0041 IE10 R0121 and Global VAV 
Application Design User Guide.

Alarms Provides the notification classes for establishing alarming.
IRM Controller 
Diagnostics

The IRMNX controller diagnostics primarily monitors the activity in Control 
Engine, BACnet, Modbus Trace, and Sylk Trace.

Components of IRM Program
Control Manager The control manager takes care of the major control functions and displays the 

current status of the IRM program accordingly. The following information is 
provided:

Periodic Program Creates the control strategy running in a cyclic manner on a fixed time base. All 
function blocks in the root folder and its subfolders are processed. The periodic 
program is executed every 500 ms within the controller.

Event Program Includes event-driven control strategy triggered by particular I/O changes.

IRM Engineering Tool Operation

• Author of the 
application

• Flash Memory 
Exceed FBs & 
IRM Folder

• Synchronization 
Status

• Application 
Details 
Config

• Description • Hardware 
Compatibility

• Drop of BACnet point 
settings

• Global 
Balancing 
Object

• Device Model 
Name

• Controller 
connection 
type

• Last program 
changes and 
commissioning dates

• Application 
type

• Teaching 
Mode

• Modbus Baudrate 
and Parity 
configuration

• Function 
block family, 
version, and 
numbers

• Measurement 
Type • Sylk Device details

• Number of 
folders and 
links

• AirFlow Unit • Custom Sensor 
Config Details

• Memory 
usage

• Communication S
tatus • Day Light Savings
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Onboard IO Shows the hardware configuration for which the application is designed. 
Alarms Provides the notification classes for establishing alarming.
Common Operation of IRM Program Tool
Teaching To 
Controller

Downloads the application in the project to the controller.
Any modifications in either the project or the controller can be synchronized in one 
of the following modes:

• On-demand - will be performed explicitly as desired by the user
• Immediate - occurs instantly when the change is done

Note:  If a user performing the bulk cut-paste operation in Immediate mode, it 
will take more time to complete.

It is recommended for a user to perform bulk cut-paste only in On-
demand mode

Teaching Full 
Application To 
Controller

Teach Full Application To Controller clears all the previous configurations from 
the controller and downloads the new configuration of the project to the controller. 

Learning from 
Controller

Uploads the application from the controller in the project

Learning from 
Controller

Learn from Controller uploads the current application from the controller in the 
project. The teaching mode does not care in this case.

Checking 
Hardware 
Compatibility

The hardware configurations of the used physical controller and the hardware 
defined for the controller in the application can be checked. Any differences are 
indicated graphically on the terminals on the wire sheet.

Check Application 
Compatibility

To check the status of the Application Software, see the 'Property Sheet view' of 
the IrmBacnetDevice.

Clearing Controller This feature allows to clear the controller from the database.
Clearing Project This feature allows to clear the application from the controller.
Taking Snapshot The current status of an application can be backed up and restored later.
Restore Snapshot This allows restoring a changed application if these changes should be discarded.
Swapping IRM 
Program

Swapping saves RAM space and reduces processor load and bus traffic. The 
current state of a swapped device is frozen and saved to an IRM repository on the 
disk. Then, synchronization is no more possible. 
In order to synchronize swapped-out devices, the devices must be swapped in 
again. Swapping can be applied to a single or to all devices per step. 

Set Controller 
Password

This feature allows user to set user-defined password in the controller, this 
password is sent to the IRMNX controller, then the controller cannot be accessed 
without this password.

Note:  Starting from Controller version 1.0.1.9 and Niagara IRM Engineering 
Tool version 1.0.1.7, Secure Commissioning Communication is 
implemented for IRMNX controller commissioning.

Reset Tool 
Password

This feature allows user to reset user-defined password of the controller.
Resetting a controller password can only be done by conducting a Reset to the 
factory, refer to Factory Device Handling.

IRM Engineering Tool Operation
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Update All BACnet 
Object Values 
From Controller To 
Application

Update All BACnet Object Values From Controller To Application option allows to 
synchronize the controller values with the IRM application values. Besides that, 
when you run a Full teach to the controller, this feature makes sure that the values 
in the controller are not over-written by Wire Sheet values when the two values 
are not in sync (i.e. it will retain the object values from the controller).

Other Operation in IRM Program Tool
VAV System A Variable Air Volume (VAV) system allows a single unit to provide the 

appropriate amount of cooling to multiple zones with different cooling loads. The 
VAV regulates the volume of the air to the zone by opening or closing the damper. 
This damper is controlled by a floating motor, which is installed on an integrated 
actuator of the IRM Compact VAV controller.

Reference 
Datapoints Usage

If the control and monitoring system contains more than one BACnet device 
(controller), the devices communicate with one another via the BACnet MSTP 
protocol. This enables one controller to read values from other controllers and set 
values on other controllers.
This data communication is realized via reference input and reference output 
points which are assigned to physical or value BACnet points. 
Assignments can be done manually (manual creation and mapping) or 
automatically (automatic creation via drag & drop).

Master Sync The "Master Sync" function is based on a group of multiple devices that must 
have the same application type. This is called a master sync group. The master 
sync group is established via the "Clone Application" function which clones the 
application of one selected device (template) to multiple devices.

Splitting-Off 
Application

Splits the unique application of the master sync group into a new application and 
keeps the existing application. For the new application, you can enter a different 
IRM program name. A new IRM application type is issued automatically by the 
software. The new application can then be cloned to form the new master sync 
group.

Controller MAC 
Address 
Assignment

This section provides information for Automatic MAC Address Assignment, 
Manually Changing MAC Addresses, Swapping MAC Addresses, MAC Address 
Configuration and Auto MAC Configuration.

Cloning Application Clones the device application based on a selectable template (device) to 
selectable devices. As result, all devices will receive the same application type 
which is the basis of a master sync group.

Firmware 
Download

Allows updating the firmware in the controller via download.

Sylk Device 
Programming

Sylk-enabled sensors saves I/O on the controller and is faster and cheaper to 
install since only two wires are needed and the bus is polarity insensitive.

Making Controller/
Application Backup

This section provides steps to create controller or application backup.

Reset to Factory 
Delivery

This section provides steps to reset controller.

IRM Engineering Tool Operation
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System Architecture for IP VAV Controller

The following schematic shows an example for a BACnet IP based system connected to 
two IP VAV controllers controllers. The system is engineered using the IRM Engineering 
Tool based on the Niagara framework (version 4.9 or higher).

Figure  1. System Architecture of IRM Engineering Tool for IP VAV Controller
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System Architecture for MSTP VAV Controller

The following schematic shows an example for a BACnet MS/TP based system contain-
ing an EAGLEHAWK controller as a router and two MSTP controllers for room control. 
The system is engineered using the IRM Engineering Tool based on the Niagara frame-
work (version 4.9 or higher).

Figure  2. System Architecture of IRM Engineering Tool for MSTP VAV Controller
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SETUP IP/ MSTP CONTROLLER 

Setup IP/ MSTP controller section contains following sections.

• Setup MS/TP Controllers

• Setup IP Controllers

• Configuring IRM BACnet Device

• Adding IRM Application Template to Palette

• Baud Rate Note

• Tuning Policies

It is assumed that you are familiar with basic Niagara techniques and functions, such as 
creating platforms, stations, and networks, etc.

Note: Make sure that the IRMNX controller and EAGLEHAWK controllers are properly 
connected. Refer MERLIN N4 Installation Instructions - EN1Z-1035GE51 and 
EAGLEHAWK NX Installation & Commissioning Instructions - EN1Z-1039GE51.

Make sure that the following steps were done prior to working with the IRM Engineering 
Tool. 

If not available in the current Niagara N4 installation, download the following files from 
www.centraline.com and copy the files to the Modules folder.

• airFlowBalancer • honIrmAppl-rt • honIrmControl-rt.
• docHoneywellSylkDevice-doc • honIrmConfig-doc • honIrmControl-ux
• honeywellSylkDevice-rt • honIrmConfig-rt • honIrmControl-wb
• honeywellSylkDevice-ux • honIrmConfig-wb • spyderToIrmNxMigrator-wb
• honeywellVersionManager-rt • honIrmControl-doc •



https://www.centraline.com/partnerweb/
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Setup MS/TP Controllers 
To access the MS/TP controllers via Niagara IRM Engineering Tool or supervisor, a 
BACnet MS/TP router must be implemented. For this purpose, it is recommended to use 
the EAGLEHAWK NX/ HAWK 8000 controller as MS/TP router which can host and run a 
station.

MS/TP Controller System Architecture 

Figure  3. MS/TP Controller System Architecture

Note: For detailed information on standard Niagara techniques and functions, please refer to 
Niagara online documentation and HAWK 8000 User Guide: EN2Z-1030GE51.

Prerequisites
• Connect Hawk 8000/ MSTP controller via ethernet cable.

• Connect MS/TP controllers to the Hawk 8000/ MSTP controller.

Follow the below steps to setup MS/TP controller using HAWK 8000/EAGLEHAWK 
Controller as MS/TP router.

1. Steps up BACnetNetwork

2. Configure MstpPort in Niagara Workbench

3. Commissioning on a Supervisor station

4. Transfer the station to a Hawk 8000 or EagleHawk
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Steps up BACnetNetwork
Step 1. Open the platform on the PC.
Step 2. Start creating the station using the New Station Wizard.
Step 3. In the New Station Wizard dialog, select the 'CLNXEaglehawkNX.ntpl' 

template.

Step 4. Enter the station name as "Supervisor Station."
Step 5. Start and connect to "Supervisor Station."
Step 6. In the Nav sidebar, expand the Station folder, and double-click on Drivers.
Step 7. Open DriverManager view and click New.
Step 8. Select BacnetNetwork from the drop-down and click OK. This adds 

BACnetNetwork under Supervisor station.
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Step 9. Expand BACnetNetwork. 

To access MS/TP controllers via HAWK 8000/ EagleHawk controller, the MstpPort must 
be configured in the Niagara workbench.

Configure MstpPort in Niagara Workbench
Step 10. Navigate to Palette, click on Open Pallet, and enter bacnet in the filter field.

Step 11. Select bacnet module from search result and click OK. This adds bacnet 
module in the Palette.

Step 12. Go to Palette, open the bacnet module and expand NetworkPorts folder.
Step 13. Select MastpPort from NetworkPorts folder and drag-drop it under Drivers > 

BacnetNetwork > Bacnet Comm > Network. This adds MstpPort under 
Network property.
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Step 14. Navigate to Drivers > BacnetNetwork > Bacnet Comm > double-click 
Network and expand MstpPort property.

Step 15. Enter the following values:
•   Network Number = Any number less or equal than 65535 (for example, 56) 

•   Port Name = RS485_1

•   Baud Rate = Baud_38400 (see also Baud Rate Note)

•   Enabled = true
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Step 16.  Go to Local Device property set the Character Set to ISO 10646_UTF8.

Important: All the device support UTF-8 format, so when user set the device name using device 
object, the tool shall write the data in UTF-8 format.

Ensure that before changing the device name, the BACnet network is 
configured for character set UTF-8, or else the VAV balancing app device 
discovery page will not display the device.

Step 17. Click Save. This saves the MstpPort configuration on the Supervisor station.

Note: If any of the configuration settings are changed during operation, you must restart the   
MSTP/ IP router (see also Baud Rate Note).

Commissioning on a Supervisor station
Step 18. Right-click on BacnetNetwork > Views > IrmBacnetDeviceManager view.
Step 19. Perform Discover operation in the IrmBacnetDeviceManager view This 

action list down all the live MS/TP controllers connected to the HAWK 800/ 
EagleHawk controllers.

Step 20. Select all the controllers and click Add. This opens the Irm Bacnet Device 
property sheet.
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Step 21. Enter the following details:
•  Name - Rename the device name

•  Type - Select the device from the drop-down list

•  Device ID - Enter the device ID

•  Network address - Enter the network address

•  MAC Address - Enter the MAC address

•  Enabled - Select true or false from the drop-down

•  Use Cov - Select true or false from the drop-down, to get more details on 
Cov refer Tuning Policies. 

•  Use Cov property - Select true or false from the drop-down

•  Keep Max Cov Subscriptions as max

Perform the desired engineering operations in the controller, refer Common 
operation of IRM Program. All the configured operation is saved in the local 
Nagara workbench. 
After completing engineering operation in the controller. You need to transfer 
the local database to Hawk 8000/ EagleHawk station, before transferring local 
database, you need to perform Swap Out the operation on all the controllers.
Swap Out saves RAM space and reduces processor load and bus traffic. The 
state of a swapped out device is frozen and saved to an IRM repository on the 
disk. The swapped out device is indicated by a proxy that inherits and shows 
the minimum information of the device. 
Important: To get seamless performance, It is strongly recommended to 
swap-out the Hawk-8000/ EagleHawk controller after finishing the 
engineering in online or offline mode in the station.

Step 22. Go to IrmBacnetDeviceManager view, select the controller from the 
database, and click Swap Out.

Or 
To swap out all the controllers in the database.
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Right-click on the IrmConfig folder > Action > click Swap Out. This action 
swap out all the controllers under BacnetNetwork.

Result: The device is swapped out. On the Property Sheet, the proxy is 
displayed. In the tree, the IRM program is shown without any subfolders.

Step 23.  Save the station.
Recommendation: It is recommended to keep the backup of the station after 
making major changes in the controller or station. 

Step 24. Go to Platform and run Station Copier. This open station copier window.
Step 25. Select the station from localhost section and click Copy to the computer. This 

action copies saved station from localhost of Niagara workbench to computer.
Transfer the station to a Hawk 8000 or EagleHawk
Step 26. Run the Hawk 8000/ EagleHawk Platform and run Station Copier. This open 

station copier window.
Step 27. Select the saved station from the computer section and click Copy to 

localhost. This action copies saved the station from computer to localhost of 
the Hawk-8000/ EagleHawk controller.
Recommendation: It is recommended to keep all the controllers in the swap 
out mode in the Hawk-8000/ EagleHawk controller station to get seamless 
performance.
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Setup IP Controllers 
To access the IP controllers via Niagara IRM Engineering Tool or supervisor, a BACnet 
IP router must be implemented. For this purpose, it is recommended to use the EAGLE-
HAWK NX/ HAWK 8000 controller as router, which can host and run a station.

IP Controller System Architecture 

Figure  4. IP Controller System Architecture

Note: For detailed information on standard Niagara techniques and functions, please refer to 
Niagara online documentation and HAWK 8000 User Guide: EN2Z-1030GE51.

Prerequisites
• Connect Hawk 8000/ MSTP controller via ethernet cable.

• Connect IP controllers to the Hawk 8000/ MSTP controller.
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Follow the below steps to setup IP controller using HAWK 8000/EAGLEHAWK Control-
ler as IP router.

1. Steps up BACnetNetwork

2. Configure IP Port in Niagara Workbench

3. Commissioning on a Supervisor station

4. Transfer the station to a Hawk 8000 or EagleHawk

Steps up BACnetNetwork
Step 1. Open the platform on the PC.
Step 2. Start creating the station using the New Station Wizard.
Step 3. In the New Station Wizard dialog, select the 'CLNXEaglehawkNX.ntpl' 

template.

Step 4. Enter the station name as "Supervisor Station."
Step 5. Start and connect to "Supervisor Station."
Step 6. In the Nav sidebar, expand the Station folder, and double-click on Drivers.
Step 7. Open DriverManager view and click New.
Step 8. Select BacnetNetwork from the drop-down and click OK. This adds 

BACnetNetwork under Supervisor station.
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Step 9. Expand BACnetNetwork. 

To access MS/TP controllers via HAWK 8000/ EagleHawk controller, the MstpPort must 
be configured in the Niagara workbench.

Configure IP Port in Niagara Workbench
Step 10. Expand Bacnet Comm > Network > double-click on IP Port.

Step 11. Select the BACnet Wifi adapter from drop-down list. Make sure the Station 
and BACnet Wifi adapter in same subnet in the computer.

Step 12. Click Save. 
Step 13. Go to Local Device property set the Character Set to ISO 10646_UTF8.

Important: All the device support UTF-8 format, so when user set the device name using device 
object, the tool shall write the data in UTF-8 format.
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Ensure that before changing the device name, the BACnet network is 
configured for character set UTF-8, or else the VAV balancing app device 
discovery page will not display the device.

Step 14. Click Save.

Note: If any of the configuration settings are changed during operation, you must restart the IP 
router.

Commissioning on a Supervisor station
Step 15. Right-click on BacnetNetwork > Views > IrmBacnetDeviceManager view.
Step 16. Perform Discover operation in the IrmBacnetDeviceManager view This 

action list down all the live IP controllers connected to the HAWK 800/ 
EagleHawk controllers.

Step 17. Select all the controllers and click Add. This opens the Irm Bacnet Device 
property sheet.

Step 18. Enter the following details:
•  Name - Rename the device name

•  Type - Select the device from the drop-down list

•  Device ID - Enter the device ID

•  Network address - Enter the network address

•  MAC Address - Enter the MAC address

•  Enabled - Select true or false from the drop-down
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•  Use Cov - Select true or false from the drop-down, to get more details on 
Cov refer Tuning Policies. 

•  Use Cov property - Select true or false from the drop-down

•  Keep Max Cov Subscriptions as max

Perform the desired engineering operations in the controller, refer Common 
operation of IRM Program. All the configured operation is saved in the local 
Niagara workbench. 
After completing engineering operation in the controller. You need to transfer 
the local database to Hawk 8000/ EagleHawk station, before transferring local 
database, you need to perform Swap Out the operation on all the controllers.
Swap Out saves RAM space and reduces processor load and bus traffic. The 
state of a swapped out device is frozen and saved to an IRM repository on the 
disk. The swapped out device is indicated by a proxy that inherits and shows 
the minimum information of the device. 
Important: To get seamless performance, It is strongly recommended to 
swap-out the Hawk 8000/ EagleHawk controller after finishing the engineering 
in online or offline mode in the station.

Step 19. Go to IrmBacnetDeviceManager view, select the controller from the 
database, and click Swap Out.

Or 
To swap out all the controllers in the database.
Right-click on the IrmConfig folder > Action > click Swap Out. This action 
swap out all the controllers under BacnetNetwork.
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Result: The device is swapped out. On the Property Sheet, the proxy is 
displayed. In the tree, the IRM program is shown without any subfolders.

Step 20.  Save the station.
Recommendation: It is recommended to keep the backup of the station after 
making major changes in the controller or station. 

Step 21. Go to Platform and run Station Copier. This open station copier window.
Step 22. Select the station from localhost section and click Copy to the computer. This 

action copies saved station from localhost of Niagara workbench to computer.
Transfer the station to a Hawk 8000 or EagleHawk
Step 23. Run the Hawk 8000/ EagleHawk Platform and run Station Copier. This open 

station copier window.
Step 24. Select the saved station from the computer section and click Copy to 

localhost. This action copies saved the station from computer to localhost of 
the Hawk 8000/ EagleHawk controller.
Recommendation: It is recommended to keep all the controllers in the swap 
out mode in the Hawk 8000/ EagleHawk controller station to get seamless 
performance.



EN2B-0414GE51 R1021 36

NIAGARA IRM ENGINEERING TOOL - USER GUIDE

Configuring IRM BACnet Device

Adding IRM BACnet Device

Procedure

Step 1. Go to Palette.

Step 2. Click on Open Pallet, and in the filter field enter honIrmControl.

Step 3. Select honIrmControl and click OK.
Step 4. Navigate to the pallet, open the honIrmControl.

Step 5. Drag and drop IrmBacnetDevice under Drivers > BacNetwork from the 
honIrmControl paette.
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This adds IrmBacnet Device under BACnet Network.

Setting Measurement Type

Before starting with the application engineering, it is important to define the correct mea-
surement type in order to assure that the proper engineering units are used throughout 
the project.

Procedure

Step 1. In the Nav tree, go to BacnetNetwork > IrmBacnetDevice > expand IRM 
Program folder.

Step 2. Double click on the Control Manager.
Step 3. On the Property Sheet, in Measurement Type, select the desired type of 

engineering units from:
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•  SI-Metric - To set measuring unit as SI-Metric, select Measurement Type 
as SI-Metric and Air Flow Unit as Cubic Meter Per Hour or Liter Per 
Second.

•  Imperial - To set measuring unit as Imperial, select Measurement Type as 
Imperial and Airflow Unit as Cubic Feet Per Minute.

Baud Rate Note

BACnet MSTP Baud Rate

The following Baud Rates for the MSTP interface in the IRMNX controller are supported:

The Baud Rate of each IRMNX controller on the BACnet MSTP bus is automatically set 
by the defined Baud Rate of the BACnet IP – MS/TP Router (EAGLEHAWK controller) 
after the IRMNX controllerIRMNX controller is powered up and connected to the BACnet 
MS/TP bus.

Setting or changing the Baud Rate of a single IRMNX controller is not possible. 

When changing the Baud Rate of the BACnet MSTP bus of a running system, any con-
nected IRMNX controller must be power-cycled to adapt the changed baud rate.

Note: Application Teach Fails in the IRM Device with the Baud Rate 115200.

Modbus Default Baud Rate: 

Following are the Modbus supported Baud rate.

Tuning Policies

Defines rules for evaluating both write requests, which is to writable proxy points, as well 
as the acceptable “freshness” of read requests that result from polling. It includes stan-
dard tuning policy properties and additional properties related to client-side usage of the 
BACnet Subscribe COV service.

9600 (default) 57600

19200 76800

38400

1200 9600 38400

2400 14400 57600

4800 19200 (default) 115200
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For more details about tuning policies, refer to the Niagara Drivers Guide.

Note: If the controller supports COV, it is recommended to use this feature, it will optimize the 
bandwidth of the controller. IRMNX controller supports upto 20 points for COV. Since 
there a is limitation in the Niagara framework on the COV feature, it is recommended to 
configure only upto 20 points and rest of the points for polling.

IrmBacnet Device comes with default IRM Tuning policy which enables COV feature. 
Whenever you perform BacnetNetwork discover for IrmBahnet device tool automatically 
create IrmTuningPolicy.

It is recommended to categories critical and less critical points, based on that you can 
assign the policy to all the different points. So that the critical points can be polled more 
frequently, and less critical points can be polled less frequently, this configuration helps 
to optimize the bandwidth.

To assign a policy.
 Step 1. Add points from the IRM point discovery manager. 
 Step 2. While configuring the point, assign the tuning policy from the drop-down list.

One way to access these properties is by expanding BacnetNetwork > Tuning Poli-
cies or double-clicking Default Policy.
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Property Value Description
Min Write 
Time

Time 
(defaults to 0)

Specifies the minimum amount of time allowed 
between writes to writeable points. This causes the 
system to write only the last value that occurs during 
this minimum time period, which serves to throttle 
rapidly changing values, improving system 
performance.
A value of zero (0, the default) disables this feature 
causing the system to attempt to write all values.

Max Write 
Time

Time 
(defaults to 0)

Specifies the maximum amount of time to wait before 
rewriting the same value to a writable point in case 
nothing else triggers a write. Any write action resets 
this timer.
A value of zero (0, the default) disables this feature 
resulting in no timed rewrites.

Write On 
Start

True 
(default) or 
False

Determines writeable proxy point behavior when a 
station starts.

Note: Consider setting to false except for critical proxy points, 
otherwise large networks may experience write-queue-
overflow exceptions.

Write On Up True (default) 
or False

Determines writable proxy point and parent device 
behavior when a status transitions from down to up.
If true, a write occurs when the parent device 
transitions from down to up.
If false, no write occurs.

Write On 
Enabled

True (default) 
or False

Determines writable proxy point behavior when the 
point’s status transitions from disabled to normal 
(enabled).
If true, a write occurs when the point transitions from 
disabled to enabled.
If false, no write occurs.

Stale Time hours minutes 
seconds
(defaults to 
zero)

Defines the length of time after which the data for a 
point in the station database is considered to be too 
old to be meaningful (stale).
A non-zero value causes the point to become stale 
(status stale) if the configured time elapses without a 
successful read, indicated by Read Status {ok}.
Zero disables the stale timer. Points become stale 
immediately when unsubscribed.
Do not configure an amount of time shorter than the 
poll cycle time. If you do, points will go stale in the 
course of normal polling. Instead, set this time to be 
longer than the largest expected poll cycle time.

Poll 
Frequency

Drop-down list 
(defaults to 
Normal)

Applies to all proxy points. Provides a method to 
associate the tuning policy with one of 3 Poll Rates 
available in the network’s Poll Service: Fast Rate, 
Normal Rate, or Slow Rate. It may not exist in some 
driver’s tuning policies, but it is a separate property of 
each ProxyExt.
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Workaround for Niagara Firmware behavior issue

Scenario 1
In a Database when the Bacnet device is online and the Use Cov property is set to 
True. 

Use COV 
(change of 
value)

True or false 
(default)

If set to true, and the assigned proxy points are under 
a BacnetDevice that supports the Subscribe COV 
service, the driver attempts any necessary updates 
(proxy subscriptions) using BACnet COV 
subscriptions to the device. If the subscription 
attempt succeeds, the Read Status property of the 
point’s BacnetProxyExt displays COV. If the 
subscription attempt fails, the driver uses normal 
polling and the Read Status property shows Polled.

If set to false, the driver ignores any updates (proxy 
subscriptions).

Use 
Confirmed 
COV

True(default) 
or False

If enabled (true), and the assigned proxy points are 
under a BacnetDevice that supports Confirmed COV 
notifications, the driver attempts any necessary 
updates (proxy subscriptions) using BACnet 
Confirmed COV subscriptions to the device.
If disabled (false), the driver ignores this property.

COV 
Subscription 
Lifetime

Time range 
(defaults to 15 
minutes)

The lifetime, in minutes, for which database will 
subscribe for COV notifications, then (if necessary) 
periodically re-subscribe. A value of zero means an 
indefinite lifetime, although this is not guaranteed to 
persist across resets of the server device.

Property Value Description
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And if a point is added to Bacnet device, which has set TuningPolicyName property as 
IrmTuningPolicy ( i.e using COV mode to receive the data.)

After you perform the Clear Controller operation The point as well as deice will go offline.

Solution 1: While assigning points, set TuningPolicyName property as DefaultPolicy ( 
i.e without COV mode). 

Or 

Go to Database in Point folder, open the property of the point, and set TuningPolicy 
Name property as DefaultPolicy. In few seconds, the controller will be back Online. 

 



EN2B-0414GE51 R1021 43

NIAGARA IRM ENGINEERING TOOL - USER GUIDE

Solution 2: Go to the database, open the device property, and set the Use Cov property 
to False. In few seconds, the controller will be back to Online.

Scenario 2
In the Global VAV template or Venom template if the assigned points set TuningPoli-
cyName property as IrmTuningPolicy.

While performing Match operation on online device in the database and the Global VAV 
template or Venom template. The device will go offline.

Solution: Whenever you are creating a template, ensure all the points in the template 
are disabled by default.
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Also, while performing the Match operation between template and device don't set the 
Use Cov property set to True.

Recommendation: If the points set TuningPolicyName property as IrmTuningPolicy, then don't keep the 
points enabled. After performing commissioning or Teach the controller you can enable 
the points.

Adding IRM Application Template to Palette
Procedure
 Step 1. Make sure that the ‘honIrmAppl.jar’ file is installed in the Modules folder of 

the IRM Engineering Tool installation.
 Step 2. Open the Niagara N4 workbench Tool.
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 Step 3. On the platform, connect to the station.

 Step 4. On the Palette pane, click the Open Palette icon.

 Step 5. In the Open Palette dialog box, enter 'honIrmAppl.jar'.
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 Step 6. If not already selected in the list, select 'honIrmAppl.jar', and then click OK.

 Step 7. In the Palette pane, expand the honIrmAppl folder.

 Step 8. Right-click IRM Program and select Copy from the context menu.
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 Step 9. In the Nav tree, expand the IRM device, navigate to IRM Program and click 
Delete from the context menu to delete the existing IRM Program.

 Step 10. Right-click the IRM device and click Paste in the context menu.
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After pasting the IRM Program, in the IRM device, Nav tree updates.
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ENGINEERING MODES

There are two kinds of engineering modes you can use for configuring an IRMNX con-
troller:

Offline Engineering

In this mode, you create an empty BACnet device manually, add an application, and 
match it afterward to a device discovered on the BACnet bus by using the service pin. 
This is normally applied when doing the engineering in the office without having the con-
troller hardware available but knowing the hardware specification of the devices to be 
used.

Online Engineering

In this mode, you discover the devices on the BACnet network in the first step and use 
the devices instantly for application engineering. This is recommended when doing the 
engineering at the site with the devices already installed on the BACnet bus.

Note: To discover the Bacnet devices on Niagara Workbench, ensure that the "Niagara Station 
Launcher" is allowed to communicate through Windows Defender Firewall.

Note: The Status property of the controller under the Device Object property sheet is not 
updating while performing cut/paste operation between the BACnetDeviceFolder and 
IrmBacnet Manager view (Vice Versa).

Solution: Restart the station, the Device Object property sheet of the controller is updated 
to display Status property “OK”.

Note: Adding 50 IPVAV devices in the bulk to the Database doesn’t update the device instance 
for all the devices. The current IPVAV engineering tool displays 10 IPVAV unique device 
ids.

There are 2 solutions to fix this behavior.

Solution 1: For factory out devices, add 10 devices at a time to ensure unique instance 
numbers are allocated in the device add dialog.

Solution 2: Review the instance numbers allocated in the device add dialog and update 
the unique IDs manually.
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Offline Engineering
There are two ways you can configure an IRMNX controller using an offline procedure:

Procedure 1: Offline Procedure Controller without adding Serial Number – Use this 
method when you don’t have the serial no of the controller.

Procedure 2: Offline Procedure Controller with adding Serial Number – Use this method 
when you have the serial no of the controller.

Procedure 1: Offline Procedure Controller without adding Serial 
Number

Procedure

Step 1. Double-click the BACnetNetwork folder in the Nav tree, and then select the 
Irm Bacnet Device Manager view.

Step 2. On the bottom, click New.

Step 3. In the New dialog box, select Irm Bacnet Device, and then click OK.
Step 4. This opens the Irm Bacnet Device property sheet.

Enter the following details:
• Name – Rename the device name

• Type – Select the device from the drop-down list.

• Network address – Enter the network address

• MAC Address – Enter the MAC address

• Enabled - Select true or false from the drop-down

• Use Cov - Select true or false from the drop-down

• Keep Max Cov Subscriptions as max
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Step 5. Click OK.
Result: The IrmBacnetDevice is created and added to the Database pane and the 

BacnetNetwork tree.

Step 6. Expand the device and create the IRM Program by adding control strategy, 
hardware layout, and alarm settings (optional). Common operation of IRM 
Program

Step 7. Visit the site, go online by connecting to the Bacnet Network.
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Step 8. Discover the controllers on the network. This will list all the live controllers on 
the network. 

Step 9. Press the service pin at the device you want to match to the offline created 
IRM BACnet device. Do this for all devices, which need to be matched. This 
action will discover and list the devices in the discover pan as per service pin 
rank.

Service
Button

The Service Button is used to trigger dedicated events. It is important to dis-
tinguish different controller behaviors which are elicited depending upon 
whether the Service Button is pressed when the controller is powering up or 
when it is in normal operation. 

Pressing Service Button during Power-Up

If the service pin is pressed and then the controller is switched on (while the 
service pin is still pressed), a reset to factory delivery is performed. 

• The application is cleared from the controller.
The MAC address will be set to 0xFF, meaning that the controller will now
search for a new mac address (Auto-MAC will be automatically triggered after
controller power-up).

• The maxMaster setting will revert to its default value of 64.

• The Max info frames will revert to 10.

• The device instance will revert to its default of 4194302.

• The device name will revert to CLMEVA[ModelName].
The values of Auto MAC, Min MAC, and Max MAC will be reset to default
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Note: In the Service Pin Rank column, the service pin action is indicated by consecutive 
numbers depending on the time when the service pin was pressed at the device.

Step 10. On the Discovered pane, select the online device and in the Database pane, 
select the offline controllers.

Step 11. At the bottom, click Match. 

Step 12. If desired, you can enter the Device ID, Network Address, and MAC Address.
Step 13. Enable Use Cov by selecting "true" from the drop-down.
Step 14. Click OK.

Pressing Service Button during Normal Operation

During normal operation of the controller, a short press (< 1 sec) of the Ser-
vice Button will cause a Service Pin Message (BACnet WhoAmI as a Private 
Transfer (SerialNo. = 130)) to be sent.

Default
maxmaster

Default 
MinMAC

Default 
MaxMAC

Default Baud 
rate

64 1 60 38400
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The online device properties are matched to the offline IRM BACnet device 
indicate in the Database pane. 
Following device property got updated:

Step 15. Finally, perform the hardware compatibility check to make sure that the 
application is properly designed for running seamlessly in the created device. 
To perform a hardware compatibility check, Checking Hardware Compatibility

Step 16. Click on Teach Full Application to Controller, refer Teaching Full 
Application To Controller. If there is an application already running in the 
controller, clear the controller. To perform a clear controller operation, refer to 
Clearing Controller. 
For users connecting Irm Bacnet Device to a new controller or want to clear 
all the previous configuration from the controller and downloads the new 
configuration of the project to the controller. Use Teach Full Application to 
Controller. refer Teaching Full Application To Controller
Or
Click on Teach to Controller, refer Teaching To Controller. 
If the user want to modify an existing program in the controller, the user should 
perform Teaching To Controller. In this scenario, the user should not perform 
Clearing Controller operation.

Note:  If the user adding a large application to the controller, it is recommended to perform 
Teach Full Application To Controller.
Result: If as a result, any inconsistencies of the application appear between the 

disconnected IRM BACnet device and the discovered IRMNX controller, a 
notification message will be displayed, and the relevant synchronization 
status is indicated in the control manager. For more details, refer to 
Synchronicity Status Check

• Name • Irm Family
• Type • Irm Program Name
• Device ID • Irm Application Type
• Status (For example, Alarm, 

unacknowledged alarm)
• Irm Sync Status* (synchronized or 

not synchronized)
• Model • Irm Last Change
• Firmware Revision • Irm Master Sync
• Serial Number 
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Step 17. To solve any inconsistencies, synchronize the applications by doing any of the 
following steps:

Procedure 2: Offline Procedure Controller with adding Serial 
Number

Before working on this procedure make sure you have the Device Name, Serial No, and 
Device Id of the controller that need to be matched.

Step 1. Expand the BacnetNetwork in the Nav tree.

Step 2. Right-click the IrmConfig > Action > click Add Serial Number.

Step 3. Enter the Device Name, Serial No and Device Id. Use a barcode scanner 
software if available to get the barcode data to be copy-pasted or enter the 
data manually. 

Or
Enter data manually
• Enter 0000 in the Serial No field. Serial No must be case sensitive and 

should match with the serial number printed on the product label.

• Enter the correct Device Name and Device Id as per the online IRM 
device that you desired to configure.

• Clearing Project • Learning from Controller
• Clearing Controller • Checking Hardware Compatibility
• Teaching To Controller •
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For example:

Step 4. Click OK. The device gets added to the IrmConfig Property Sheet.

Step 5. Repeat steps 2 through 4 add all controllers to the IrmConfig Property Sheet.
Step 6. Discover the controllers. This will list all offline devices.

Step 7. Select the device from the Discover pane and Click Add. 
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Step 8. Click Ok. This adds an offline controller to the Database.

Step 9. Expand the device and create the IRM program by adding control strategy, 
hardware layout, and alarm settings (optional). Refer Common operation of 
IRM Program.

Step 10. Visit the site, go online by connecting to the BACnet network.
Step 11. Discover the controllers on the network. This will list all the live controllers on 

the network. 

Step 12. Now the software searches for controllers that have the same serial numbers 
issued offline.
Or
Press the service pin at the device you want to match to the offline created 
IRM BACnet device. Do this for all devices, which need to be matched. This 
action will discover and list the devices in the discover pan as per service pin 
rank.

Service
Button
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Note: In the Service Pin Rank column, the service pin action is indicated by consecutive 
numbers depending on the time when the service pin was pressed at the device.

Step 13. On the Discovered pane, select the online device and in the Database pane 
and then select the offline created IrmBacnetDevice.

The Service Button is used to trigger dedicated events. It is important to dis-
tinguish different controller behaviors which are elicited depending upon 
whether the Service Button is pressed when the controller is powering up or 
when it is in normal operation. 

Pressing Service Button during Power-Up

If the service pin is pressed and then the controller is switched on (while the 
service pin is still pressed), a reset to factory delivery is performed. 

• The application is cleared from the controller.

• The MAC address will be set to 0xFF, meaning that the controller will now 
search for a new mac address (Auto-MAC will be automatically triggered 
after controller power-up).

• The maxMaster setting will revert to its default value of 64.

• The Max info frames will revert to 10.

• The device instance will revert to its default of 4194302.

• The device name will revert to CLMEVA[ModelName].

• The values of Auto MAC, Min MAC, and Max MAC will be reset to default.

Pressing Service Button during Normal Operation

During normal operation of the controller, a short press (< 1 sec) of the Ser-
vice Button will cause a Service Pin Message (BACnet WhoAmI as a Private 
Transfer (SerialNo. = 130)) to be sent.

Default
maxmaster

Default 
MinMAC

Default 
MaxMAC

Default Baud 
rate

64 1 60 38400
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Step 14. Click Match. The Match dialog box displays. 

If desired, you can enter the Device ID, Network Address, and MAC Address.
Enable Use Cov by selecting "true" from the drop-down.

Step 15. Click OK. 
The online device properties are matched to the offline IRM BACnet device 
indicate in the Database pane. 
Following device property got updated:

• Name • Irm Family
• Type • Irm Program Name
• Device ID • Irm Application Type
• Status (For example, Alarm, 

unacknowledged alarm)
• Irm Sync Status* (synchronized or 

not synchronized)
• Model • Irm Last Change
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Step 16. Finally, perform the hardware compatibility check to make sure that the 
application is properly designed for running seamlessly in the created device. 
To perform a hardware compatibility check, Checking Hardware Compatibility.

Step 17. Click on Teach Full Application to Controller, refer Teaching Full 
Application To Controller. If there is an application already running in the 
controller, clear the controller. To perform a clear controller operation, refer to 
Clearing Controller. 
For the users connecting Irm Bacnet Device to a new controller or want to 
clear all the previous configuration from the controller and downloads the new 
configuration of the project to the controller. Use Teach Full Application to 
Controller. refer Teaching Full Application To Controller
Or
Click on Teach to Controller, refer Teaching To Controller. 
If the user wants to modify an existing program in the controller, the user 
should perform Teaching To Controller. In this scenario, the user should not 
perform Clearing Controller operation.

Note:  If the user adding a large application to the controller, it is recommended to perform 
Teach Full Application To Controller.
Result: If as a result, any inconsistencies of the application appear between the 

disconnected IRM BACnet device and the discovered IRMNX controller, a 
notification message will be displayed, and the relevant synchronization 
status is indicated in the control manager. For more details, Synchronicity 
Status Check.

Step 18. To solve any inconsistencies, synchronize the applications by doing any of the 
following steps:

• Firmware Revision • Irm Master Sync
• Serial Number 

• Clearing Project • Learning from Controller
• Clearing Controller • Checking Hardware Compatibility
• Teaching To Controller •
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Online Engineering
Online engineering includes the following steps:

Step 1. Connect to the BACnet network

Step 2. Discover devices on the BACnet network
Step 3. Create/change/ application and hardware layout if necessary
Step 4. Depending on the synchronization status, apply any of the following actions:

• Clearing Project

• Clearing Controller

• Teaching To Controller

• Learning from Controller

For detailed descriptions, please see the following sections:
• Common operation of IRM Program

• Clearing Project

• Clearing Controller

• Teaching To Controller

• Learning from Controller

• Checking Hardware Compatibility

For further information on Online engineering, see Factory Device Handling.
Step 5. For devices in factory setting mode, press the service pin at the devices.

Press the service pin at the device you want to match to the offline created 
IRM BACnet device. Do this for all devices, which need to be matched. This 
action will discover and list the devices in the discover pan as per service pin 
rank.

Service
Button
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Note: In the Service Pin Rank column, the service pin action is indicated by consecutive 
numbers depending on the time when the service pin was pressed at the device.

Step 6. On the Discovered pane, click Discover.
Result: All devices available in the BACnet network are discovered.
Step 7. On the Discovered pane, select the devices you want to add to the database

The Service Button is used to trigger dedicated events. It is important to dis-
tinguish different controller behaviors which are elicited depending upon 
whether the Service Button is pressed when the controller is powering up or 
when it is in normal operation. 

Pressing Service Button during Power-Up

If the service pin is pressed and then the controller is switched on (while the 
service pin is still pressed), a reset to factory delivery is performed. 

• The application is cleared from the controller.

• The MAC address will be set to 0xFF, meaning that the controller will now 
search for a new mac address (Auto-MAC will be automatically triggered 
after controller power-up).

• The maxMaster setting will revert to its default value of 64.

• The Max info frames will revert to 10.

• The device instance will revert to its default of 4194302.

• The device name will revert to CLMEVA[ModelName].

• The values of Auto MAC, Min MAC and Max MAC will be reset to default.

Pressing Service Button during Normal Operation

During normal operation of the controller, a short press (< 1 sec) of the Ser-
vice Button will cause a Service Pin Message (BACnet WhoAmI as a Private 
Transfer (SerialNo. = 130)) to be sent.

Default
maxmaster

Default 
MinMAC

Default 
MaxMAC

Default Baud 
rate

64 1 60 38400
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.

Step 8. Click Add.
Step 9. The Add dialog box displays. You can change the properties of the devices 

before adding them to the database. To do so, select the device and change 
the desired property from:
• Name

• Device ID

• Network

• Use Cov

• Maximum Cov Subscriptions
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Step 10. Click OK.

Result: All devices are added to the database. The devices are learned from the 
project to the controller as indicated by the following messages.

Note: Starting from Controller version 1.0.1.9 and Niagara IRM Engineering Tool version 
1.0.1.7, the Learning from Controller function is not performed automatically, when a 
discovered controller is added to the database. 

Learn from Controller must be initiated manually while adding a controller to the data-
base.

Step 11. Click OK to confirm.

All devices are added to the database. The following properties are shown:

A synchronicity check is performed, and a message is displayed if non-synchronicity is 
detected, Synchronicity Status Check.

• Name • Irm Family
• Type • Irm Program Name
• Device ID • Irm Application Type
• Status (For example, Alarm, 

unacknowledged alarm)
• Irm Sync Status* (synchronized or 

not synchronized)
• Model • Irm Last Change
• Firmware Revision • Irm Master Sync
• Serial Number 
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SYNCHRONICITY STATUS CHECK 

Whenever you connect to the BacnetNetwork via device discovery (online mode) or 
when matching an empty IRM device (offline mode) to a discovered device of the Bac-
netNetwork, the control manager starts working and checks the applications in the proj-
ect and the controller on synchronicity.

An application in the project can be either synchronous or not synchronous with the 
application running in the connected controller. As soon as non-synchronicity is 
detected, notification messages about the synchronization status are displayed.

Example: Message when Learning the project from the controller on the network.

Note: The software always gives support by displaying appropriate messages which describe 
the current status or problem and how to proceed.
It is strongly recommended to read all the messages to avoid misleading or wrong actions 
which may result in the deletion or loss of application data.

Note: The software always gives support by displaying appropriate messages which describe 
the current status or problem and how to proceed.

Warning:  It is strongly recommended to read and note all messages to avoid misleading or wrong 
actions which may result in the deletion or loss of application data.

Synchronizing applications between project and controllers
To solve any inconsistencies, synchronize the applications by doing any of the following:

• Clearing Project

• Clearing Controller

• Teaching To Controller

• Learning from Controller

• Checking Hardware Compatibility
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Factory Device Handling

Default Factory Device ID Settings

For successful communication via BACnet, each controller must have a unique device 
ID. By default, all new IRM controllers are assigned the factory device ID = 4194302. 
But, when multiple controllers have the same device ID assigned, they cannot talk via 
the BACnet protocol (Who is? - I am broadcast messages).

As a result, new controllers on the MSTP bus will not be visible after discovery. 

IRM Configuration Settings

For engineering IRM controllers on a BacnetNetwork, particular settings must be config-
ured as default settings.

Procedure

Step 1. Expand the BacnetNetwork folder in the Nav tree.

Step 2. Double-click the IrmConfig folder in the BacnetNetwork to display the 
property sheet.

Step 3. On the property sheet, do any of the following:

Property Details
Id Range Min Enter the value for the lowest drive Id that is assigned to a 

device during discovery.
Id Range Max Enter the value for the highest device Id that is assigned to a 

device during discovery.
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Teach Modified 
Controller

• Deny (Default value) — Don’t allow overwriting of an 
existing Application in the Controller. While trying to teach a 
different application to a controller an error message is 
generated which requires to clear the controller.

•  Allow — Allows the unconditional overwriting of an existing 
application.

Note: For the Controller version, Niagara IRM Engineering Tool 
version 1.0.1.7, the "Learn From Controller” function is not 
performed automatically when a discovered controller is added 
to the database. "Learn From Controller” has to be initiated 
manually when a controller is added to the database.

Important: It is strongly recommended not to change this set-
ting.

Inconsistent Pro-
gram Check

(If true — default setting), the software checks the application 
for inconsistencies and shows a message if this is the case. 
Inconsistencies may occur if you have moved or copied the 
application to an external location, for example, to the palette, 
changed it there, and then include it again.

Note: Copying and pasting parts of an application from an 
external location such as another controller do not generate 
inconsistencies in the application.

Last Selected 
Teach Option

This option displays the last teach option used while performing 
Teach To Controller or Full Teach Application To Controller.
• Overwrite BACnet objects values in Device - This option 

overwrites BACnet object values in the controller and 
directly teaches application in the controller.

• Overwrite BACnet object values in Application – This 
option first performs update all BACnet object values and 
default value from controller to application, then it teaches 
application in the controller.

Swap In Heap 
Memory Usage 
Limit

This option allows to set Heap memory usage limit for controller 
or  supervisor station.

• While working on Hawk 8000 or EagleHawk controller, an 
ideal recommendation for memory utilization should not go 
beyond 70% of usage.

• While working on supervisor station, an ideal 
recommendation for memory utilization should not go 
beyond 90% to 95% of usage.

Property Details
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Assignment of Unique Device IDs

Depending on the requirements or scenarios (online at the site, offline in the office), new 
IRM controllers need to be engineered with or without using the service pin button. 

Offline Mode (service pin not accessible)

Step 1. Create a device (controller) by entering the device name and the serial num-
ber for the controller (use a barcode scanner software – if available or enter 
the data manually). Repeat this process for all controllers. 

Step 2. Discover the controllers. This will list all offline devices.
Step 3. At the site, go online by connecting to the network. 
Step 4. Discover the controllers on the network. Now software matches the serial 

numbers issued for offline devices. 
Step 5. Once those controllers are added to the network, they will start 

communicating with the physical online controllers.

When adding the discovered controllers to the database, each controller is issued with a 
unique device ID within the minimum and maximum ID limits configured in the IRM Con-
fig Properties.

Note: In the Add dialog box, you can change the pre-defined device ID before addition to the 
database.

Online Mode (Service pin accessible)

For each controller, press the service pin at the controller before executing the Discover 
command. Then the controllers will be discovered, but they still show the default factory 
ID.

Then when adding the discovered controllers to the database a unique device ID is 
issued for each controller. This unique ID ranges within the minimum to maximum ID 
limits configured in the IRM config properties.

Note: In the Add dialog box, you can change the pre-defined device ID before the database 
addition.

D
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COMMON OPERATION OF IRM 
PROGRAM

Common operation of IRM Programming tool includes:

For working conveniently during application engineering, prepare the work environment 
by enabling the following functions in the IRM Engineering Tool:

BACnet Device Manager View

Step 1. Double-click the BACnet network folder in the Nav tree, and then select the 
Irm Bacnet Device Manager view.

IRM Program Tool Reference Datapoints Usage

Application Engineering Guidelines Components of IRM Program

IP Setting Master Sync

Bluetooth Configuration Splitting-Off Application

Link Creation Controller MAC Address Assignment

Modbus Interface Engineering Synchronizing Device Time

VAV System
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BACnet Device Property Sheet

Step 1. Double-click on IRMBacnetDevice in the Nav tree.
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Property Description

Status This field is read-only and displays the physical status of the port (OK/fault).
Enabled Allows to enable or disable IrmBacnetDevice setting
Fault Cause Indicates the reason why a system object (network, device, component, extension, 

etc.) is not working properly (in fault). This property is empty unless a fault exists.
Health

Alarm Source 
info

This container slot is available on any network component and each child device 
component. The slot’s properties populate the alarm record when the network or 
device does not respond to a monitor ping. This ping is configured at the network 
level.
Each parent and child device object has its Alarm Source Info slot with identical (but 
independently maintained) properties.

Property Value Description

Alarm Class List, console 
column, or field or 
alarm class on a 
report.

Specifies or returns the alarm routing option 
for the component.

sourceName text Displays the name in an alarm record that 
identifies the source of the alarm.

To Fault Text text Enters the text to display when the 
component transitions to a Fault status. 
When applicable, text entered for Fault 
Algorithm, High Limit Text, and/or Low Limit 
Text may override this text.
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Address Specifies the data link layer MAC address of the device.

If this is a B/IP device, this address is an IP address: UDP port. 
If it is an MS/TP device, this is an 8-bit address (0-254) that is unique on its RS485 
trunk.
How to find: expand Config > Services > AlarmService and double-click the 
BacnetDestination
Or select the type of BACnet network, expand Bacnet Comm, and double-click a dnet 
node

Property Description

Property Value Description

To Offnormal 
Text

text Enters the text to display when the component 
transitions to an Offnormal (alarm) state. When 
applicable, text entered for Fault Algorithm, High 
Limit Text, and/or Low Limit Text may override this 
text.

To Normal Text text Enters the text to display when the component 
transitions to Normal status. When applicable, text 
entered for Fault Algorithm, High Limit Text, and/or 
Low Limit Text may override this text.

Hyperlink Ord 
or Hyperlink

Ord, 
BQL 
Query, 
or path

Associates an Ord, BLQ query, or path with an alarm 
state on the component. When an alarm is reported 
in the console, the Hyperlink button activates. 
Clicking this button links to the location you specify 
here.

Sound File Ord Defines the path to a sound file that plays when the 
current component is in an alarm state. Use the 
folder icon to browse the file. Click the arrow icon to 
the right of the folder icon to evaluate the path.

Alarm icon text Defines the path to a graphic file the system includes 
in the Timestamp column of the alarm table in the 
Console Recipient view. Use the folder icon to 
browse for the file. Use the right arrow to evaluate the 
location you entered.

Alarm 
Instructions

text Advice that accompanies the alarm notification 
(Alarm Record window) that provides important 
information for the operator. Click the right-pointing 
arrow to view the instructions.

Meta Data 
[alarms]

text Defines facets for the extension.
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Points The Bacnet Point Device Ext (Points folder in the Nav tree) is the BACnet 
implementation of the PointDeviceExt, a frozen container under every BacnetDevice. 
Its primary view is the Bacnet Point Manager.
BACnet proxy points are similar to other driver proxy points. Refer to the Niagara 
Drivers Guide for general information.

Virtual This component is the BACnet driver’s implementation of the Baja Virtual Gateway. A 
virtual gateway is a component that resides under the station’s component space 
where it provides access to the station’s virtual component space. Other object 
spaces are Files and History. For a general explanation about Baja virtual 
components, refer to the Niagara Drivers Guide.
Each BacnetDevice and BacnetWsDevice has its virtual gateway, at the same level 
as its device extensions (Points, Schedules, and so on). Accessing components 
under this gateway dynamically adds them as virtual points while they are subscribed, 
but they exist only in memory (are not persisted in the station database like proxy 
points). When virtual points become unsubscribed, the driver automatically removes 
them from the station database.
Expanding a BacnetVirtualGateway results in a list of the devices BACnet objects. 
Each is a BacnetVirtualObject that contains a number of BACnetVirtualProperty 
components to represent its properties. Thus, virtual points are at the object, property 
level.

Alarms Each BacnetDevice has an Alarms device extension. This extension applies to 
BACnet event notifications (alarms) sent to the station by that device.

One way to view these properties is to expand BacnetNetwork > BacnetDevice 
followed by double-clicking the Alarms node in the Nav tree.

Schedules This device extension configures schedule properties

For property descriptions, refer to the properties dictionary chapter in this document

Property Description
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Trend Logs This component is a frozen device extension under every BacnetDevice and the 
container for BacnetHistoryImport components. The default view is the Bacnet History 
Import Manager, used to import data from trend log objects in the device, into the 
station as histories.
This folder under the BacnetNetwork > BacnetDevice node in the Nav tree serves as 
the container for BACnet history objects, which you import from a device into a 
station. For general information on this device extension, refer to the Drivers Guide.
A BACnet device must contain trend log objects (and/or trend log multiple objects) to 
make use of histories. A Discover command determines this. If it finds no such 
objects, the Trend Logs extension has no practical application.
By default, this container also has a Retry Trigger, for automatic usage as needed. 
For details, refer to the Drivers Guide.
The default view of this component is the Bacnet History Import Manager.

Config This frozen device extension under every BacnetDevice functions as the container for 
Config-type objects, which represent individual BACnet objects in the device. By 
default, it contains a BacnetDeviceObject for the device’s sole BACnet Device object.

Property Description
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Enumeration 
List

Lists the BACnet properties that can be exported to configure data exchange. The list 
provides access to each property's configuration facets.
How to find: expand the BACnet network and double-click the BACnet device.

Use Cov Enables and disables a device’s support for COV (change of value) as a way to 
monitor proxy point values.
Assuming the device supports a subscription to the COV service, true triggers the 
driver to attempt the necessary updates (proxy subscriptions) to the value of each 
point using the BACnet COV subscription to the device. If the subscription attempt 
succeeds, the Read Status property of the point’s BacnetProxyExt displays COV. If 
the subscription attempt fails, the driver uses normal polling and the Read 
Statusproperty shows Polled.
When true, individual proxy points under the device may use COV subscriptions, 
depending on their assigned tuning policy.
When false, the driver ignores any proxy subscription updates.
How to find: expand the BACnet network and double-click the BACnet device. Also 
available on the Device Manager Add window.

Use Cov 
Property

If enabled (true), and the assigned proxy points are under a BacnetDevice that 
supports Confirmed COV notifications, the driver attempts any necessary updates 
(proxy subscriptions) using BACnet confirmed COV subscriptions to the device.
If disabled (false), the driver ignores this property.
How to find: expand Config > Drivers, BACnet network, expand Tuning Policies, and 
double-click Default Policy

Max Cov 
Subscription

Specifies the maximum number of COV (change of value) subscriptions that the 
database attempts to use with this device. This restriction prevents the station from 
consuming all of the available subscription space in the device. Applies only if Use 
Cov is true.

Cov 
Subscription

Reports number of active COV client subscriptions to the device.

Property Description
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Character Set Defines the character set supported, with other selections that are IBM/Microsoft 
DBCS, JIS C 6226, ISO 10646 (UCS-4), ISO 10646 (UCS-2), ISO 8859-1, and 
“Unknown.”
How to find: expand the BACnet network and double-click the BACnet device.

IP Setting IP Config operation is provided to ease IP configuration for multiple IP VAVs from
a single window. This feature allows user to perform many productivity operation
like batch update of IP configuration, auto-increment of IP addresses, visual
indication of modifications to IP addresses, user errors in IP configuration, offline
and online IP configuration.
This configuration interface is for any wired IP connections that are made through 
either one of the controller’s Ethernet Switch Primary connector or Ethernet Switch 
Secondary connector. For more details refer, to IP Setting.

BLE 
Configuration

BLE Config is provided to batch configure BLE configuration for Beats IP and
MSTP devices. This feature allows user to perform operation like configure the
BLE enable/disable function, setting password, BLE enable start and end. For more 
details, refer to Bluetooth Configuration

Property Description
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IRM Program IRM Program allows user to perform operation using IRM programming tool.

Property Description

• Ping • Restore Snapshot

• Teaching To Controller • Swapping IRM Program

• Teaching Full Application To 
Controller • Application Engineering Guidelines

• Learning from Controller • Reset Tool Password

• Checking Hardware 
Compatibility • Ping Sylk Device

• Check Application Compatibility • Validate Sylk Device

• Clearing Controller • Update All BACnet Object Values 
From Controller To Application

• Clearing Project • Replace Text A Block And Ws Text 
Blocks With Irm Ws Text Block

• Taking Snapshot
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IRM Palette

The following palette is available for creating the application:

• honIrmControl – It provides control function blocks and templates for IRM BACnet 
devices, IRM programs, and folders. 

• honIrmAppl – It provides a standard FCU application with all commonly used 
functionalities.
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IRM Operations Monitor or Jobs Sidebar

The IRM Operations Monitor shows all actions in a popup window and all actions are 
summarized in a list in the Jobs window.

In the Windows menu, click Side Bars, and then click Jobs.

When actions are executed, they will be shown in the temporary IRM Operations Moni-
tor popup window and listed permanently in the Jobs window. 

Devices can be viewed in the nav tree as shown below:

https://www.google.com/
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IRM Program Tool
The IRM Program tool is part of the device and includes the following components:

• Control Manager

• Periodic Program

• Event Program

• Onboard IO

• Alarms

The component’s workspace can be shown by double-clicking it in the tree and selecting 
the Wire Sheet view. For the Control Manager, the Property Sheet displays after double-
clicking on the item.
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Control Logic Source or Palette

For creating the application, the “honIrmControl” palette is used which includes all necessary components 
such as logic function blocks, terminals, and templates for IRM BACnet devices, IRM programs, and fold-
ers.
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Modifications and Consistency Check

Whenever working on the application, for example, periodic program, on-board I/O, etc., 
every modification is detected by the control manager and indicated graphically by a yel-
low warning symbol that replaces the original symbols at the modified item on the wire 
sheet, and in the tree. This applies to teaching mode 'on demand' only. When working in 
teaching mode 'immediate', changes are not indicated graphically since they are written 
instantly to the controller.

Note: When user cut and paste multiple functional blocks in immediate mode, the modification 
cause project to go in Out of Sync. In that scenario, the user needs to perform Teach To 
Controller.

Whenever moving/copying multiple function blocks from one folder to another, it is 
advised to be in on-demand mode.

Example:

In addition, the IRM Program icon and the component's icon get a dark square back-
ground . 

The control manager icon switches from synchronous state  to non-synchronous 
states

On the property sheet of the controller manager, the synchronization status switches 
accordingly:

Depending on where the application is created (project) or changed (project or control-
ler), the application must be taught to the controller or must be learned from the control-
ler to achieve synchronicity. In both cases, if meaningful and required, the controller or 
the project must be cleared first.
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Control Manager 

Procedure 

Step 1. In the Nav tree, expand the IRM Program folder. 

Step 2. Double-click on the Control Manager icon.

Result: On the Property Sheet, the following information is displayed.

Name Definition

Author of the application Name of the applicant
Description Description of the applicant
Device Model Name Select device model from the drop-down list.
Application Type Type of application
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Application Details Application name and version
Function Block Family Name of the function block family
Function Block Version Function block version
Number of Folders Number of folders

Note: IRM engineering tool supports a maximum of 32 IRM folders 
overall

Number of Function blocks Number of function blocks
Note: IRM engineering tool supports a Maximum of 100 function 
blocks per folder and a maximum of 2000 function blocks overall.

Number of Links. Number of links
Memory usage Shows the memory usage of the device, application, and parameters 

in percentage and graphically.
Controller Hardware features Displays the I/O configuration (Online available in Online mode).
Hardware Compatibility Indicates whether the terminal layout of the application is compatible 

with the hardware layout of the physical controller.
Controller Connection Allows selecting the connection type among network, offline, and 

simulation.
Teaching Mode Allows selecting the teaching mode from on-demand and immediate.

Measurement Type Allows selecting the type of engineering units from the drop-down list.

Air Flow Unit Allows selecting the airflow units from the drop-down list.

Drop of BACnet Output Defines which type of reference point, reference input, or output is 
created when dropping a BACnet output from another device.

Name Definition
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Drop of BACnet Value Defines which type of reference point, reference input, or output is 
created when dropping a BACnet value point from another device.

Communication Status Displays the communication status of the device: online or offline.
Is Synchronized Indicates whether the project and the controller are synchronized 

(yes) or not (no).

Synchronization status Displays a message describing the cause of the current 
synchronization status.

Last program change Displays the date of the last program change.
Last Commissioned Displays the date of the last commissioning.
Modbus Baud Rate Modbus devices must have an identical Baud rate, an identical Parity, 

and an identical number of stop bits. Typically, the Baud rates of 
Modbus devices are set and changed via their user interfaces or their 
separate configuration software.

Modbus Parity Modbus devices may have a configurable Parity, most likely, they will 
not have a configurable number of stop bits. If a Modbus device has 
an un-matching number of stop bits, this device cannot be used.

Modbus Stop Bits If Modbus Parity = None, then select Modbus Stop Bits = “2”.
If Modbus Parity = Even or Odd, then select Modbus Stop Bits = “1”.

Sylk Details Displays Sylk Device usage.

Custom Sensor Configuration If the sensor does not meet any standard characteristics of the 
available sensors, you can select the Type as Custom Sensor and set 
its characteristics.

Name Definition
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Day light Saving This feature is integrated when the daylight setting comes into effect.

Application Details Config This feature allows to configure Application Type and Application 
Feature.
5. Application developer can mark what is the type of the application 

and can be viewed by the user over network

6. Any external tools like, VAV balancing will check what is the type 
of the application is running, so it can support those features

Example: IP unitary device, even though it is not a VAV device, it is 
capable of running a VAV application using an external actuator, so 
application type dictates what is to be supported, nor the hardware 
type.
3. Similarly, we an add a FCU valve balancing application in future, 
for that this Application Type field will be useful.
Note: All the values currently available in the tool are added for future 
compatibility.
Application Type - configure application type from the drop-down list.

Application Feature - configure application feature
Global Balancing Object This feature allows to configure Global Balancing Object.

Name Definition
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Step 3. Do any of the following if desired:
g. In Controller Connection, select the connection type for the devices from:

• The network connects to the physical BACnet network.

• Offline disables the connection to the network. This is useful in case you 
want to reduce bus traffic if the application has not been swapped out.

h. In Teaching Mode, select how the application changes in the project are written 
to the controller from:

• Immediate - changes are written to the controller automatically and are 
effective immediately.

• On-Demand - changes are written to the controller manually and explicitly 
by the Teach to Controller action.

Note: For both teaching modes, only the changes are written to the 
device, hence the process is very fast.

i. In Measurement Type, select the type of engineering units from:
• SI-metric - To set measuring unit as SI-Metric, select Measurement Type 

as SI-Metric and Air Flow Unit as Cubic Meter Per Hour or Liter Per 
Second.

• Imperial - To set measuring unit as Imperial, select Measurement Type 
as Imperial and Air Flow Unit as Cubic Meter Per Hour.

Step 4. Click Save.

Application Details

The Application Details property sheet allows you to keep a record of application version 
details. 

Flash Memory Exceeded FBs & IRM Folder

If any configuration is done on the Function block, IRM folders or subfolders exceed the 
defined memory limit (900 bytes). The Flash Memory Exceeded FBs & IRM Folder list 
the details of the Function block, IRM folders, or subfolders exceed memory.
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Using the details from Flash Memory Exceeded FBs & IRM Folder section, the user can 
verify the property sheet and re-configure the respective Function block, IRM folders, or 
subfolders to the defined limit. 

Memory Usage

The memory of the controller's RAM varies based on the configured model consumed 
by the:

• Device

• Application

• Parameters

Details of controller memory 

The IRM Engineering Tool provides a memory consumption check of the current appli-
cation in the tool. This is an approximate calculation of the application in the tool but not 
a real-time consumption within the controller.

The calculated memory usage is shown in the IRM Control Manager as a percentage 
and graphically via traffic light symbol.

Controller Maximum Memory

Compact VAV 344 KB
IP/MSTP VAV 1 MB
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The memory Usage field also displays the memory utilized by application data or client 
data (Function Block Name/IRM Folder Name/Annotation/SubFolder Count/Composite 
Flash Memory for the whole application. Under Client Data, you can see the distribution 
of client data memory usage.

• IrmFolderClientData: Memory utilized by application folders.

• IrmFunctionBlockClientData: Memory utilized by function block folders.

The sum of memory utilized by IrmFolderClientData and Irm FunctionBlockClientData is 
sent to the controller. 

Note: Teach time can vary based on the Client Data memory usage, irrespective of the memory 
usage.

The memory usage can be viewed on the property sheets of the different levels:

• IRM Program AX property sheet 

• Control Manager

Maximum memory varier's based on the configured controller type

For Compact VAV controller (max memory 344kb) 
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For IP/MSTP VAV  controller (max memory 2mb) 

• Periodic and Event Program AX property sheet

• IRMFolder AX property sheet

• In Function block AX property sheet

Memory Usage and Its Display

The maximum capacity of memory in the controller varies based on the configured 
model. 
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Each folder added, consumes 8 KB of memory. The maximum number of folders is 100, 
4 folders are reserved by default. Hence, user-defined individual folders can be 100 at 
maximum. 

SubFolder Count: This field is read-only displays a number of the configured Sub-
folder per Irmfolder..

Function Block Count: This field is read-only displays a number of the configured  
function block per Irmfolder.

Note: To keep the memory usage as low as possible, it is recommended to optimize application 
engineering by keeping the number of folders as low as possible and the number of 
added function blocks per folder as high as possible in relation to the required result of 
the logic.

The maximum number of function blocks per folder is 150. If you want to use more than 
150 function blocks, split them among two or more folders.

The calculated memory consumption will be indicated graphically and as percentage in 
the traffic light symbol as follows:

It is recommended to monitor the memory usage on the Control Manager level and to 
avoid exceeding the limit of 80 %. 

Sylk Details

After configuring Sylk devices on the wire sheet under the Periodic program. You can 
check the details of the configured Sylk device. To check the details, navigate to the Sylk 
Details under Control Manager.

In the Sylk Details, you can check the total Sylk power consumption, host Sylk config file 
size, Sylk proxy file size, and is the Sylk configuration downloaded or not. 

• Green > 80%
• Yellow < 80 %
• Red > 90 %



92 EN2B-0414GE51 R1021

NIAGARA IRM ENGINEERING TOOL - USER GUIDE

Custom Sensor Configuration Details

If the sensor does not meet any standard characteristics of the available sensors, you 
can select the Type as Custom Sensor and set its characteristics. There are three types 
of custom sensors available Current, Voltage and Resistive.

• Resistive Input: A Resistive Input Point is an Analog Point that configures a UI / UI/
AO to read resistance from 0 to 300000 (should be 300 KΩ) ohms. The configuration 
provides for default (ohms).

• Voltage Input: A Voltage Input Point is an Analog Point that configures a UI / UI/AO 
to read a Voltage signal from 0 volts to 10.3 Volt. The configuration provides for 
default (Volts).

• Current Input: A Current Input Point is an Analog Point that configures a UI / UI/AO 
to read resistance from 0 to 20 mA. The configuration provides for default (mA).

Note: To perform the Current sensor, type custom sensor configuration in the IRM engineering 
tool.  The user needs to connect an external 500 Ohm resistor to convert current to volt 
to measure 0(2 to 20 mA, which does work without hardware change.

0(4) ... to 20 mA (via external 499 Ω/0.25 % resistor)

Note: Users can configure up to 10 custom sensor configurations in the IRM engineering tool.

To configure custom sensor:

Step 1. Navigate to BacnetNetwork > IrmBacnetDevice > IRM Program > double 
click the Control Manager.

Step 2. Click on the Custom Sensor Details and configure the fields
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The following table describes the configuration properties and their definitions.

Name Definition

Enable Select True to enable the selected custom sensor 
configuration.

Sensor Name Enter the name of the sensor
Sensor Type Select sensor Input (Current, Voltage, and Resistive) from the 

Sensor Type drop-down menu.
Sub Type Select a sensor type from the Sub Type drop-down menu.
Specification Unit Specification Unit option in the drop-down menu depends upon 

the Data Type selected while configuring the details on the 
Add window.
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Step 3. Select Sensor Type as Current or Resistive or Voltage.

Step 4. Configure the Specification Unit option in the drop-down menu depends upon 
the Data Type selected while configuring the details on the Add window.

Step 5. Click   next to the Linearization field, where the linearization points are 
provided to define the characteristics of the sensor. The Tabular Conversion 
Dialog window is displayed.

Linearization The Linearization field, where the linearization points are 
provided to define the characteristics of the sensor. The 
Tabular Conversion Dialog window is displayed.

Sensor Low Limit The lower limit in the Low Limit field.
Sensor High Limit The upper limit in the High Limit field
Sensor Reading 
Output Limits

Select the value for Sensor Reading Output Limits from the 
respective drop-down menus. Sensor Readings Outside Limit, 
The Value is Invalid outside High Limit option is selected, when 
output crosses the limit, the output becomes invalid. 
The Clamp Value as High and Low Limits option is selected 
and if output crosses the high limit or low limit, the output is 
clamped to Low or High Limit and it doesn’t become invalid
The Continue Linearization Without Clamp option selected, the 
user wants to continue sensor reading outside the High limit

Offset Offset is the precision limit of the curve
Validation Text This field verifies the configuration of the custom sensor, if any 

of the fields are not configured it will display a message.

Name Definition
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Step 6. Click Add
Step 7. Enter the sensor current value for the electrical signal in the Source field and 

enter the corresponding value of the parameter which is being sensed in the 
Result field. 
Enter the low and high limit sensor values in the Sensor Low Limit (Sensor 
value at 0 mA) and Sensor High Limit (Sensor value at 20 mA) fields 
respectively as per Sensor Data Sheet.
Similarly, add and enter value for the sensor resistance value and sensor 
voltage value for Resistance and Voltage input.

Step 8. Select the value for Sensor Reading Output Limits from the respective drop-
down menus.
• If output crosses the limit, the output becomes invalid, select Value is 

INVALID outside High Limit option. 

• If output crosses the high limit or low limit, the output is clamped to Low or 
High Limit and it doesn’t become invalid, select Clamp Value as High and 
Low Limit option.

• If the user wants to continue sensor reading outside the High limit., select 
The Continue Linearization Without Clamp option 

Step 9. Enter the Offset value.
Step 10. Click Save after entering the required details.

If any of the fields are not configured, the Validation text will display a 
message.
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Once the custom sensor is configured, the user can integrate these custom sensor con-
figurations on the UI terminals of the controller.
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Day Light Savings Day Light saving setting 

Daylight saving setting is a part of the control manager and enables the user to config-
ure the day light setting when comes into effect.

Procedure

Step 1. Navigate to BacnetNetwork > IrmBacnetDevice > IRM Program > double 
click the Control Manager.

Step 2. Click on the Day Light Saving and configure the fields

Set Enable Daylight Savings option and enter parameters:

• Start Month

• End Month

• Start Day

• End Day

• Start Time

• End Time

• Off Set Minutes

Note: Clear the Day Light Savings check box and download it to the controller, for the controller 
to stop using daylight savings
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Global Balancing Object

The Global VAV Balancing tool is an intuitive tool developed to perform balancing and 
calibration for VAV controllers. You can perform Setpoint balancing, Max-Min balancing, 
Zero calibration, and Move damper procedures. For more details, refer to Global VAV 
Balancing tool- EN2B-0041 IE10 R0121 and Global VAV Application Design User Guide.

Using the Mobile balancing Tool user can perform balancing and calibration of the VAV 
controller. For more detail, refer EN2Z-1086IE67 Honeywell Connect Mobile VAV Bal-
ancing Mobile App

Teach Balancing Object To Controller – Allows the commission engineer to bring the 
balancing object values from the VAV controller to the supervisor workbench balancing 
object.

Important: Set the desired Measurement Type before configuring Global VAV Balancing Tool, refer 
Setting Measurement Type. 

SI-Metric - To set measuring unit as SI-Metric, select Measurement Type as SI-Metric and 
Air Flow Unit as Cubic Meter Per Hour or Liter Per Second.

Imperial - To set measuring unit as Imperial, select Measurement Type as Imperial and 
Airflow Unit as Cubic Feet Per Minute.

Steps to run Teach Balancing Object To Controller

Step 1. Navigate to BacnetNetwork > IrmBacnetDevice > IRM Program > Control 
Manager > double-click Global Balancing Object. This opens Global Bal-
ancing Object property sheet.

Step 2. Right-click Global Balancing Object > Actions> Teach Balancing Object 
To Controller
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Learn Balancing Object From Controller - Allows the commission engineer to send 
the balancing object values from the supervisor workbench to the VAV controller. 

Steps to run Learn Balancing Object From Controller

Step 1. Navigate to BacnetNetwork > IrmBacnetDevice > IRM Program > Control 
Manager > double-click Global Balancing Object. This opens Global Bal-
ancing Object property sheet.

Step 2. Right-click Global Balancing Object > Actions> Learn Balancing Object 
From Controller

Note: Make sure to correctly mapping the Balancing objects with BACnet Objects points 
(BacnetNumericValue, BacnetBooleanValue, or BacnetEnumValue).

Note: Input and output points are not supported by balancing objects.

Teach Balancing Object on Multiple Controller 

Procedure

Step 1. Right-click on BacnetNetwork > Views > Irm Bacnet Device Manager 
view.

Step 2. Select all the IRM devices from the device list.
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Step 3. Click Teach Balancing Object. This action opens Teach Balancing Object  To  
Controller dialogue box.

Step 4. Click Yes.

Result: The Balancing object changes are written to the controller. The applications 
then synchronized. The successful action is displayed in Workbench Job 
Service.

Learn Balancing Object on Multiple Controller 

Procedure

Step 1. Right-click on BacnetNetwork > Views > Irm Bacnet Device Manager 
view.

Step 2. Select all the IRM devices from the device list.
Step 3. Click Learn Balancing Object. This action opens Learn Balancing Object  To  

Controller dialogue box.

Step 4. Click Yes.

Result: The Balancing object data upload into the project. The applications then 
synchronized. The successful action is displayed in Workbench Job 
Service.
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Generating Balancing Report

IRM engineering tool allows you to generate the report for balancing data of the set of 
devices or controller stations. Balancing reports can be generated from Online Control-
ler Values or Wiresheet Values.

• Online Controller Values – Read value from online controller only.

• Wiresheet Values - Read wiresheet values mapped to the online and offline 
controller. 

Generating balancing report for multiple devices

Steps to generate balancing report for a set of devices

Step 1. Navigate to the Irm Bacnet Device Manager view and select the devices.
Step 2. Click on Generate Balancing Report. This opens Generating Balancing 

Report dialogue box.

Step 3. Select the report option From OnlineControllerValues or From 
WiresheetValues

Step 4. Click OK.

Generating balancing report from the station

Steps to generate balancing report from the station

Step 1. Navigate to BacnetNetwork.
Step 2. Select IrmConfig, right-click Actions> Generate Balancing Report.
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Step 3. Select the report option From OnlineControllerValues or WiresheetValues.

Step 4. Click OK.

The report is saved in the shared location station repository (“C:\Users\User 
account\Niagara4.10\CentraLine\stations\”current station name”\shared\BalancingRe-
ports). Inside the shared, go to the BalancingReports folder and open the Balancing 
Report CSV file.

File Format: Stationname_Balancing report_unique number
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Periodic Program

Creates the control strategy running in a cyclic manner on a fixed time base. All function 
blocks in the root folder and its subfolders are processed. The periodic program is exe-
cuted every 500 ms within the controller.

Procedure
Step 1. Double-click Periodic Program in the tree, and then select the Wire Sheet 

view.
Step 2. Open the honIrmControl palette.
Step 3. From the palette, add control items to the wire sheet via drag and drop.
Step 4. Create or change the control logic by applying desired steps such as 

connecting, adding, deleting, moving icons, and/or adding and deleting 
connections. 

Note: There can be a maximum nesting of 5 levels of Irmfolders. The 6th level would be the 
component in the ord.
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Synchronization Check

Any modifications on the Periodic Program wire sheet are detected by the control man-
ager. Modifications can be any of the following such as:

• Added item

• Deleted item

• Moved item

• Deleted connection

• Added connection

As result, all modified items will be not in sync with the application in the controller and 
hence indicated by a yellow "warning" symbol on the item. 

The application can be synchronized according to the set teaching mode, on-demand or 
immediate.

After synchronization, the warning symbols are removed, and the items are indicated in 
their synchronized state. See also the description of Control Manager.

Event Program

Creates event-driven control strategy. All function blocks in the root folder and its sub-
folders are processed. 

The event program is executed:

• When the time interval of 1000 ms has elapsed

• Whenever the state of a hardware point configured as binary input that is used in the 
event program, changes and when this binary input point is used as an input slot to a 
function block

You can configure BI and UI as binary inputs. 

Procedure
Step 1. Double-click Event Program in the tree, and then select the Wire Sheet view.
Step 2. Open the honIrmControl palette.
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Step 3. From the palette, add control items to the wire sheet via drag and drop.
Step 4. Create or change the control logic by applying desired steps such as 

connecting, adding, deleting, and moving icons, and/or adding and deleting 
connections.

Synchronization Check

Any modifications on the Event Program wire sheet are detected by the control man-
ager. Modifications can be any of the following such as:

• Added item

• Deleted item

• Moved item

• Added connection

• Deleted connection

As result, if working in 'on demand' teaching mode, all modified items will be not in sync 
with the application in the controller and hence indicated by a yellow “warning” symbol 
on the item. 

The application can be synchronized accordingly to the active teaching mode, "on 
demand" or "immediate". After synchronization, the warning symbols are removed, and 
the items are indicated in their synchronized state. Synchronization happens immedi-
ately in "immediate" mode. See also the description of Control Manager.

Note: To achieve the best performance for the operation of light and blind, the light and blind 
function block have to be put into the Event Program folder. In addition, the UIs of the 
buttons used must be connected from the On Board IO folder to the Event Program 
folder, e.g. to a PassThru function block which is not used anymore.
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Onboard IO

Shows the hardware configuration for which the application is designed. The hardware 
displayed here can differ from the real hardware layout of the physical controller. For 
proper operation, the hardware of the project does not have to fit 100 % to the physical 
hardware of the used controller later. But, if the difference is too much, hardware com-
patibility is not guaranteed. The control manager will show incompatibilities and software 
give support and tell what to do for synchronicity.

Procedure
Step 1. Double-click On Board IO in the tree, and then select the Wire Sheet view.
Step 2. Open the honIrmControl palette.
Step 3. From the palette, add single physical terminals manually or a pre-defined 

template to the wire sheet via drag and drop. Pre-defined templates are 
matched to particular controller models. The following physical terminals and 
templates are available: 
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Step 4. Create or change the layout by applying desired steps such as connecting, 
adding, deleting, and moving terminals, and/or adding and deleting 
connections.

Note: When discovering datapoints on the BacnetNetwork via IRM Bacnet Device Manager, the 
hardware I/O points of the IRM controllers are not detected and visible by default. To 
expose hardware I/O points on the BacnetNetwork, please see Exposing Hardware, I/O 
Points on BACnet

Synchronization Check

Any modifications on the On-Board I/O wire sheet are detected by the control manager. 
Modifications can be any of the following such as:

• Added item

• Deleted item

• Moved item

• Added connection

• Deleted connection

As result, all modified items will be not in sync with the application in the controller and 
hence indicated by a yellow "warning" symbol on the item, see figure below. 
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The application can be synchronized according to the active teaching mode, 'on 
demand' or 'immediate'. After synchronization, the warning symbols are removed, and 
the items are indicated in their synchronized state. See also the description of Control 
Manager.
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Alarms

Alarming

Provides the notification classes for establishing alarming.
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Alarming

Follow the below steps to perform Alarm configuration and details on how to use Notifi-
cation Class objects in BACnet points and generate alarms

Procedure

Step 1. Navigate to the BacnetNetwork >IrmBacnetDevice > double-click on Con-
fig.

Step 2. Click Discover and select all the discovered notification classes 1,2,3 & 4.

Step 3. Click Ok to add the notification to the database.
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After you discovered and added a notification to the database, you can change the prop-
erties of any notification class listed in the database.

Step 4. Right-click on any of the notification Views > Property sheet.

Step 5. Right-click on Recipient List > Action > select add Elements
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Step 6. Select the Recipient option, configure the device ID and click ok.

This action will configure notification with the device Id.

Note: Bacnet Alarms not supported by EnumOutput, NumericValue, BooleanValue, 
EnumValue, RefIn, and RefOut data types.

Synchronization Check

Any modifications such as adding, deleting, or copying, and pasting items on the Alarms 
wire sheet are not allowed. 

You can only change the properties of the pre-defined notification class objects on the 
Property Sheet after you have double-clicked the icon.
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IRM Controller Diagnostics

The IRMNX controller diagnostics primarily monitors the activity in Control Engine, 
BACnet, Modbus Trace, and Sylk Trace. 

Important: IRM controller Diagnostics feature hidden by default in the tool, to use this features user 
need to unhide IRM controller Diagnostics.

• Control Engine – Enabling Control Engine allows you to collect logs for function 
blocks. These logs were utilized to identify the functionality issues in the Function 
Block.

• BACnet - Enabling BACnet allows you to monitor the BACnet network traffic between 
tool to controller or controller to tool

• Modbus Trace – Enabling Modbus Trace allows you to monitor RS485 connection 
activity.

• Sylk Trace - Enabling Sylk Trace allows you to monitor configured Sylk device 
activity. 

Note: User should enable one of the parameters (either Control Engine or BACnet or Modbus 
Trace or Sylk Trace.) at a time for diagnostic..

To Access IRM Controller Diagnostics
Step 1. Navigate to BacnetNetwork > IrmBacnetDevice.
Step 2. Right-click IRM Program > Views > select AX Slot Sheet and locate 

irmControllerDiagnostics property in the Slot Sheet.
Step 3. Right-click irmControllerDiagnostics property and select Config Flags.
Step 4. In the Config Flags, uncheck the Hidden option. 
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Step 5. Click Ok.

Now IRM Controller Diagnostics feature is visible in the IrmProgram property sheet.

To Use IRM Controller Diagnostics

Step 1. Navigate to BacnetNetwork > IrmBacnetDevice.
Step 2. Right-click IRM Program > Views > select AX Property Sheet. This opens 

the IRM Program property Sheet.
Step 3. Right-click IRM Controller Diagnostics > Action > Start Diagnostics. This 

action starts diagnosis of Control Engine, BACnet, Modbus Trace, and Sylk 
Trace. 

Step 4. Right-click IRM Controller Diagnostics > Action > Stop Diagnostics. This 
action stops diagnosis process and generate Diagnostics report.

Step 5. Right-click IRM Controller Diagnostics > Action > Read Diagnostics. This 
action generates Diagnostics file. 

Step 6. Open to Niagara console, check the location of the Diagnostics file and 
navigate to the location. 

Share that Diagnostics file with the technical support team to resolve the issue in the 
controller. 

Note: Currently users can generate Diagnostics reports for a single controller at a time.
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Application Engineering Guidelines

Commissioning and Station Copier Usage

Before a controller can be used for the first time after initial installation or upgrade, it 
must be commissioned by loading the following components from the PC (localhost) into 
the controller (remote host):

• Niagara software

• License

• Application or station

When changes will be done later to the application on the PC, the station can be copied 
into the controller by using the Station Copier function. In this case, new commissioning 
is not necessary.

For a detailed description, please see the HAWK 8000 User Guide: EN2Z-1030GE51.

Important: It is strongly recommended to swap out the application in any case after finishing the 
engineering in online or offline mode.

Swapping out the application avoids additional communication between IRM Engineering 
Tool and controller and reduces bus traffic.

For details about Swapping, see Swapping IRM Program.

Memory and Folder Usage

It is recommended to monitor the memory usage on the Control Manager level and to 
avoid exceeding the limit of 80 %. 

To keep the memory usage as low as possible, it is recommended to optimize applica-
tion engineering by keeping the number of folders as low as possible and the number of 
added function blocks per folder as high as possible in relation to the required result of 
the logic.

Note: The maximum number of function blocks per folder is 100. If you want to use more than 
100 function blocks, please split them into two or more folders.

For details see Memory Usage.
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Teaching and Learning

Synchronization can be performed in two ways:

• Teaching to Controller downloads the changed application in the project to the 
controller.

• Learning from Controller uploads the changed application from the controller in 
the project.

When in teaching mode, application changes of the project can be written to the control-
ler in two ways:

• Immediate changes are written to the controller automatically and are effective 
immediately.

• On-demand changes are written to the controller manually and explicitly by the 
Teach to Controller action.

The explicit usage of the teaching and learning actions and the time when an action is 
used depends on the application status in the project and the connected controller, and 
the result you want to achieve.

Controllers can:

• Be empty (factory delivery, cleared, no application)

• Have a history (engineered with application)

Recommendations

Please be sure, about the result you want to achieve and ask the following: 

• Do you want to keep the application in the controller, or the project? 

• Do you want to change the application in the project and teach it to the controller?

• Do you want to learn an application from the controller to the project?

If you want to keep the application in the project, learning the application from the con-
troller should be avoided for controllers with history. In this case, the controller should be 
cleared before, to avoid the destruction of the application in the project. 

If you want to keep the application in the controller, teaching the application to the con-
troller would not destroy the application. Only the changes are taught.

Note: If there are too many changes in the project or the controller, learning from and teaching 
to the controller does not work. Software always gives support by displaying appropriate 
messages which describe the status or problem and how to proceed.



EN2B-0414GE51 R1021 117

NIAGARA IRM ENGINEERING TOOL - USER GUIDE

IRM Function Blocks and External Application Components

The IRM program accepts IRM control components only. Direct connection between 
IRM control function blocks with Niagara components by using the Niagara Link function 
does not work. External communication should be established via BACnet components 
which link the IRM function blocks to the Niagara components.

Application Templates Usage

For quick engineering and avoiding hardware compatibility problems, use pre-defined 
onboard I/O configurations (templates) provided in the PhysicalPoints folder of the 
honIrmControl palette. While using any of these, make sure that they fit the physical 
device model.

Exposing Hardware, I/O Points on BACnet

When discovering datapoints on the BACnet network via the IRM BACnet device man-
ager, the I/O hardware points of the IRM controllers are not detected and visible by 
default.

To expose hardware, I/O points on the BACnet network, they must be prepared individu-
ally to make them discoverable. This is done by adding a BACnet function block, e.g. a 
BACnet numeric input, to the periodic or event-driven program and link it to the hard-
ware I/O point function block you want to expose on the BACnet network.

Procedure

Step 1. Double-click On Board I/O in the tree and select the Wire sheet view.

Step 2. On the wire sheet, identify the I/O hardware point you want to expose to the 
BACnet network and note its type and name, e.g. an analog output with the 
name “AO4 – HwAoFanSpeedCtl”.
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Step 3. On the On-Board I/O wire sheet, right-click the IO hardware datapoint, then 
click Link Mark in the context menu.

Step 4. Double-click on Periodic Program in the tree and then select the Wire sheet 
view. 

Step 5. From the honIrmControl palette, add a 'BACnet Numeric Input' BACnet 
function block to the wire sheet. 

Step 6. Change the default name to the name of the hardware I/O point you want to 
expose, e.g. 'AO4 – HwAoFanSpeedCtl'. 

Step 7. Click OK. The BACnet Numeric Input is added to the wire sheet. 
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Step 8. Right-click the BACnet Numeric Input, then click Link Mark in the context 
menu. 
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Composite View

Composite is an interface that allows you to virtually link control points, function blocks, 
and folders that contain control logic. When you create a composite, you create slots of 
child components in the parent component, that can simply link the configure and run 
the control logic. 

This interface allows you to group the application using their IrmFolders and IrmSubfold-
ers. That contains control logic that is virtually configured with control points, function 
blocks, and folders present in different folders.

Note: This feature is supported by both IRM Unitary FCU and Compact VAV controllers.

Whenever you are configuring more than 32 IRM folders, then it is recommended to 
statically divide your application to add logic in their folders for major applications and 
minor grouping use IrmSubFolders to configure items or folders. This will help to better 
memory management for the unitary controller. 

Steps to configure

Step 1. Add Irmfolder from palette to the Periodic program or Event program wire 
sheet.

Step 2. Double-click the Irmfolder, drag and drop function block to Irmfolders wire 
sheet.

Step 3. Right-click on the function block and select Composite.

Step 4. Add the input and output slots in the Composite editor and click Ok. 
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Step 5. Drag-drop Const1 Numeric function block to Irmfolder wire sheet, add value 
to the Const1Numeric, and click Save.

Step 6. Connect the output slot of Const1 Numeric to the input slots of IrmFolder.

If the maximum number of IrmFolders are used in the wire sheet, then you can add Irm-
SubFolders.

Note: IrmSubFolder cannot be added directly into the Periodic program or Event program. 
IrmSubFolder can only be added inside IrmFolder.

Step 9. Double-click on configured IrmFolder, drag, and drop IrmSubFolders function 
block to wire sheet. After adding the IrmSubFolders function block, configure 
the Const1Numeric function block. 

Step 10. Connect the output slot of Const1Numeric to input slots of IrmSubFolders.
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Note: Character renaming of IrmFolder and IrmSubFolder is restricted up to 20 characters. 

Note: IrmFolder and IrmSubFolder don't support parameters.

Also, you can check the IrmFolder memory usage along with the nested sub folder and 
functional count. The Sub folder Count displays the number of IrmSubFolder present in 
the IrmFolder and Functional Block Count displays the number of functional blocks 
present in the IrmFolder

To check Irmfolder memory usage
Step 1. Navigate to the Periodic program or Event program.
Step 2. Right-click IrmFolder>Views>AX property sheet. 

Functional Block memory usage

Each Function block contains the memory based on the configuration. You can check 
the individual functional block memory or a Composite view memory. Open the func-
tional block or Composite view property sheet to check the memory usage of each func-
tional block or a Composite view.
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IP Setting
IP Config operation is provided to ease IP configuration for multiple IP VAVs from a sin-
gle window. This feature allows user to perform many productivity operation like batch 
update of IP configuration, auto-increment of IP addresses, visual indication of modifica-
tions to IP addresses, user errors in IP configuration, offline and online IP configuration.

IP setting comprises IP Configuration and Network Time Server. 

Important: IP Setting feature supported on following controllers.

When you add IrmBacnetDevice into BACnet Network, by default the IP Setting option 
is hidden. 

To activate the IP Setting feature

Step 1. Go to IRM Program > double-click Control Manger. This open Control 
manager Property sheet.

Step 2. In Device Model Name, select the IP Setting supported model from the drop-
down list.

Step 3. Click Save.
Step 4. Right-click IrmBacnetDevice and select Refresh Tree Node. This activates 

the IP Setting feature.

VA75I24NM
VA00IB24NM
VA75IBWA24NM
VA75IBWB24NM
VA75I24NS
VA75IB24NS
VA75IBWA24NS
VA75IBWB24NS
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IP Configuration

Whenever a factory-out controller is discovered on a station, it searches for the available 
IP address on the DCHP server or local Ethernet IP address. 

If DHCP mode is enabled:

• On power-up; for the first 15 seconds, the controller will search for a DHCP server to 
acquire an IP address.

• If DHCP server (Switch) is not found, controller will switch to Auto IP mode in which 
it follows Link Local Addressing for address resolution.

• The controller acquires an IP address in range 169.254.1.0 - 169.254.254.254. It 
uses the last 2 characters of its Serial Number as the last octet for starting address 
search. 
For example, if the serial number ends with “36” (decimal value = 54), the IP address 
is set to169.254.1.54.

Note: From the firmware version 0.0.0.50 onwards, if a controller has the Link Local 
Addressing, it will periodically search for the DHCP server (every 1 minute). If the server 
is found, the controller acquires the new IP address from the server and starts using it 
immediately.

Default IP address type is DHCP for factory out controller, irrespective you are connecting 
to DHCP server or via ethernet.

To check IP Settings Details:

Step 1. Navigate to BacnetNetwork > IrmBacnetDevice (IP controller) > IP 
Settings.

Step 2. Double-click on IP Settings. This opens the IP Settings property sheet view
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Properties Description

Status Read-only. Display the status of the IP Configuration.
Fault Cause Read-only. Displays the fault cause information, which causes the IP configuration 

to go in a Fault state.
IP Interface Read-only. Displays the supported interface. The current engineering tool version 

supports Ethernet only.
Configuration 
Sync Status

Read-only. Displays the following configuration sync status

• Configuration Insync

• Configuration modified

• Configuration OutOfSync
Ethernet
IP Address Type Allows you to set IP Address type as DHCP or Static.

DHCP IP Address Type (Default): Displays available IP address for the control-
ler from DHCP server. All the IP4 Settings fields DHCP IP Address type is read-
only.

Static IP Address Type: Displays IP address for the controller when connected to 
the local ethernet port. All the IP4 Settings fields Static IP Address type is read and 
write.
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If the controller is connected via ethernet cable, you can change the IP address of the 
controller.

To change the IP settings

Step 1. Navigate to BacnetNetwork > IrmBacnetDevice (IP controller) > IP 
Settings

Step 2. Double-click on IP Settings. This opens the IP Settings property sheet view

After configuring IP Configuration save the configuration to the controller using Write IP 
Configuration to Controller. This action writes the IP configuration from the station to 
the controller platform.

Procedure
Step 1. Right-click on IP Configuration, select Action and click Write IP 

Configuration To Controller.

IPv4 Settings Allows to configure the following settings:

• Enter IP Address 

• Enter Subnet Mask address

• Enter Default Gateway 

Validation conditions which the tools check when IP Address configured:
• All Octet cannot be 0 for IP Address, Subnet Mask, Default Gateway

• First Octet cannot start with 0 for IP Address, Subnet Mask, Default 
Gateway

• The address should be in proper format and the value of Octet should be 
between 0 to 255 for IP Address, Subnet Mask, Default Gateway

• IP Address and Default Gateway should not be the same.

• All the bits in the host address portion of the IP address cannot be 0.

• All the bits in the host address portion of the IP address cannot be 1.

• The default gateway is not on the same network segment defined by the IP 
address and subnet mask.

• Invalid subnet mask, The subnet mask has to be contiguous.

• All the bits in the network address portion of the IP address cannot be 0.

• IP Address is not unique. (IP Address validation within the network)

• The first octet of IP Addresses should be between 1 and 223. (Class D IP 
address not accepted)

The first octet of the default gateway should be between 1 and 223. (Class D IP 
address not accepted).

Properties Description
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If the user wants to read the IP Configuration from the controller platform, use Read IP 
Settings from Controller.

Procedure
Step 1. Right-click on IP Configuration, select Action and click Read IP Settings 

from Controller.

Network Time Server

Allowing the user to add Network Time Server address. Users can enter supported IP 
address (example: 129.6.15.28) or server URL link (time.googel.com)

After configuring Network Time Server save the configuration to the controller using 
Write NTS Configuration to Controller. 

Procedure
Step 1. Right-click on Network Time Server, select Action and click Write NTS 

Configuration to Controller.

If the user wants to read the Network Time Server from the controller platform, use Read 
NTS Configuration from Controller.

Procedure
Step 1. Right-click on Network Time Server, select Action and click Read NTS 

Configuration from Controller.
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If user has updated or configured both IP Configuration and Network Time Server 
property of IP Setting. After configuring IP Setting save the configuration to the control-
ler using Write IP Setting to Controller. This action writes the IP configuration and Net-
work Time Server changes from the station to the controller platform.

Procedure

Step 1. Right-click on IP Settings, select Action and click Write IP Settings To 
Controller.

If the user wants to read the IP Settings from the controller platform, use Read IP Set-
tings from Controller.

Procedure

Step 1. Right-click on IP Settings, select Action and click Read IP Settings from 
Controller.

Configuring IP Settings for multiple controllers

IRM Engineering tool allows you to configure IP settings for multiple controllers in a 
batch process. 

Procedure

Step 1. Right-click on BacnetNetwork > Views > Irm Bacnet Device Manager 
view.

Step 2. Select all the IRM devices from the device list.

Note: IP Config option not active, if any BACnet spyder device is selected from the device list.

Step 3. Click IP Config.
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This displays the IP Config batch window, which consists of Ethernet settings 
and Network Time Server settings.

Note: NOTE: In the IP Config window, all the listed devices belong to one network, which is 
determined during the selection of the first device from the IRM Device Manager view. 

Step 4. Set the IP Address type as DHCP or Static (default IP address type) for all 
the listed IRM devices from the IP Config batch window. 
• For Static IP address type: Any change in the Ethernet settings or 

Network Time server setting will update the respective column in device 
the list.

• For DHCP address type: If DHCP IP Address type selected the IP 
Address, Subnet Mask and Default Gateway for all the listed IRM device 
updated to auto and IP4 Settings fields updated to read-only.

Note: NOTE: Static IP Address configuration data for all the listed IRM controllers will be not be 
deleted after changing the IP Address type to DHCP. If you desired to revert back to the 
Static IP Address type, change the IP Address type to Static. 

Step 5. Click OK.
Now, the IRM tool performs two operations: 
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10. After clicking OK, the IRM tool starts validating details of all the listed IRM 
controllers. If details of all the listed IRM controllers are correct. 

11. IRM tool starts updating the device level component for selected controllers.

If any invalid configuration is discovered, the IRM tool generates an error report.

If devices are online, perform the Write IP configuration to Controller.

If the devices are offline, perform a write to device level component.
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Bluetooth Configuration
Bluetooth Configuration is provided to batch configure BLE configuration for Beats IP 
and MSTP devices. This feature allows user to perform operation like configure the BLE 
enable/disable function, setting password, BLE enable start and end time to enable 
mobile balancing application to connect to the devices over BLE.

Important: Bluetooth Configuration feature supported on following controllers.

When you add IrmBacnetDevice into BACnet Network, by default the IP Setting option 
is hidden. 

To activate the IP Setting feature
Step 1. Go to IRM Program > double-click Control Manger. This open Control 

manager Property sheet.

VA423B24N
VA00IB24NM
VA75IBWB24NM
VA75IB24NS
VA75IBWA24NS
VA75MB24NM
VA00MB24NM
VA75MB24NS
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Step 2. In Device Model Name, select the IP Setting supported model from the drop-
down list.

Step 3. Click Save.
Step 4. Right-click IrmBacnetDevice and select Refresh Tree Node. This activates 

the Bluetooth Configuration feature.

Important: Ensure to check the following points before performing Bluetooth configuration.

 - All IRM devices support the UTF-8 format, Therefore, when a user sets the device 
name using the device object, the tool will write the data the UTF-8 format.

 - User given device name from Niagara workbench using device object will not display 
VAV Balancing app “Device Discovery page” if the character set in not set to UTF-8.

To set the Character Set to ISO 10646_UTF8.
Step 1. Go to BacnetNetwork property sheet.
Step 2. Under Local Device property set the Character Set to ISO 10646_UTF8.

Ensure that before changing the device name, the BACnet network is configured for 
character set UTF-8, or else the in VAV balancing app device discovery page will not  
display the device.

Bluetooth configuration is applicable for both MSTP VAV and IP VAV controllers.

Steps to enable Bluetooth Configuration
Step 1. Navigate to BacnetNetwork > IrmBacnetDevice > double-click on 

Bluetooth Configuration. 
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Step 2. Set Bluetooth Status to Enabled.

Bluetooth Configuration allows you to set a passcode for connected Bluetooth devices, 
which helps you to authenticate the correct device. The passcode is 8 digit number; the 
default passcode is 00000000. You can set your passcode or generate a random pass-
code. Also, you can set the validity of the passcode.

To set Bluetooth device passcode:
Step 1. Right-click Bluetooth Configuration > Actions > Generate Passcode.

To set Bluetooth device passcode validity:

Step 1. Navigate to Bluetooth Configuration, double-click on Bluetooth 
Configuration to open the property sheet.

Step 2. Under Bluetooth Passcode Validity, select the Start Date and End Date.

After configuring Bluetooth Configuration save the configuration to the controller using 
Write BLE Configuration to Device. 

Procedure
Step 1. Right-click on Bluetooth Configuration, select Action and click Write BLE 

Configuration to Device.

If the user wants to read the Bluetooth Configuration from the device, use Read BLE 
Configuration from Device.
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Procedure
Step 1. Right-click on Bluetooth Configuration, select Action, and click Read BLE 

Configuration from Device.

Bluetooth Configuring for multiple devices

IRM Engineering tool allows to perform Bluetooth configure on multiple controllers in a 
batch process. 

Steps to perform Bluetooth configure on multiple controllers

Step 1. Right-click on BacnetNetwork > Views > Irm Bacnet Device Manager 
view. 

Step 2. Select all the IRM devices from the device list.

Note: BLE Config option not active, if any unsupported device is selected from the device list.

Step 3. Click on BLE Config and set Generate New Passcode to True or False.

Step 3. Set Bluetooth Status to Enabled. This enables Bluetooth features for all the 
selected IRM devices.

Step 4.  Set Bluetooth Passcode and Bluetooth Passcode Validity.
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Download BLE Firmware

Steps to download Bluetooth Firmware.

Step 1. Right-click on BacnetNetwork > Views > Irm Bacnet Device Manager 
view. 

Step 2. Select all the IRM devices from the device list.

Note: Download BLE Firmware option not available, if any unsupported device is selected 
from the device list.

Step 3. Click on Download BLE Firmware.
Step 4. Navigate to firmware file and click open.

Step 5. Check the job log to check the status of Bluetooth firmware download.

Result: The Bluetooth firmware of the controller is updated. The successful action 
is displayed in the workbench job service.

Step 6. Click OK.
Step 7. Power cycle the controller.
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Link Creation
Links are the basic mechanism of execution flow in the Niagara Framework. Links allow 
components to be wired together graphically by propagating an event from one slot to 
another slot. 

A link is used to establish an event relationship between the source link and the target 
link. The source link generates an event when the output slot value gets modified and 
the value propagated to the input slot of the target link.

The IRM Engineering tool does not support connecting a target function block slot from 
2 different source function blocks. But users can override default Niagara behavior by 
enabling the FanIn flag and connect from more than one source slot. This is invalid pro-
gramming in the IRM Engineering tool, to stop the user from creating invalid links, the 
latest IRM Engineering tool added a check to disallow the user from enabling the fan-in 
flag.

To control this issue, the user needs to install the latest IRM engineering tool. This 
restricts the user to set the FanIn flag and displays an error message.

Important: If any of the existing stations got FanIn flag enabled, the user cannot start the station 
using the new IRM Engineering tool version. The user needs to first remove the FanIn 
flag and delete if there are more than one link to the same slot, then use the new IRM 
engineering tool to start the station.

Similarly, the IRM Engineering tool does not support connecting two components across 
the devices. Using Link Mark user can connect two components across the devices to 
override default Niagara behavior, this is invalid programming. To stop the user from 
connecting components across the devices, check added in the IRM Engineering tool, 
which restricts the user from creating invalid links.
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Modbus Interface Engineering
Important: Modbus Engineering interface is supported by IRM Unitary FCU controllers (WEB-RL6N 

and WEB-RS5N).

The Modbus protocol is described in the following two documents, which can be found 
at www.modbus.org:

• Modbus_over_serial_line_V1_02.pdf

• Modbus_Application_Protocol_V1_1b3.pdf

Addressing and Wiring Rules

Step 1. Use only one IRMNX controller per Modbus network.
Step 2. The maximum number of devices — 32, including the IRMNX controller. 

Overloading the network will impact the performance.
Step 3. Address: Can be from 1 to 247.

Note: Never use the address 0, because 0 is used by the IRMNX controller exclusively for 
broadcast addresses.

Note: Address must be unique on the Modbus.

Note: Dip switch setting (when available) must be correct (depending on its physical 
connection) for every Modbus device address.

Step 4. Termination and Bias: Must be correct for every IRM Modbus Device.
Step 5. The naming of Modbus terminals. Modbus devices may use different naming 

and descriptions for the wire connections. Possible synonyms can be as 
follows:
• Transmit Data: TxD, Tx, T+/R+, D1, B

• Receive Data: RxD, Rx, R-/T-, D0, A

• Signal Ground: GND, COMMON

Note: A and B are not clearly defined and can vary from one manufacturer to another. Verify the 
correct definition of A and B with the manufacturer of the Modus device before wiring.

Engineering Workflow

The following order of investigation and checks is recommended:

a. Get Modbus RTU slave device documentation — It is mandatory to have the 
vendor’s documentation of the Modbus functionality for every Modbus 
device that is to be connected to the IRM Modbus Device. This will allow 
obtaining most of the required information, but most likely not all of it. 
Missing information can be obtained from the support function of the ven-
dor.

b. Verify usage and activation of the correct Modbus device interface — Modbus 
devices may not have the Modbus interface activated by default. Activation may 
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be necessary via software, for example, setting a parameter via the Modbus 
device’s user interface. In addition, activation may be necessary via hardware, 
for example, shorting an input of the Modbus device. While using any Modbus 
device, verify that you have the correct hardware variant which supports Modbus 
on the RS485 interface as expected. 

c. Verify RTU Transmission Mode — All Modbus devices must use transmission 
mode RTU. No other transmission mode (for example, ASCII) is supported.

d. Ensure only one Modbus RTU master is on the bus — There is only one Modbus 
master allowed on the bus, which is the IRMNX controller. It does not support 
"Multi-Master" or "Modbus plus" devices, nor does it support such configurations 
on the Modbus. As per the Modbus standard, the IRMNX controller (as the 
master device) does not have a Modbus address. The IRMNX controller must be 
added to the Bacnet Network.

Follow the below steps to add IRMNX controller to Bacnet Network

Step 1. Drag and drop IrmBacnetDevice from honIrmControl palette to 
BacnetNetwork
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Step 2. Add Modbus Device to Periodic or Event Program wire sheet. In the Nav 
tree, expand the IRM Program folder of the controller. Double-click on the 
Periodic program icon

Step 3. Drag and drop ModbusDevice from honIrmControl palette to wire sheet

Step 4. Change name in the dialog box
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Step 5. To enter ModbusDevice settings double click on the ModbusDevice function 
block in the wire sheet.

Step 6. Check Modbus Channel Communication Parameters

Baud Rate: All Modbus devices must have an identical Baud rate, an identical 
Parity, and an identical number of stop bits.
Typically, the Baud rates of Modbus devices are set and changed via 
their user interfaces or their separate configuration software.
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Step 7. Check Modbus Device Settings

Parity: Modbus devices may have a configurable Parity, they will not have a 
configurable number of stop bits.
If a Modbus device has an un-matching number of stop bits, this 
device cannot be used.
Note: Not all Modbus products comply with the Modbus standard. 
Modbus devices that have implemented "no parity" may have 1 or 2 
stop bits.

In most cases, select Modbus Parity as “Even.”
Stop Bits:

If Modbus Parity = “None, then select Modbus Stop Bits = “2”.
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Device Address: Modbus devices can have addresses between 1 and 247. All 
Modbus devices must have a different address. Typically, the 
Modbus addresses of third-party Modbus devices are set and 
changed via their user interfaces or their separate configuration 
software.

Byte Order:

The Modbus standard defines the serial bit order to be Least 
Significant Bit First and Most Significant Bit Last.
However, the Modbus standard does not define the Byte and 
Word order of messages. Hence, there are Modbus devices that 
will transmit Most Significant Byte First or Lower Significant Byte 
First. 
For 32-bit values, Most Significant Word First or Lower 
Significant Word First may be implemented.
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Step 8. Add Read & Write points
Step 9. Select the Read Point tab and click on Add.

Step 10. Enter the following details

Max Read Points
Counts:

Via Modbus, the controller can request a single register of a 
Modbus device and then gets back a single value as a response 
or it requests several registers (start register, number of 
registers) and gets back several values in one response.
This method results in less data traffic on the bus and thus it 
accelerates communication.
The controller recognizes successive registers with the same 
operating mode and then automatically asks for multiple 
registers in a message.
Often, however, the manufacturer of the Modbus device has 
limited the number of registers that can be requested with a 
single message. This limitation can be entered here. The 
IRMNX controller can query up to 20 consecutive registers in a 
single message.

Table 1 :  Read Point property 

Property Description

Read Point 
Name

User-defined name



144 EN2B-0414GE51 R1021

NIAGARA IRM ENGINEERING TOOL - USER GUIDE

Read Point 
Address

The address range is 0-65535 
Against device manufactured as per Modbus specification, an 
address offset of "-1" might be required, because the address 
range starts at 0.
The Read Point Address is the data address and NOT the Coil or 
Register Number of the Modbus device.
Information is stored in the Modbus devices in four different 
tables. Two tables store on/off discrete values (coils) and two 
store numerical values (registers). The coils and registers each 
have a read-only table and read-write table. Each table has 9999 
values.
Each coil or contact is 1 bit and assigned a data address 
between 0000 and 9998.
Each register is 1 word = 16 bits = 2 bytes and has a data 
address between 0000 and 9998
Note: Read Point Address accepts both decimal and Hex format. 

• Hex format: 0xfff 

• Range: 0 – 270F

Example:
The first Holding Register, number 40001, has the Data Address 
0000.
The difference between these two values is the offset.
Each table has a different offset. 1, 10001, 30001, and 40001.

Read Point Type

Table 1 :  Read Point property 

Property Description

Coil/
Register 
Numbers

Data 
Addresses Type Table Name

1-9999 0000 to 270E Read-Write Discrete 
Output Coils

10001-19999 0000 to 270E Read-Only Discrete Input 
Contacts

30001-39999 0000 to 270E Read-Only Analog Input 
Registers

40001-49999 0000 to 270E Read-Write Analog Output 
Holding 
Registers
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Operation Mode 
(Poll Rate)

This parameter allows adapting to the communication and 
processing performance of the Modbus device.
If the Modbus device does not respond fast enough, increase the 
poll rate.

• DoNotRea — Output is NULL

• Slow — Register is read after multiple of 5 seconds, one 
register at a time.

• Normal — Register is read after all high priority registers are 
read, one register at a time.

• Fast — Register is read every 50 ms.

• UserDefined — Allow user to defined polling time

Note: Not all Modbus products comply with the Modbus 
standard. Modbus devices that have implemented "no parity" 
may have 1 or 2 stop bits.

Scaling Factor Read value is multiplied by 10^Scaling Factor
For example, 
Read value=1500. With Scaling Factor -3 the calculated value = 
1.5 
Read value=1500. With Scaling Factor +2 the calculated value = 
150000

Table 1 :  Read Point property 

Property Description
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Step 11. Click OK

Data Format

Poll Time (Sec)

Allows the user to defined polling time. This is a number between 
60 and 86400.

Event Bit 
Masking

If the Read Point is read in the Event Program, the value can be 
masked via the Event Bit Mask. Whenever the masked value 
changes, the logic of the Event Program Wire Sheet view is 
executed immediately. Masked value means logical AND with 
the value received from the Modbus.

The Event Program Wire Sheet logic is executed periodically. 
Additionally, it can be executed immediately (event-driven), such 
an event can be triggered by a Modbus value.
Masked Occupancy Sensor: The execution of the Event 
Program Wire Sheet logic will immediately be executed when 
the Occupancy Sensor Bit changes. 
None masked Occupancy Sensor (0xFFFF): The execution of 
the Event Program Wire Sheet logic will be executed 
immediately when the Occupancy Sensor or the Brightness 
Sensor changes.

Table 1 :  Read Point property 

Property Description

SingleBit
Int16 : -32768 to 32767

Uint16 : 0 to 65535
Int32 : -2147483648 to 2147483647

Uint32 : 0 to 4294967295
Float : -3.4E+38 to +3.4E+38 (32 Bit)
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Step 12. Select the Write Point tab and click Add.

Table 2 :  Write Point property

Property Description

Write Point Name User-defined name

Write Point Address For details see to Read Point Address
Write Point Address:

• Decimal Range: 0-9999

• Decimal format: 9999

• HEX Range: 0 – 270F

• Hex format: 0xfff
Write Point Type
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Data Format

Significant Change To reduce bus load a significant change for analog values 
is recommended. This ensures that values are only sent 
when the value has changed significantly from the value 
previously sent. 

To finish the Modbus configuration press, save and 
then click in the Nav Tree on the Periodic or Event 
program.

Table 2 :  Write Point property

Property Description

SingleBit
Int16 : -32768 to 32767

Uint16 : 0 to 65535
Int32 : -2147483648 to 2147483647

Uint32 : 0 to 4294967295
Float : -3.4E+38 to +3.4E+38 (32 Bit)
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Delete a Modbus Device in Wire Sheet View

A complete ModbusDevice function block with configured Read and Write Points can 
only be deleted via right-clicking it, point to the Actions menu, and click Delete Modbus 
Device menu entry. The standard Delete function will not work.

Duplicate Modbus Device for further usage

Save Function Block as a Template: In the Periodic Program and Event Program Wire 
Sheet view, the right-click duplicate function only copies the device without the con-
nected function blocks. To have a complete Modbus Device configuration as a template, 
please use the Save As Template function.

Procedure

Step 1. Right-click in the Wire Sheet View on the item you want to reuse and select 
Save As Template.
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Step 2. Select Location where to save the template.

Step 3. The template will be saved in the. Palette file. The default name will be the 
name of the marked function block.
If you want to add a function block to an existing template, just mark it in the 
Wire Sheet, click on Save As Template and select an already existing palette 
file and choose Append.

Insert Function Block saved as a Template
Step 4. Open palette file.

Step 5. Choose the template file 
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Step 6. Double click on ModbusDevice in Palette panel shows in template saved 
function blocks

Now mark in the Wire Sheet the components you want to use (Ctrl+A, Ctrl+left Mouse 
Click, or via frame). Copy the selection via Ctrl+C and paste it to your target Wire Sheet 
(for example, Periodic Program) via Ctrl+V.

Verify Modbus Communication (Trouble Shooting)

For a first test of the communication, connect only one Modbus device using a short 
cable (i.e. cable less than 3 meters in length).

Step 1. Create one Read Point — this Read Point should have a known value that 
can be verified.

Step 2. Verify that the T2 and R2 LEDs are flickering (indicating data communication). 
Use the IRM Engineering Tool to verify that the Modbus data can be read and 
written.

Step 3. T2 LED indicates sending a request message to a Modbus Device and R2 
LED indicates receiving an answer message from the Modbus Device.

Possible error causes could be wrong settings for Baud rate, Parity, and Stop bits.

The function block Modbus Read Point has two outputs:
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Possible error causes:

• Reverse Modbus polarity 

• The polling interval defined in Operation Mode is too short, (Out Cause = Timeout = 
8) Some devices do not support fast polling and therefore might not be able to 
respond in time.

Note: Modbus device failure behavior - If a Modbus device does not respond to a register poll 
command, the register is entered into the list of "Failed Registers". After that, the IRM 
polls this single register only every 10 seconds. If the register could be read successfully, 
the register is read again in the defined interval.

• Read/Write Point Address Offset +1/-1

• Device Setting Byte Order

Once this is working properly, add the next Modbus device. 

Out = received value from the Modbus Device
Out Cause = error code. 0 = no error; Further values are listed in the Niagara 

Guide Help of the Modbus Read Point function block. Out Cause pin 
slot is not visible by default and needs to be enabled.
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VAV System
A Variable Air Volume (VAV) system allows a single unit to provide the appropriate 
amount of cooling to multiple zones with different cooling loads. The VAV regulates the 
volume of the air to the zone by opening or closing the damper. This damper is con-
trolled by a floating motor, which is installed on an integrated actuator of the IRM Com-
pact VAV controller. 

It is recommended to integrate the Global application engineering template in the Niag-
ara N4 workbench, to work with IRM Compact VAV applications. For more details refer 
to Global VAV Application Engineering Guide - 31-00465 and Global VAV Application 
Design User Guide - 31-00466.

Prerequisite

• Check the system requirements before performing engineering/commissioning.

• Make sure that the latest Niagara N4 workbench installed on the desktop.

• Use the latest version of the IRM Engineering Tool.

Deploying Global VAV Application Template

Deploy a Global VAV application template on a station by dragging from the Template 
side bar onto the project station. This is similar to dragging and dropping components 
from a palette.

Steps to Deploy VAV Application Template 

Step 1. Copy and paste your application template under Niagara installed path in the 
Templates folder (C:\Users\User Account\Niagara4.8\Webs\templates)

Step 2. Run the Niagara station and navigate to Window > Side Bars > click 
Template. This opens the Template sidebar.

System Requirements
Niagara Honeywell N4.4.XX.XXX and higher
Firmware Download the latest firmware version
Engineering Tools Download latest IRM Engineering Tool
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Step 3. Select application template as per the site requirements.
• VAV_ISF1_HX_FX_IM-2.X", Ver. 2.x (supports imperial unit)

• VAV_ISF1_HX_FX_SI-2.X", Ver. 2.x (supports SI unit) 

Step 4. Select the *.ntpl  file per project requirement and drag and drop the *.ntpl  file 
in the project station. 

This action opens the configuration property window of the template.
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Step 5. Configure the template properties as per your project requirement. 

Step 6.  Click OK to save the configuration.

Note:  If you want to reuse the same template in another station, then use Save As option to 
save the template with a different filename (leaving the original template unchanged).

Note: After deployment, the VAV templates are displayed in the Station under the 
BacnetNetwork , see the below image.

Note: Opening the template via Palette is not recommended, it will not create the PX images in 
the desired location.
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Flow Balancing View

The Flow Balancing tool can be configured with various parameters and indicators to 
optimize the calibrations, which are used to balance the airflow. 

Based on the version of the VAV application and its features, the following operations 
can be performed on the Flow Balancer View.

• Flow pressure zero calibration

• K factor calibration

• Two point calibration

• Heating coil water flow calibration

• Auto mode operation

• Restoring to factory defaults

Figure  5. Flow Balancing View
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The following table describes the Flow Balancing Parameters.

Parameters Description

Flow Balancing Parameters

Actuator Travel Time The Actuator travel time is the time required by the actuator to 
travel from 0% to 100% open or 100% to 0% open. This time 
interval depends on the actuator type and varies from 0 to 500 
seconds.

K Factor This field allows you to manually change the K factor value 
from 0 to 10000.

Inlet Area Displays the area of the duct. Either a standard diameter can 
be selected, or a custom area can be entered in this field. The 
inlet area ranges from 0 to 100 sq. ft.

Measured Flow Displays the actual airflow when measured by the balancer 
using an accurate device. This field is editable.

Maximum Flow 
Setpoint

This field allows you to set the flow setpoint from 0 to 138850 
cfm for maximum flow calibration and k factor calibration. The 
controller tries to stable airflow, when it allows you to set the 
calibration source value.

Minimum Flow 
Setpoint

This field allows you to set the flow setpoint value from 0 to 
138850 cfm. You must set the flow setpoint less than the 
maximum value to obtain minimum flow calibration. The 
controller tries to stable airflow, when it allows you to set the 
calibration source value.

Valve Override Parameters

Re-heat Valve 
Override

This field allows to override the value of the reheat valve in an 
application built for the reheat valve. This field is visible when 
the Reheat Valve Override Supported feature is enabled in 
the Details View of the Control Program.

Peripheral Heat 
Valve Override

This field allows to override the value of the peripheral heat 
valve in an application built for the peripheral heat valve. This 
field is visible when the Peripheral Heat Valve Override 
Supported feature is enabled in the Details View of the 
Control Program.

Flow Balancer Status (This are a non-editable field)

Device Mode Displays the current device mode. 
Damper Position Displays the current damper position.
Sensed Flow Displays the actual airflow that is measured by a pressure 

sensor. 
Flow Pressure Displays the current flow pressure. 
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Prerequisites

• Configure the IRMNX controller for the VAV application. Below is the tool 
configuration that the user needs to configure under Control Manager.

• The controller must be online.

• The controller must be in a commissioned and synchronous state.

• User must configure the BACnet object as per the rules given in the below table, i.e. 
with specific point name, object ID, point type, and respective units in the application, 
to operate in Flow balancer view. For details about BACnet objects, see BACnet 
objects details and requirement for Air flow balancing.

Application Type  VAV Zone Terminal Single Duct Application
Application Feature – Air Balance Supported is mandatory and other features as 

programmed in the application
– Reheat Valve Override Supported option to calibrate the 
reheat valve.
– Peripheral Heat Valve Override Supported option to 
calibrate the peripheral heat valve.

Point Name Point 
Type

Object 
ID

SI Metric 
Unit Imperial Unit

CfgKFactor Analog 
value

1000 Liter per 
second

Cubic feet per minute

CfgDuctArea Analog 
value

1001 Sq meter Square foot

CfgMaxFlowSetpt Analog 
value

1002 Liter per 
second

Cubic feet per minute

CfgMinFlowSetpt Analog 
value

1003 Liter per 
second

Cubic feet per minute

BalKFactorOffset Analog 
value

1004 Pascal Inches of WC

BalKFactorOffset Analog 
value

1005 Liter per 
second

Cubic feet per minute

BalMaxMeasFlow
Act

Analog 
value

1006 Liter per 
second

Cubic feet per minute

BalMaxMeasFlow
Spt

Analog 
value

1007 Liter per 
second

Cubic feet per minute

BalMinMeasFlow
Act

Analog 
value

1008 Liter per 
second

Cubic feet per minute

BalMinMeasFlow
Spt

Analog 
value

1009 Liter per 
second

Cubic feet per minute
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Note: The configuration must be done before downloading the program to the controller.

FlowOvrdState Analog 
value

1010 No unit No Unit

FlowOvrdPct Analog 
value

1011 Percentage Percentage

FlowOvrdFlow Analog 
value

1012 Liter per 
second

Cubic feet per minute

BoxFlow Analog 
value

1013 Liter per 
second

Cubic feet per minute

VelSenPress Analog 
value

1014 Pascal Inches of WC

DamperPos Analog 
value

1015 Percentage Percentage

Point Name Point 
Type

Object 
ID

SI Metric 
Unit Imperial Unit
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BACnet objects details and requirement for Air flow balancing

Step 1. CfgKFactor: This datapoint is used to set a factory k factor value in the bal-
ancing tool. Currently, the tool expects a value greater than equal to 10.

Step 2. BalKFactorOffset: This datapoint will be set with the k factor value sent from 
the balancing tool. After performing k factor balancing, the balancing tool will 
set the calculated k factor. 

The balancing tool makes sure that the calculated k factor value is equal to CfgKFactor 
plus BalKFactorOffset.

Step 3. BalBoxZeroOffset: This value will be set by the balancing tool after performing 
zero calibration.

Step 4. CfgDuctArea: This value will be set by the user based on the VAV controller.

Step 5. CfgMaxFlowSetpt: The maximum flow setpoint value will be set by the user in 
the balancing tool. The same value will be used in the application.

Step 6. CfgMinFlowSetpt: The minimum flow setpoint value will be set by the user in 
the balancing tool. The same value will be used in the application.

Step 7. BalMaxMeasFlowAct: The balance maximum flow actual value will be set by 
the user in the balancing tool. When doing, the maximum flow balancing the 

Point Name Point Type Object ID SI Unit Imperial Unit
CfgKFactor Analog 

value
1000 Liter per second Cubic feet per 

minute

Point Name Point Type Object ID SI Unit Imperial Unit
BalKFactorOffset Analog value 1005 Liter 

per 
second

Cubic feet per minute

Point Name Point Type Object ID SI Unit Imperial Unit
BalKFactorOffset Analog value 1004 Pascal Inches of WC

Point Name Point Type Object ID SI Unit Imperial Unit

CfgDuctArea Analog value 1001 Sq meter Square foot

Point Name Point Type Object ID SI Unit Imperial Unit

CfgMaxFlowSetpt Analog value 1002 Liter per 
second

Cubic feet per minute

Point Name Point Type Object ID SI Unit Imperial Unit

CfgMinFlowSetpt Analog value 1003 Liter 
per 
second

Cubic feet per minute
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actual measured flow will be set to this data point. This data point is used in a 
2-point balancing ratio block.
If the VAV controller is k factor balanced, then the balancing tool will set the 
maximum flow setpoint to this data point.

Step 8. BalMaxMeasFlowSpt: The maximum flow setpoint value will be set by the 
user in the balancing tool. The same value will be used in an application in a 
2-point balancing ratio block.

Step 9. BalMinMeasFlowAct: The balance minimum flow actual value will be set by 
the user in the balancing tool. When doing, the minimum flow balancing the 
actual measured flow will be set to this data point. This data point is used in a 
2-point balancing ratio block.
If the VAV controller is k factor balanced, then the balancing tool will set the 
minimum flow setpoint to this data point.

Step 10. BalMinMeasFlowSpt: The minimum flow setpoint value will be set by the user 
in the balancing tool when doing the minimum flow balancing. The same value 
will be used in an application in a 2-point balancing ratio block.

Step 11. FlowOvrdState:
a. Max balancing flow override state 7

In the application, the effective flow setpoint will be set to the maximum flow 
setpoint and the controller ramp up its output and the damper will open until the 
sensed flow is equal to the flow setpoint.
When the measured flow has attained the effective flow setpoint (abs 
(CfgMaxFlowSetpt – BoxFlow) < = (CfgMaxFlowSetpt * 0.05)) for at least 5 
seconds, the balancer will enter the measured flow and the same value will be 
set to data point BalMinMeasFlowAct.

b. Min balancing flow override state 6

Point Name Point Type Object ID SI Unit Imperial Unit

BalMaxMeasFlowAc
t

Analog value 1006 Liter per 
second

Cubic feet per minute

Point Name Point Type Object ID SI Unit Imperial Unit

BalMaxMeasFlowSpt Analog 
value

1007 Liter 
per 
second

Cubic feet per minute

Point Name Point Type Object ID SI Unit Imperial Unit

BalMinMeasFlowAct Analog 
value

1008 Liter 
per 
second

Cubic feet per minute

Point Name Point Type Object ID SI Unit Imperial Unit

BalMinMeasFlowSpt Analog 
value

1009 Liter 
per 
second

Cubic feet per minute
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In the application, the effective flow setpoint will be set to the minimum flow 
setpoint and the controller ramp down its output and the damper will close until 
the sensed flow is equal to the flow setpoint.
When the measured flow has attained the effective flow setpoint. 
(abs (CfgMaxFlowSetpt – BoxFlow) = (CfgMaxFlowSetpt * 0.05)) for at least 5 
seconds, the balancer will enter the measured flow and the same value will be 
set to data point BalMinMeasFlowAct. 

c. Zero balancing flow override state 5
In the application, the effective flow setpoint will be set to value 0, and the 
controller ramp down its output, and the damper will close until the sensed flow is 
equal to the flow setpoint.
When the flow has attained the effective flow setpoint, the balancing tool will 
calculate the offset pressure and will set the value to data point 
BalBoxZeroOffset

d. K factor balancing flow override state 7
In the application, the effective flow setpoint will be set to the maximum flow 
setpoint and the controller ramp up its output and the damper will open until the 
sensed flow is equal to the flow setpoint.
When the measured flow has attained the effective flow setpoint, the balancing 
tool will calculate the offset k factor and will set the value to data point 
BalKFactorOffset.
KFactorNew = Measured Flow / √(VelSenPress)

e. Mode to Auto flow override state 0

When the mode is set to Auto in the balancing view, then the application will be set to 
auto mode.

Note: If the measured airflow has not attained the effective airflow setpoint within the set 
actuator travel time, then check the correctness of the K factor value and the flow control 
loop.

Note: Before the user migrates the existing IRM application to the IRM application, the user 
needs to configure proper units as per the measurement type for CfgKfactor, 
BalBoxZeroOffset, and BalKFactorOffset data points (earlier these points were not 
having any units).

Step 12. FlowOvrdPct: When the datapoint FlowOvrdState is set to 3 from the 
application, then the damper will be overridden to FlowOvrdPct. This is not a 
mandatory datapoint for balancing.

Step 13. FlowOvrdFlow: When the datapoint FlowOvrdState is set to 2 from the 
application, then effective flow setpoint will be set to FlowOvrdFlow and the 

Point Name Point Type Object ID SI Unit Imperial Unit

FlowOvrdState Analog value 1010 No unit No Unit

Point Name Point Type Object ID SI Unit Imperial Unit

FlowOvrdPct Analog value 1011 Percentage Percentage
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controller will ramp its output to reach the effective flow setpoint. This is not a 
mandatory datapoint for balancing.

Step 14. BoxFlow: This datapoint is used to detect if the flow has been attained while 
balancing. This is used in the balancing view sensed flow.

Step 15. VelSenPress: This data point is used in the balancing view flow pressure.

Step 16. DamperPos: This data point is used in the balancing view damper 
position.Flow velocity function block 

Flow calculation with metric and imperial unit

The below metric units are calculated from VAV controller specification in imperial units

Point Name Point Type Object ID SI Unit Imperial 
Unit

FlowOvrdFlow Analog value 1012 Liter per 
second

Cubic feet per 
minute

Point Name Point Type Object ID SI Unit Imperial Unit

BoxFlow Analog value 1013 Liter per 
second

Cubic feet per 
minute

Point Name Point Type Object ID SI Unit Imperial Unit

VelSenPress Analog 
value

1014 Pascal Inches of WC

Point Name Point Type Object ID SI Unit Imperial Unit

DamperPos Analog 
value

1015 Percentage Percentage

Inlet area – 1.2 sq ft = > 0.1115 sq meters
Maximum Flow Setpoint: – 1400 cfm = > 2379 m3/h
Minimum Flow Setpoint: – 700 cfm = > 1189 m3/h

K Factor: – 1400 cfm @ 1” wc = > 2379 @ 249 pa

Pressure Imperial SI

inch wc K Factor = 1400 cfm @ 1” wc
Area = 1.20 sq feet

K Factor = 2379 m3/h @ 249 pa
Area = 0.11 sq meter

1 Flow = 1400 cfm Flow = 2379 m3/h

2 Flow = 1979.70 cfm Flow = 3364.41 m3/h
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0.25 Flow = 700 cfm Flow = 1189.5 m3/h
1.45 Flow = 1685.82 cfm Flow = 2864.70 m3/h
0.12 Flow = 484.97 cfm Flow = 824.11 m3/h

Pressure Imperial SI
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Configuring Flow Balancer view

Note: Before you start operating the Flow balancer tool, you must configure the object names 
with specific object ID, object type, and respective units in the application, to perform the 
operation in the Flow balancer view, see Table 1. Flow Balancing View Validation Rules.

Step 1. On the Nav palette, browse to Station > Config > Drivers> BacnetNetwork 
> BacnetDevice > IRM Program > Control Manager.

Step 2. Double-click on Control Manager and configure Application Details Config. 
Step 3. Navigate to the Application Type as VAV Zone Terminal Single Duct 

Application from the drop-down list.
Step 4. Navigate to the Application Features as Air Balancing Supported. If you want 

to calibrate the reheat valve and peripheral heat valve, select Reheat Valve 
Override Supported and Peripheral Heat Valve Override Supported options.

Step 5. Navigate the Measurement Type, select SI-Metric or Imperial. The object 
unit should match the global measure type or else it will generate an error 
when you run the Flow balancer view. 

Step 6. Once the configuration is complete, the tool gets integrated into the 
application. The Flow Balancer View identifies and validates the configured 
data points of the VAV application. The Flow Balancer View brings those 
values from configured data points to perform the balancing.

Step 7. Right-click Control Program and select Views > Flow Balancing View. The 
Flow Balancing View appears on the right pane.
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If the configured object ID, object type, and respective units in the application do not 
match, the Flow balancer tool identifies and generates errors from the application. 

The application validates in five stages:

Type of errors generated 

• If you run the Flow balancer tool without configuring as per the VAV application, the 
application will generate an error.

• If you run the Flow balancer tool with an incorrect network interface, the application 
displays error.

• If you run the Flow balancer tool, when the device is offline, the application will 
generate an error.

• If you run the Flow balancer tool, when the tool doesn't have enough objects to 
balance, the application will generate an error.

Stage 1: Validates, if the device supports balancing or not

Stage 2: Validates, if the device is online or offline

Stage 3: Validates, if the device is VAV application supported or not

Stage 4: Validates, if the device is commissioned or not

Stage 5: Validates, if the object rules are correctly configured or not.
Checks configured objects with object names
Checks configured objects name with object Ids
Checks configured objects names with object type
Checks configured object Ids with the object unit
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Flow Balancer Operations

Flow pressure zero calibration

To start zero balancing, click on Start Zero Balancing.

The damper is completely closed. If any flow pressure is detected that value is consid-
ered to be the flow pressure offset. After the completion of zero balancing the device, 
the mode is set to automatic operation.

Two point calibration

You can start either maximum or minimum balancing in any order. The tool does not 
enforce any rules on the order of balancing.

Maximum calibration: To start maximum calibration > click on Start Maximum Bal-
ancing.

The device adjusts the damper to try and attain the maximum flow setpoint. After the 
setpoint is attained, the Measured Flow field is enabled, and the actual measured flow 
value can be entered. The device remains in manual mode (Open Maximum) after max-
imum balancing is complete.
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Minimum calibration: To start minimum calibration > click on Start Minimum Bal-
ancing.

The device adjusts the damper to try and attain the minimum flow setpoint. After the set 
point is attained, the Measured Flow field is enabled, and the actual measured flow 
value can be entered. The device remains in manual mode (Open Minimum) after mini-
mum balancing is complete.

K Factor calibration

To start the K factor calibration method > click on Start K Factor Balancing.

After a warning message, the two-point calibration data is reset to factory defaults. The 
device adjusts the damper to try and attain the maximum flow setpoint. After the setpoint 
is attained the Measured Flow field is enabled and the actual measured flow value can 
be entered.

After the measured flow is entered, the K factor value is calculated by the tool and dis-
played. The tool prompts you to write this value to the device. You can choose to calcu-
late the K factor without using the tool and set the calculated value in the K factor field. 
The device remains in manual mode (Open Maximum) after K factor balancing has been 
completed.

Heating coil water flow calibration

To override the reheat valve position:
• Type the reheat value in percentage and click the Override button next to the Reheat 

Valve Override field.

To override the peripheral heat valve position:
• Type the peripheral heat value in percentage and click the Override button next to 

the Peripheral Heat Valve Override field.

Note: Click the Auto button to set the reheat and peripheral heat valve into automatic operation.
• The controller must be online.
• The controller must be in a commissioned and synchronous state.

Setting the device mode to automatic operation

To set the device into automatic operation > click on Set Mode to Auto when it is 
enabled. While exiting the view if the device is in manual mode, then the tool prompts 
you to change the mode to automatic operation.

Restoring to factory defaults

Click the Restore to Factory Defaults button to restore the factory default value of the 
Zero calibration values, K factor calibration values, Minimum flow calibration values, and 
Maximum flow calibration values.
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Reference Datapoints Usage
General

If the control and monitoring system contains more than one BACnet device (controller), 
the devices communicate with one another via the BACnet MSTP protocol. This enables 
one controller to read values from other controllers and set values on other controllers.

This data communication is realized via reference input and reference output points 
which are assigned to physical or value BACnet points. 

Assignments can be done manually (manual creation and mapping) or automatically 
(automatic creation via drag & drop). 

For manual creation and mapping, the device instance, object instance, and object ID of 
the physical and value BACnet points are entered manually. For automatic creation via 
drag and drop, the device instance, object instance, and object ID of the physical and 
value BACnet points of the physical and value BACnet points are carried over automati-
cally.

Note: The reference input and output function provided by the IRM Engineering Tool is a 
proprietary Honeywell BACnet function.

Figure  6. Data Exchange via Manual Mapping of Reference Input Point to Physical / Value Point

Figure  7. Data Exchange via Manual Mapping of Reference Output Point to Physical / Value Point



170 EN2B-0414GE51 R1021

NIAGARA IRM ENGINEERING TOOL - USER GUIDE

Figure  8. Data Exchange via Dropping of Physical Input Point

Figure  9. Data Exchange via Dropping of Physical Output Point or Value Point

Example

There are two controllers (A and B), in two different rooms on the BACnet MSTP bus. 
Controller A has an outside air temperature sensor connected. The outside air tempera-
ture value sensed by controller A should be provided to controller B. 

There is a third-party BACnet MSTP wall module connected to an IRMNX controller 
which should process values coming from the wall module.

Read or Write Directions

A reference input point (target) is used for reading a value from a physical or value BAC-
net point (source)

A reference output point (source) is used for writing a value to a physical or value point 
(target).
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There are two ways for applying reference points in the application:

• Manual creation and mapping of reference points to BACnet points (A)

• Automatic creation and mapping of reference points via Drag & drop of BACnet 
points (B)

COV and Polling

The controller that contains the reference point subscribes to the mapped physical or 
value point if COV reporting is possible. If COV reporting is not possible, it polls the 
mapped physical or value point.

Manual Reference Point Creation and Mapping

The reference input BACnet point connection is established by manual creation and 
mapping of the reference input point (target) to the physical or value BACnet point 
(source).

The reference output connection is established by manual creation mapping of the refer-
ence output point (source) to the physical or value BACnet point (target).

In both cases, the following device and object information from the BACnet source or 
target points must be entered during the mapping:

• Device Instance (ID)

• Object type (BACnet point type) = object ID

• Object Instance = object ID

Automatic Reference Point Creation and Mapping via Drag & Drop

Reference points can be automatically created and mapped to physical or value BACnet 
points by dragging & dropping the physical or value BACnet points onto the wire sheet. 
In this case, the corresponding device and object information comes with the corre-
sponding BACnet point and must not be entered manually.

Master-Slave Configurations

A typical application scenario for the usage of reference points is a master-slave config-
uration consisting of one master controller connected to multiple slave controllers and/or 
third-party BACnet devices. The master incorporates the main control logic, writes val-
ues to the slave controllers and/or third-party BACnet devices, and receives values from 
the slave controllers and/or 3rd Party BACnet devices. 

Example:

The master controller: 

• Reads the window contact status [EffWindow] from the slave controller via RefIn

• Reads the room temperature [ExtWmRmTemp] from the external BACnet Wall 
Module via RefIn



172 EN2B-0414GE51 R1021

NIAGARA IRM ENGINEERING TOOL - USER GUIDE

• Writes the occupancy status [EffOccMd] to an external BACnet Wall Module via 
RefOut

The slave controller: 

Reads the fan output status [FanStage] of the staged fan (slow, medium, high) from the 
master controller via RefIn.

Figure  10. Master-Slave Configuration using Reference Points
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Manual Creation and Mapping of Reference Points (A)

Example:

Two IRM controllers and a wall module are on the MS/TP bus in the master-slave con-
figuration:

• WEB-RL6N (Master)

• WEB-RS5N (Slave)

• External BACnet wall module

The WEB-RL6N master controller: 

• Reads the window contact status [EffWindow] from the slave controller via RefIn

• Reads the room temperature [ExtWmRmTemp] from the BACnet Wall Module via 
RefIn

• Writes the occupancy status [EffOccMd] to an external BACnet Wall Module via 
RefOut

The WEB-RS5N slave controller:

• Reads the fan output status [FanStage] of the staged fan (slow, medium, high) from 
the master controller via RefIn

Reference Inputs

Based on the example above, the reference input functions of the WEB-RL6N master 
controller are described in the following.

• The WEB-RL6N master controller

• Reads the window contact status [EffWindow] from the slave controller via RefIn

• Reads the room temperature [ExtWmRmTemp] from the BACnet Wall Module via 
RefIn.

Note: The read function of the WEB-RS5N slave controller is described using the automatic 
creation via drag and drop, see Automatic Creation and Mapping of Reference Points via 
Drag & drop (B).

Procedure
Step 1. Note the device IDs of the WEB-RL6N master and WEB-RS5N slave 

controllers. In the below image "5003" and "5001" (displayed in the 
Discovered and Database pane).

Step 2. In the Nav tree, expand the BACnet network and browse to the Points folder 
of the WEB-RS5N slave controller.
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Step 3. Double-click the Points folder and discover the points by clicking Discover on 
the bottom.

Step 4. Sort the discovered points by clicking on the Object Name column.

Step 5. In the point list, scroll to the 'EffWindow' BACnet point.
The Object ID, in this case 'multiStateValue:8'.

Step 6. In the Nav tree, browse to the WEB-RL6N master controller.
Step 7. Expand the IRM Program folder.
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Step 8. Double-click the control program folder, Periodic Program or Event 
Program, to which you want to add the reference input point.

Step 9. In the honIrmControl palette, expand BacnetObjects, and then drag & drop 
the RefIn, BACnet object to the wire sheet.
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Step 10.  In the Name dialog box, change the name to EffWindow, and then click OK.

The reference input is added to the wire sheet.

Step 11.  Double-click the symbol to display the Property Sheet for the reference 
input.
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Step 12. On the Property Sheet, expand Device Instance, Object Type, and Object 
Instance.

Step 13.  Enter the values of the wall module and the EffWindow multistate value point 
as shown in steps 1 and 6.
• Device Instance: device ID = 5001

• Object Type: object ID = multistateValue

• Object Instance: object ID = 8
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Step 14.  Click Save.

Step 15.  The reference input in the WEB-RL6N master controller is mapped to the 
multistate value point EffWindow in the WEB-RS5N controller which provides 
the window contact status.

Step 16.  Apply the procedure in the same way for:
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• Reading the room temperature by mapping a reference input from the 
master controller to the analog value [ExtWmRmTemp] of the external 
BACnet Wall Module.

• Reading the fan stage by mapping a reference input from the WEB-RS5N 
slave controller to the multistate output [FanStage] of the WEB-RL6N 
master controller. 

Alternatively, you can use the "automatic reference point creation and mapping via drag 
and drop" method which is described in the section .Automatic Creation and Mapping of 
Reference Points via Drag & drop (B). This section uses fan stage reading as an exam-
ple.

Step 17. For writing the occupancy status from the master controller to the external 
BACnet wall module, please, see Reference Outputs below.

Step 18.  If desired, you can change the setting for master sync or other settings.

Master-Slave Synchronization

If Master Sync Enabled is true, this property will be synchronized between master and 
slaves in case a master sync operation is performed. The source device setting will be 
synchronized to a target device during a master sync operation. If the source device has 
set the flag to false, then this parameter will not be synchronized to all target devices.

Reference Outputs

Example: 

Two IRM controllers and a wall module are on the MS/TP bus in the master-slave con-
figuration:

• WEB-RL6N (Master)

• WEB-RS5N (Slave)

• External BACnet wall module

In the following procedure, the reference output function of the WEB-RL6N master con-
troller is described. 

• The WEB-RL6N master controller writes the occupancy status [EffOccMd] to an 
external BACnet wall module via RefOut

Procedure

Note: The device ID of the external BACnet wall module, in this case, for example, 5008 
(displayed in the Discovered and Database pane).

Step 1. In the Nav tree, expand the BACnet network and browse to the Points folder 
of the wall module.

Step 2. Double-click the Points folder and discover the points by clicking Discover on 
the bottom.

Step 3. Sort the discovered points by clicking on the Object Name column.
Step 4. In the point list, scroll to the "EffOccMd" BACnet point.
Step 5. Note the Object ID, in this case, for example, 'multiStateValue:13'.
Step 6. In the Nav tree, browse to the WEB-RL6N master controller.
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Step 7. Expand the IRM Program folder.
Step 8. Double-click the control program folder, Periodic Program or Event 

Program, to which you want to add the reference output point.

Step 9.  In the honIrmControl palette, expand BacnetObjects, and then drag & drop 
the RefOut BACnet object to the Wire Sheet.
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Step 10. In the Name dialog box, change the name to "EffOccMd", and then click OK.

 The reference output is added to the Wire Sheet.

Step 11.  Double-click the symbol to display the property sheet for the reference output.

Step 12. On the Property Sheet, expand Device Instance, Object Type, and Object 
Instance.
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Step 13.  Enter the values of the external BACnet wall module and the EffOccMd 
multistate value point as shown in steps 1 and 4.
• Device Instance: device ID = 5008

• Object Type: object ID = multistateValue

• Object Instance: object ID = 13

Step 14.  Click Save.

Step 15.  The reference input in the WEB-RL6N master controller is mapped to the 
multistate value point EffOccMd in the wall module.
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Step 16.  If desired, you can change the setting for master sync or other settings.

Master-Slave Synchronization

If Master Sync Enabled is true, this property will be synchronized between master and 
slaves in case a master sync operation is performed. The source device setting will be 
synchronized to a target device during a master sync operation. If the source device has 
set the flag to false, then this parameter will not be synchronized to all target devices.

Automatic Creation and Mapping of Reference Points via Drag & 
drop (B)

Niagara allows the automatic creation of reference points when BACnet points are 
dragged & dropped onto the Wire Sheet. Thus, you do not have to enter the values for 
device instance, object type, and object instance of the target controller and point manu-
ally, since they come with the BACnet point automatically. 

This automatic creation is always executed whenever a BACnet point is dragged & 
dropped onto the Wire Sheet of another controller or external BACnet device.

The drop result, that is, which type of reference point, input, or output, is to be created, 
can be defined in the control manager as described in the following.

Drop Settings in Control Manager

When using reference points in the application via drag & drop, the dropping result 
depends on the pre-setting for drop in the control manager of the device to which the 
BACnet point is dragged & dropped.



184 EN2B-0414GE51 R1021

NIAGARA IRM ENGINEERING TOOL - USER GUIDE

In the control manager, the result for dropping a BACnet output and a BACnet value 
point can be selected. For both point types, either a reference output or a reference 
input can be selected as a drop result.

Note: Input points cannot be overridden by another controller. Hence when dropping an input 
onto the Wire Sheet, a reference input is always created and a drop setting for inputs in 
the Control Manager is not necessary.

Example: 

Two IRM controllers and a wall module are on the MSTP bus in the master-slave config-
uration:

• WEB-RL6N (Master)

• WEB-RS5N (Slave)

• External BACnet wall module

The WEB-RL6N master controller:
• Reads the window contact status [EffWindow] from the slave controller via RefIn

• Reads the room temperature [ExtWmRmTemp] from the BACnet Wall Module via 
RefIn
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• Writes the occupancy status [EffOccMd] to an external BACnet Wall Module via 
RefOut

The WEB-RS5N slave controller:
• Reads the fan output status [FanStage] of the staged fan (slow, medium, high) 

from the master controller via RefIn

Based on the example above, the reference input function of the WEB-RS5N slave con-
troller is described.

The WEB-RS5N slave controller:

Reads the fan output status [FanStage] of the staged fan (slow, medium, high) from the 
master controller via RefIn. 

Procedure
Step 1. In the Nav tree, expand the BACnet network and browse to the Points folder 

of the WEB-RL6N master controller.
Step 2. Double-click the Points folder and discover the points by clicking Discover on 

the bottom.

Step 3. Sort the discovered points by clicking on the Object Name column.
Step 4. In the point list, scroll to the 'FanStage' BACnet point.
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Step 5. Add the 'FanStage' BACnet point to the database by clicking Add at the 
bottom.

Step 6. Click OK in the Add dialog box. The point will be added to the Database and 
the Points folder.
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Step 7. In the Nav tree, browse to the WEB-RS5N slave controller.
Step 8. Expand the IRM Program folder.
Step 9. In the Control Manager of the WEB-RS5N slave controller, set the drop 

option for BACnet output dropping (mandatory for outputs and value points, 
but not necessary for input points, see the previous subsection). 

Step 10. Based on the example, select 'Create Ref Input' in Drop of Bacnet Output.

Step 11.  Double-click the control program folder, Periodic Program or Event Program, 
to which you want to add the FanStage BACnet point.
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Step 12.  From the Points folder of the WEB-RL6N master controller, drag & drop the 
FanStage BACnet point to the wiresheet of the WEB-RS5N slave controller.

Step 13.  In the Name dialog box, click OK.

A reference input point with the name of the dropped BACnet point, in this case Fan-
Stage, is created. 

Step 14.  Double-click the symbol of the reference input point to display the Property 
Sheet.
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Step 15.  On the Property Sheet, you can see that the reference input is already 
mapped to the dropped BACnet multistate output point indicated by the values 
for device instance, object type, and object instance.

Step 16.  If desired, you can change the setting for master sync or other settings.

Master-Slave Synchronization

If Master Sync Enabled is true, this property will be synchronized between master and 
slaves in case a master sync operation is performed. The source device setting will be 
synchronized to a target device during a master sync operation. If the source device has 
set the flag to false, then this parameter will not be synchronized to all target devices.
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Components of IRM Program

Following feature included IRM Program.

• Ping • Restore Snapshot

• Teaching To Controller • Swapping IRM Program

• Teaching Full Application To Controller • Application Engineering Guidelines

• Learning from Controller • Reset Tool Password

• Checking Hardware Compatibility • Ping Sylk Device

• Check Application Compatibility • Validate Sylk Device

• Clearing Controller • Update All BACnet Object Values From 
Controller To Application

• Clearing Project • Replace Text A Block And Ws Text Blocks With 
Irm Ws Text Block

• Taking Snapshot
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Ping

Procedure

Step 1. Right-click on IRM Program, click Actions > Ping.

This action initiates a Ping (check device status) on the device.

Do a ping and check the status and health of the device.

Teaching To Controller

Teach to Controller downloads the changed application of the project to the controller. 
This can happen in two ways:

• Immediate changes are written to the controller automatically and are effective 
immediately.

• On-demand changes are written to the controller manually and explicitly by the 
“Teach to Controller” action.

Note: When working in teaching mode "immediate", no messages display, and no changes are 
indicated graphically when changing the application. The following procedure can be 
applied at any time when working in teaching mode “On-demand”.

 Procedure
Step 1. Right-click on IRM Program in the tree, then click Actions and then select 

Teach to Controller.
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Step 2. Select Overwrite BACnet objects values in Device or Overwrite BACnet 
object values in Application.

• Overwrite BACnet objects values in Device - This option overwrites 
BACnet object values in the controller and directly teaches application in 
the controller.

• Overwrite BACnet object values in Application – This option first 
performs update all BACnet object values and default values from 
controller to application, then it teaches application in the controller.

Step 3. Click OK.
Result: The changes are written to the controller. The applications are 

synchronized. The successful action is displayed in the workbench job 
service.

Note: Max APDU Length Accepted size and Segmentation Supported under Device Object 
properties are not correctly updating in the controller, resulting in commissioning failures.

Solution: Perform Teaching Full Application To Controller.

Application Download Failure

Due to various reasons, the download of an application can fail. This is shown via mes-
sage in the Jobs Sidebar. In case of a failed application download, parts of the applica-
tion may have already been downloaded to the controller, and such application parts 
could start and operate the IRMNX controller. In this case, damage to the controlled 
equipment may occur.

Important: To avoid damaging the controlled equipment or environment due to partial application 
download failure, it is strongly recommended to clear the controller and perform the 
application download again.

Teach to Multiple Controller 

Procedure

Step 1. Right-click on BacnetNetwork > Views > Irm Bacnet Device Manager 
view.

Step 2. Select all the IRM devices from the device list.
Step 3. Click Teach to Controller. This action opens Teach To Controller dialogue 

box.
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Step 4. Select Overwrite BACnet objects values in Device or Overwrite BACnet 
object values in Application.

• Overwrite BACnet objects values in Device - This option overwrites 
BACnet object values in the controller and directly teaches application in 
the controller.

• Overwrite BACnet object values in Application – This option first 
performs update all BACnet object values and default values from 
controller to application, then it teaches application in the controller.

Step 5. Click OK.
Result: The changes are written to the controller. The applications are 

synchronized. The successful action is displayed in Workbench Job 
Service.
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Teaching Full Application To Controller

Teach Full Application To Controller clears all the previous configurations from the con-
troller and downloads the new configuration of the project to the controller. 

Note: While applying Teach Full Application To Controller, it's is recommended to keep a 
backup of the previous configuration.

Procedure
Step 1. Right-click on IRM Program > Actions > click Teach Full Application to 

Controller in the context menu.

Step 2. Select Overwrite BACnet objects values in Device or Overwrite BACnet 
values in Application.

• Overwrite BACnet objects values in Device - This option overwrites 
BACnet object values in the controller and directly teaches application in 
the controller.

• Overwrite BACnet object values in Application – This option first 
performs update all BACnet object values and default values from 
controller to application, then it teaches application in the controller.

Step 3. Click OK.
Result: The changes are written to the controller. The applications are 

synchronized. The successful action is displayed in Workbench Job 
Service.
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Application Full Teach to Multiple Controller

Procedure

Step 1. Right-click on BacnetNetwork > Views > Irm Bacnet Device Manager 
view.

Step 2. Select all the IRM devices from the device list.
Step 3. Click Application Full Teach to Controller. This action opens Teach To 

Controller dialogue box.

Step 4. Select Overwrite BACnet objects values in Device or Overwrite BACnet 
object values in Application.

• Overwrite BACnet objects values in Device - This option overwrites 
BACnet object values in the controller and directly teaches application in 
the controller.

• Overwrite BACnet object values in Application – This option first 
performs update all BACnet object values and default values from 
controller to application, then it teaches application in the controller.

Step 5. Click OK.
Result: The changes are written to the controller. The applications are 

synchronized. The successful action is displayed in Workbench Job 
Service
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Unconditional Application Teaching to All Controllers

Overwriting of an application can be permitted for the complete network.

Teach Modified Controller:

Deny (Default value) — Don’t allow overwriting of an existing Application in the control-
ler. While trying to teach a different application to a controller an error message is gener-
ated which requires to clear the controller.

Allow — Allows the unconditional overwriting of an existing application.
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Learning from Controller

Learn from Controller uploads the current application from the controller in the project. 
The teaching mode does not care in this case. 

Warning:  When learning from the controller, the application in the project will be deleted.

If the synchronization status is different, a message displays recommending either to 
clear the project (modifications are discarded) or to teach the controller (modifications in 
the controller are discarded).

Procedure
Step 1. Right-click on IRM Program in the tree, then click Actions and then click 

Learn From Controller in the context menu.

Result: The application is to be uploaded into the project. The applications are 
synchronized. The successful action is displayed in the workbench job 
service.
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Learning from Multiple Controller 

Procedure

Step 1. Right-click on BacnetNetwork > Views > Irm Bacnet Device Manager 
view.

Step 2. Select all the IRM devices from the device list.
Step 3. Click Learn from Controller. This action opens Learn from the controller 

dialogue box.

Step 4. Click Yes.

Result: The application is uploaded into the project. The applications are 
synchronized. The successful action is displayed in Workbench Job 
Service.
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Checking Hardware Compatibility

The hardware configurations of the used physical controller and the hardware-defined 
for the controller in the application can be checked. Any differences are indicated graph-
ically via the yellow warning symbol on the terminals in the wire sheet. In addition, a 
message displays that lists the affected terminals.

Procedure
Step 1. Right-click on IRMProgram in the tree, then click Actions and then click 

Check Hw Compatibility.

Result: In case of incompatibilities, a message box displays that lists the affected 
terminals.

On the Wire Sheet, the terminals are marked as 'dirty' by a yellow warning symbol.

Step 2. Confirm the message box by clicking OK, and then remove the dirty terminals.
Step 3. Teach the controller.
Result: The successful action is displayed in workbench job service..
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Check Application Compatibility

To check the status of the Application Software, see the 'Property Sheet view' of the Irm-
BacnetDevice.

Procedure

Step 1. Right-click on IRMProgram in the tree, then click Actions and then click 
Check Application Compatibility.

Result: In case of application has any incompatibilities,  failed notification is 
displayed.

Check the job log in to the Workbench Job Service to get details of failed items.

Application Software Status:
• Controller is Empty — Result of the Flush Controller command. Download 

Application software via Teach command

• Incomplete Application due to failed teach —Application software was not 
downloaded correctly and is not running

Application teach is succeed and running — Application software was downloaded 
correctly and is running
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Clearing Controller

Clear Controller deletes the application from the controller.

Note: During Clearing controller (Proxy file to the controller), 20VDC output will be turned off for 
30 seconds and all IO terminals will be down for 30 seconds. This will only happen when 
Niagara is changing the Sylk application in the controller or deleting the application from 
the controller. This will not happen once the application teach is completed and the 
controller is running.

Procedure
Step 1. Right-click on IRMProgram in the tree, then click Actions and then click 

Clear Controller in the context menu.

Result: The application deletes in the controller.
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Clearing Multiple Controller from database

Procedure

Step 1. Right-click on BacnetNetwork > Views > Irm Bacnet Device Manager 
view.

Step 2. Select all the IRM devices from the device list.
Step 3. Click Clear Controller. This action opens the Clear Controller dialogue box.

Step 4. Click Yes.
Result: The application is deleted from all the selected controllers. The successful 

action is displayed in Workbench Job Service.



EN2B-0414GE51 R1021 203

NIAGARA IRM ENGINEERING TOOL - USER GUIDE

Clearing Project

Clear Project deletes the application from the project.

Procedure
Step 1. Right-click on IRMProgram in the tree, then click Actions and then click 

Clear Project in the context menu.

Result: The application deletes in the project. 

Clearing Engineering Project from Multiple Controller

Procedure

Step 1. Right-click on BacnetNetwork > Views > Irm Bacnet Device Manager 
view.

Step 2. Select all the IRM devices from the device list.
Step 3. Click Clear Project. This action opens the Clear Controller dialogue box.
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Step 4. Click Yes.

Result: The application is deleted from all the selected the controller. The 
successful action is displayed in Workbench Job Service.
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Taking Snapshot

The current status of an application can be backed up and restored later. This allows 
restoring a changed application if these changes should be discarded.

Procedure
Step 1. Right-click on IRMProgram in the tree, then click Actions and then click Take 

Snapshot in the context menu.

Result: The application is backed up and the successful action is displayed in 
Workchbench Job Service.
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Restore Snapshot

The current status of an application can be backed up and restored later. This allows 
restoring a changed application if these changes should be discarded.

Procedure
Step 1. Right-click on IRMProgram in the tree, then click Actions and then click 

Restore Snapshot in the context menu.

Result: The application is restored in the project and the successful restore is 
displayed in Workbench Job Service.
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Swapping IRM Program

Purpose

Swapping saves RAM space and reduces processor load and bus traffic. The current 
state of a swapped device is frozen and saved to an IRM repository on the disk. The 
swapped device is indicated by a proxy that inherits and shows the minimum information 
of the device necessary for swapping-in the device. Synchronization is not for swapped-
out devices. To synchronize swapped-out devices, the devices must be swapped-in 
again. You can swap single devices one after another or multiple devices in one step.

Important: It is strongly recommended to swap-out the application in any case after finishing the 
engineering in online or offline mode.

Swapping Single IRM Device

Procedure (Single Device)
Step 1. Expand the device.
Step 2. Right-click on the IRM Program folder in the tree, then click Actions and then 

click Swap in the context menu.
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Result: The device is swapped-out. On the Property Sheet, the proxy is displayed. In 
the tree, the IRM program is shown without any subfolders.

The successful swap-out is displayed in the Workbench Job Service.

Step 3. To swap-in the device, right-click on the IRMProgram folder in the tree, then 
click Actions and then click Swap in the context menu.

Result: The device is swapped in. In the tree, the IRM program is restored showing 
all subfolders. The successful swap-in is displayed in Workbench Job 
Service.
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Swapping Multiple IRM Device

Procedure (Multiple Devices)

To swap-out the multiple devices:

Step 1. Expand the BACnet network.

Step 2. Right-click on the IrmConfig folder > Action > click Swap Out in the context 
menu.

Or 

Step 1. Right-click on BacnetNetwork > Views > Irm Bacnet Device Manager 
view.

Step 2. Select all the IRM devices from the device list.
Step 3. Click Swap Out.This action displays Swap Out dialogue box. 

Step 4. Click Yes.

Result: The successful swap-out is displayed in the Workbench Job Service..
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To swap-in the multiple devices 

Step 1. Right-click on the IrmConfig folder > Actions > click Swap In in the context 
menu.

Or

Step 1. Right-click on BacnetNetwork > Views > Irm Bacnet Device Manager 
view.

Step 2. Select all the Swap Out devices from the device list.
Step 3. Click Swap In.This action displays Swap In dialogue box. 

Step 4. Click Yes.

Result: The devices are swapped in. The successful swap-in is displayed in 
Workbench Job Service.
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Set Controller Password

Starting from Controller version 1.0.1.9 and Niagara IRM Engineering Tool version 
1.0.1.7, Secure Commissioning Communication is implemented for IRMNX controller-
IRMNX controller commissioning.

In the initial state (factory setting), IRM and Niagara IRM Engineering Tool version 
1.0.1.7 use a non-visible default password. This default password is not exposed to the 
outside world.

If a user-defined password has been entered, this password is sent to the IRMNX con-
troller and from then the controller cannot be accessed without this password.

Resetting a controller password can only be done by conducting a Reset to the factory. 
Refer to "Reset to Factory Delivery".

Important: Resetting the controller password means conducting a manual factory reset for every 
single controller.

To understand each other, the IRM Engineering Tool and the IRM Controllers must use 
the same password. When changing a project or when discovering IRM controllers, it 
may be necessary to re-enter the passwords on one or both sides. Password setting can 
be conducted via the Set Password for function in the IRM 5 Engineering Tool. It is 
possible to apply the password only for the tool or for the tool and the controller.

Setting a Password for a Single Controller

The user-defined password setting for the single controller is done in IRM Program via 
the Action menu. Navigate to the entry Set Controller Password. 
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Password change is done via the same procedure with additional old password input.

Setting a Password for All Controllers

Bulk user-defined password setting for all controllers in the BACnet is done via right-
click at IRMConfig select Actions menu entry Set Controller Password. 

The user-defined password in the IRM Engineering Tool will also be set.

To ensure that the password in the IRMNX controller and the IRM Engineering Tool is 
the same, Set Password for can be used to select where the password should be 
changed.

Change passwords is done via the same procedure with additional old password input.

Note: Old password should be empty if the password is set for the first time.



EN2B-0414GE51 R1021 213

NIAGARA IRM ENGINEERING TOOL - USER GUIDE

Reset Tool Password

Users can reset the password for a single controller in IRM Program via the Action 
menu.

Steps to reset controller Password

Step 1. Navigate to the Station > BacnetNetwork > IrmBacnetDevice > select IRM 
Program

Step 2. Right-click on IRM Program navigate to Actions > Reset Tool Password.

Step 3. Enter the Old Password and click OK.

Note: IRMNX controller (Hardware)

Resetting a controller password can only be done by conducting a Reset to the factory. 
Refer to "Reset to Factory Delivery",
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Resetting Password for All Controllers

Step 1. Navigate to BacNetwork and right-click on IRMConfig > Actions > Reset 
Tool Password.

Note: IRMNX controller (Hardware)

Resetting a controller password can only be done by conducting a Reset to the factory. 
Refer to "Reset to Factory Delivery",
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Use Cases

The table below shows different use cases for setting the password to the controller.

Use Case
IRMNX 
controller
≥ 1.0.1.9

IRM Engineering 
Tool
≥ 1.0.1.7

How it works/Solution

First time user 
commissioning 
the controller 

New Controller 
connected to 
BACnet 
network 
The first time, 
the device is 
discovered and 
added to the 
IRM device 
manager view 

The first time, the 
device is discovered 
and added to the IRM 
device manager view 
The default password 
is used 

The default password is used for Teach/
Learn/Ping/Clear controller. 
Usage of user-defined password. 
Recommendation: Use the default 
password for commissioning and enter 
the user-defined password after 
commissioning. Keep the user-defined 
password in a safe place for future 
commissioning. 
NOTE: There is no way to read/learn the 
application logic from the controller 
without a user-defined password. 
User-defined password setting via Set 
Controller Password in Actions menu of 
IRM Program. 
Reset user-defined password to default 
password via Set Controller Password in 
Actions menu of IRM Program. Enter 
additionally the old user-defined 
password. 

Set common 
User Defined 
Password for 
all controller 

New Controllers 
connected in 
BACnet 
network. 
Default 
Password is set 
from the factory 

The first time, devices 
are discovered and 
added to the IRM 
device manager view 
The default password 
is automatically 
assigned in 
Engineering Tool and 
all controllers.

The default password is used for Teach/
Learn/Ping/Clear controller. 
Solution: The user can set the user-
defined password in Engineering Tool 
and all controllers.
Users should use the Set Controller 
Password Actions menu of IrmConfig in 
Bacnet Network. 
The first time a user-defined password is 
set Old Password field stays empty.

Change 
common User 
Defined 
Password for 
all controllers 

Existing 
controllers. 
User-defined 
password is 
already set by 
the user during 
commissioning 

Engineering Tool has 
the same user-defined 
password as all 
controllers. 
Users want to change 
the user-defined 
password in all 
controllers. 

The existing user-defined password is 
used for Teach/Learn/Ping/Clear 
controller. 
Solution: User can change user-defined 
passwords in all controllers. 
Use Set Controller Password in Actions 
menu at IrmConfig in Bacnet Network. 
The old and new passwords must be 
entered. 
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Modify 
application in 
the existing 
controller by 
another user 

Existing 
controllers. 
A user-defined 
password is set 
during 
commissioning. 
All controllers 
have the user-
defined 
password 

User2 discovered the 
devices and add those 
devices into the Irm 
device manager 

The user-defined password is set by User 
1. 
User 2 uses the different user-defined 
passwords and gets the below error 
message: 
There is an error in controller 
communication. It could be a password 
mismatch in the controller and station. 
User2 can’t Teach/Learn/Ping/Clear the 
controller until the user-defined password 
from user1 is set in the Engineering Tool. 
Having entered User1 user-defined 
password all engineering operations can 
be conducted. 
IMPORTANT: If the user-defined 
password is not communicated no 
engineering operations are possible. If it 
is lost, the controller must have a factory 
reset and has to be commission again. 

Modify 
application in 
existing 
controller with 
the same 
station 

Existing 
controllers. 
User-defined 
password is 
already set 

Existing station. 
The user-defined 
password is already 
set. 

All engineering operations can be 
conducted 

Modify 
application in 
existing 
controller with 
other station 

Existing 
controllers. 
User-defined 
password is 
already set 

Another station. 
The user-defined 
password is already 
set. User-defined 
password doesn’t 
match with user-
defined password set 
in the controller. 

The user gets an error in the job log and 
dialog during Teach/Ping/Learn 
There is an error in controller 
communication. It could be a password 
mismatch in the controller and station. 
Solution: Reset user-defined password in 
Engineering Tool. Set user-defined 
password used in the controller also in 
the Engineering Tool. 

Modify 
application 
with the new 
station 

Existing 
controllers 
User-defined 
password is 
already set 

New station 
Devices are 
discovered and added 
into station DB. 
Default user password 
is set in the 
Engineering Tool.

The user gets an error in the job log and 
dialog during Teach/Ping/Learn 
There is an error in controller 
communication. It could be a password 
mismatch in the controller and station. 
Solution: Reset user-defined password in 
Engineering Tool. Default user 
passwords will be used in the 
Engineering Tool. 

Use Case
IRMNX 
controller
≥ 1.0.1.9

IRM Engineering 
Tool
≥ 1.0.1.7

How it works/Solution
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Replace the 
damaged 
controller with 
the new 
controller from 
the factory. 

New controller 
Default user 
password is set 
from the factory 

Users use the same 
station to configure the 
controller again. 
In Station, the user-
defined password is 
set. 

User cannot do Teach/Learn/Ping/Clear 
controller 
Solution 1: Reset the user-defined 
password in the Engineering Tool. 
Default user passwords will be used in 
the Engineering Tool. Then do the match 
between the controller in the Engineering 
Tool and the new controller added in the 
network. Set user-defined password 
again. 
Solution 2: Backup of the application 
logic with the Engineering Tool. Next, 
delete the controller from the database is 
within the Engineering Tool. Add the new 
discovered device into the station DB and 
then restore the backup. 
Note: After replacing a damaged 
controller with the new controller, you can 
either commission the application which 
is already present in the station or you 
can replace the database device with 
backed-up device data.
If you are restoring the application using 
the device already present in the station, 
please ensure to put the device in the 
database into "Swapped In" mode. After 
swapping in logic backed up in the IRM 
repository will be made available in the 
station database and the user can 
commission the newly replaced device.
To learn more about device swapping 
see Swapping IRM Program

User want to 
reset controller 
to factory-
default 

Existing 
controllers. 
User-Defined 
Password is set 

Existing station. 
A user-defined 
password is set. 

Conduct a factory reset at the controller 
Reset the user-defined password in the 
engineering Tool. Discover and match 
with the controller in the Engineering Tool 
Set user-defined password and do the 
commissioning. 

Use Case
IRMNX 
controller
≥ 1.0.1.9

IRM Engineering 
Tool
≥ 1.0.1.7

How it works/Solution
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Password Status

The Password Status column has been added in the IRM BACnet Device manager to 
help the user easily check the status and identify the problem in setting a password for 
the IRMNX controller.

Below the highlighted text, the following will be shown in the Password Status column:

• Not supported - If the IRMNX controller firmware version is below 1.0.2.2.

• Default password - If no password has been set in the IRMNX controller.

• User password - The user can set or change the password in the IRMNX controller.

• Password mismatch - If the password set for the tool does not match the password 
set in the IRMNX controller.

Copy device 
for the new 
controller in 
the network 

New Controller 
added to the 
network. 
Default user 
password is set 
from the factory 

Copy from the 
controller in the station 
having a user-defined 
password set. 
User matching the 
cloned device with a 
new controller added 
to the network. 

The copy will copy the password from the 
existing device. 
Solution: Reset user-defined password in 
Engineering Tool. Default user password 
will be used. Set the user-defined 
password used in the old controller. 

Clone 
Application 
from one 
controller to 
another 
controller

Clone application logic 
from one controller to 
multiple controllers or 
single controller in IRM 
Device Manager view

Clone operation in IRM Device manager 
view will not change the password in 
target controllers. Also, it won’t copy the 
password from the source controller to 
the target controller 

Use Case
IRMNX 
controller
≥ 1.0.1.9

IRM Engineering 
Tool
≥ 1.0.1.7

How it works/Solution
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Ping Sylk Device

Users can perform Sylk device ping from IRM Program. Sylk ping verifies and displays 
status based on the device connected to the network at the configured address.

Note: The duration of the Sylk Device ping is two minutes.

To run Sylk Ping
Step 1. Navigate to the Station > BacnetNetwork > IrmBacnetDevice > select IRM 

Program.
Step 2. Right-click on IRM Program navigate to Actions > Ping Sylk Devices

Figure  11. Sylk Device Ping

• If no device connected at configured address Status displays Down, in this case, 
Fault Cause shows No device found and Sylk Device stops read-write operation. 

All Sylk parameters associated with the Sylk device will also be updated with the same 
status and fault cause

• If the user has configured TR75 and connected TR42 at the configured address then 
Status displays Down, in this case Fault Cause shows Incompatible device found 
and Sylk Device stops read-write operation. 
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• If the device configured is matching with the device connected to the network, then 
Status displays (ok), and Sylk Device resumes read-write operation.

If the user performs Sylk device pin on multiple configured Sylk devices, the user needs 
to enter into each Sylk device property sheet and verifies the Sylk device Fault Cause.
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Update All BACnet Object Values From Controller To Application

Update All BACnet Object Values From Controller To Application option allows to 
synchronize the controller values with the IRM application values. Besides that, when 
you run a Full teach to the controller, this feature makes sure that the values in the con-
troller are not over-written by Wire Sheet values when the two values are not in sync (i.e. 
it will retain the object values from the controller).

Steps to run Update all BACnet object Values From Controller to Application

Step 1. Navigate to the Station > BacnetNetwork > IrmBacnetDevice > select IRM 
Program

Step 2. Right-click on IRM Program navigate to Actions > Update All BACnet 
Object Values From Controller To Application.

This action open the Update All BACnet Objects dialogue box.
Step 3. Click Yes. This will update the default values for all the connected BACnet 

objects.
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Updating BACnet object Values for multiple controllers 

Step 1. Right-click on BacnetNetwork > Views > Irm Bacnet Device Manager 
view.

Step 2. Select all the IRM devices from the device list.
Step 3. Click Update All BACnet Objects.This action displays Update All BACnet 

Objects dialogue box

This action open the Update All BACnet Objects dialogue box.
Step 4. Click Yes. This will update the default values for all the connected BACnet 

objects.

Note: Update All BACnet Object Values From Controller To Application only works if the 
controller and the application are in Sync mode.
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Replace Text A Block And Ws Text Blocks With Irm Ws Text Block

Replace Text A Block And Ws Text Blocks With Irm Ws Text Block option allows you to 
convert any TextA Function Block to the  IRMWsTextBlock Function Block ,which is sup-
port with better graphics for comments to be added in application.

IRM tools support Niagara's WsTextBlock under name IRMWsTextBlock. Refer to Niag-
ara document "local:|module://docDeveloper/doc/baja-rt/javax/baja/util/BWsText-
Block.bajadoc" for more details.

Input Name Description
Text Enter the text on the label
Foreground Specifies foreground fill. Null indicates no foreground fill.
Background Specifies background fill. Null indicates no foreground fill.
Font Configures the additional parameters for the font on the label.
Border Displays the border design.
Selectable If true allows to select the textbox on wiresheet. If false disallows to 

select the text box on wiresheet.
Master Sync 
Enabled

If true allows all the properties to sync from master to target. If false 
disallows all the properties to sync from master to target.
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Master Sync
The "Master Sync" function is based on a group of multiple devices that must have the 
same application type. This is called a master sync group. The master sync group is 
established via the "Clone Application" function which clones the application of one 
selected device (template) to multiple devices.

Among all devices, one device is defined as the source and the other devices are 
defined as targets. Then the master sync command allows rolling out the current appli-
cation (changes) of the source device to all target devices per one step. 

The master sync function works in online and offline mode on the project level, but not in 
the devices. Hence, the applications in the project do not have to be synchronous with 
the applications in the devices when working in teaching mode "on-demand".

Figure  12. Master Sync Group including Source and Target Devices

Note: Cloning of the application and the source-target definition for the devices can be done 
independently. That is, the source-target definition of the devices can be done before or 
after cloning of the device application and vice versa.
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Cloning Application

Clones the device application based on a selectable template (device) to selectable 
devices. As result, all devices will receive the same application type which is the basis of 
a master sync group.

Note: Even if all devices will have the same application type after cloning, the master sync 
group is not finally established. This is done before or after the cloning via the > Master 
Sync function (see Applying Master Sync) .

Example:

The following schematic shows a master sync group consisting of 4 devices with the 
same application A which has the program name A and application type A. The applica-
tion is cloned using device 1 as a template and devices 2 through 4 are selected for 
receiving this application. They are forming a master group defined by application Type-
A.

Figure  13. Cloning Application

Procedure
Step 1. In the Database pane, select all devices which should be included in the 

clone. In the next step, the application of one selected device will be used as 
a template. All others will receive the application type of the selected template 
device. 

Result: The following message box displays.
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Step 2. Confirm the message by clicking Yes.
Result: The Select Template dialog box displays.

Step 3. Select the template (device) from the drop-down list box.
Step 4. Confirm the message by clicking OK.
Result: RESULT: The selected template will be used for all devices selected in the 

Database pane. The Irm Application Type column in the Database pane 
indicates that all devices have now the same application type. The master 
sync group is formed

Note: Cloning of the device application can be done before or after the source-target definition 
of the devices and vice versa.
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Applying Master Sync

Allows rolling out the current application (changes) of the source device to all target 
devices per one step. The differences in all target device applications are synchronized 
with the application of the source device.

Note: The source-target definition of the devices can be done before or after cloning of the 
device application and vice versa.

At least one device must include an application to establish a master sync group via 
cloning. If not already done, clone the application as described in the section Cloning 
Application

The master sync function can be applied in online and offline modes.

Example:

The following procedure shows an offline engineering example with 4 IRM devices cre-
ated manually using the standard Niagara New command. The application has been 
cloned. 

Procedure
Step 1. Invoke the Database pane to display the offline devices. In the Irm Application 

Type column, the same application type is shown for all devices forming the 
master sync group.

Step 2. Select the device you want to define as the source, and then click Set as 
Source.

Step 3. Select the devices you want to define as the targets, and then click Set as 
Target.
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Step 4. Select the source device, and then click >Master Sync.

Result: The Synchronize differences dialog box displays

Step 5. Confirm the message by clicking Yes.
Result: The differences in all target device applications are synchronized with the 

application of the source device.
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Excluding Function Block Items from Master Sync

As desired, values of function blocks can be excluded from the Master Sync function. 
Then, when performing the master sync command, the excluded values of the function 
block will be kept and not affected by the updated application. This applies to periodic 
and event programs.

Excluding function block, values from master sync updates can be applied in the master 
device and the target devices. 

When excluding a function block value in the master device, this value will be kept in all 
target devices.

When excluding a function block value in a target device, only this target device will be 
excluded from the value update.

Figure  14. Master Sync Enabled” Configuration and Function Block Value Updates

Procedure
Step 1. Double-click the item in the Periodic program or Event program to display the 

Property Sheet.
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Step 2. Expand the values area by clicking . The Master Sync Enabled option is 
set to 'true' by default.

Step 3. To exclude a function block value from master sync updates, set the option to 
'false'.

Step 4. Click Save.
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BACnet Object limits in the Application

Unsupported Linking Within IrmBacnetDevice Can Cause Unintended Results

The function blocks found in the honIrmControl palette provide considerable flexibility for 
creating control applications to meet your requirements. However, you must consider 
the fact that the manner in which the function blocks are used on the Wire Sheet does 
not exactly match the way that they are represented within the controller’s firmware. 

Note: The differences between Niagara and Firmware allow opportunities for users to “force” 
configurations on the wire sheet that may cause unintended or undesirable results. A 
good “rule of thumb” to follow is that when you add a honIrmControl function block to the 
wiresheet, any slots visible by default are suitable for linking. But if you need to invoke 
“Composite” on a function block or drill down into its child components to find a property 
then most likely that property was not intended to be involved in a link.

When this rule is ignored, properties that are a target in the link may not receive the 
intended value when a master sync operation is performed. In other situations, values 
modified during runtime may not reach the controller logic.

Example: The unsupported link scenario would be the case where the user wants to 
modify a Sylk NetworkSetpoint block’s lowLimit and highLimit parameters from the net-
work. These parameters do not appear on the function block by default. However, they 
can be forced to appear as composite slots as illustrated in Figure 13. After compositing, 
external data can be linked to them as in Figure 14.

The configuration in Figures 13 and 14 is not valid. When you change the limits via the 
BACnet objects during runtime they will not propagate to the controller. And if you 
attempt to modify the limits in the RoomSpt property sheet using Maser Sync the target 
devices will not receive the property values.

Figure  15. TR42 limit slots used as Composite 
slots

Figure  16. Linking to Composite slots
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In most situations, alternative logic can be constructed to meet the intended sequence 
without the use of unsupported links. Figure 15 provides an example of enforcing set-
point links without the use of composites on the Room_Spt block.

Figure  17. Limits enforced in downstream logic.

The IrmFolder and IrmSubFolder components do provide limited support for the Com-
posite feature. When using them to expose a function block slot, a good “rule of thumb” 
to follow is to only composite slots accessible at the top level of a function block. Do not 
drill down into the child objects beneath a function block. 

Example: In and Out slots of Room_Spt appearing in Figure 16 and are valid for use in a 
Composite. However, the lowLimit and highLimit parameters appearing in Figure 17 are 
not valid

Figure  18. Valid composite slots for 
IrmFolder and IrmSubFolder

Figure  19. Invalid composite slots for 
IrmFolder and IrmSubFolder
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Splitting-Off Application

Splits the unique application of the master sync group into a new application and keeps 
the existing application. For the new application, you can enter a different IRM program 
name. A new IRM application type is issued automatically by the software. The new 
application can then be cloned to form the new master sync group.

This function can be applied to extend an existing application with new features for 
usage in a similar environment, for example, the application of a small-sized office will 
be used as the basis for creating an application for a mid-sized office.

Figure  20. Splitting-Off and Cloning Application
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Procedure
Step 1. In the Database pane, select the device you want to split off, and then click 

Split-Off Application.

Result: The following message box displays.

Step 2. Confirm the message by clicking Yes.
Result: The following dialog box displays.

Step 3. Enter a new name for the IRM program.

Step 4. Confirm by clicking OK.
Result:  In the Database pane, in the IRM Program Name column the defined 

program name is displayed and in the IRM Application Type column the 
new application type is displayed. With the device based on this split-off 
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application type, you can now form a new master sync group by cloning 
the application and defining the source and targets.

Note: Cloning of the device application can be done before or after the source-target definition 
of the devices and vice versa.
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Controller MAC Address Assignment

Automatic MAC Address Assignment

The factory setting of the MAC address of an IRMNX controller is 0xFF by default. On 
the first power-up, a controller will automatically assign itself a unique MAC address 
within the range of assignable MAC addresses. The range of assignable MAC 
addresses is defined by the Min MAC and Max MAC settings within the controller. For 
new factory controllers, the default value for Min MAC is 1 and for Max MAC it is 127 

Once the controller has found a valid MAC address, it is saved in the controller perma-
nently. From now on and on every power-up or system reset, this MAC address is used 
for MSTP communication. 

The permanent MAC address changes automatically if any of the following conditions 
happen:

• The Auto MAC process is re-triggered by Niagara via the “You are” command using 
the MAC address 255 (0xFF).

• There is a conflict caused by devices in the network with the same MAC address.

If the service pin is pressed and then the controller is switched on (while the service pin 
is still pressed), a reset to factory delivery is performed.

Manually Changing MAC Addresses

In some scenarios, you might intend to change the MAC addresses:

Example:

If a small number of controllers are connected to a network, the Auto MAC function exe-
cuted in the controller may result in huge gaps of the assigned MAC addresses, for 
example. 2, 7, 16, 23, and 31. Such an MSTP network is not optimized in terms of band-
width usage. 

To optimize the network, you can manually change the MAC addresses of the control-
lers in Niagara, see MAC Address Configuration. Make sure that unique MAC 
addresses are assigned.

Important: Once you have changed all desired MAC addresses for the controllers, it is 
recommended to change the Max Master setting of the controllers to the highest MAC 
address (=Max MAC) among all controllers. This results in optimum bus performance.

Note: If the Max Master setting is not set to the Maximum MAC value, it will not impact the 
MSTP functionality, but only the MSTP performance.

Swapping MAC Addresses

If you want to assign to a controller (A) a MAC address that is already assigned to 
another controller (B), the following steps must be applied:
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Procedure
Step 1. Re-assign a free MAC address in the range of 1-127 to the controller B which 

blocks the needed MAC address.
Step 2. Now, assign the freed MAC address of controller B (step 1) to controller A.
Step 3. Assign the next needed MAC address to controller B (optional, for example, 

in case of MAC address requirements).
Step 4. The above steps can be continuously applied for assigning desired MAC 

addresses to further controllers. 
Step 5. Change the Max Master setting to the highest MAC address (=Max MAC) 

among all controllers (see Important Note above).

MAC Address Configuration

At any point, the automatically or manually assigned MAC address of an IRMNX control-
ler and the maxMaster setting can be changed in Niagara N4.

Procedure
Step 1. Open the Property Sheet of the IRMNX controller.

Step 2. In Address, change the MAC Address as desired. 

Note: The assigned MAC addresses for the individual WEB-RxxN controllers in the BACnet 
MS/TP channel are not assigned in sequential order. Rather, they assign the MAC 
Addresses in the range of min MAC to max MAC (these are exposed as the proprietary 
properties id 1028 (min MAC) and 1029 (maxMAC) under device object). Currently not in 
use by another device in the BACnet MS/TP channel (the MAC Address of “0” is reserved 
by default for the router/plant controller, itself).

Step 3. Click Save.
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If the changed address is the highest address on the MS/TP network, change 
the maxMaster setting as follows:

Step 4. Expand the Config or Device Object area.

Step 5. In maxMaster, enter the highest MAC address of all controllers of the 
network.

Step 6. Click Save.
Step 7. Enter the same number of 'maxMaster' in all controllers of the network.

Note: If the maxMaster Setting is not working in the controller. The user needs to clear off the 
alarm and make the device okay then try to set max master configuration. To configure 
the Max Master setting. See Changing Max Master of Devices. 

Auto MAC Configuration

Auto MAC feature allows the controller to assign MAC address automatically when they 
are added to the network. Factory out controllers has the Auto MAC feature enabled by 
default.

Important: Auto MAC feature is only supported for MSTP Controller & not applicable for IP 
Controllers.
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Factory out controllers has a default Device ID of 4194302. These controllers will trigger 
the Auto MAC functionality, on every power cycle and might acquire a new mac. To 
avoid network connectivity issues due to conflict in MAC address on an existing bus 
enabling and disabling Auto MAC option added. Disabling the Auto MAC option allows 
you to perform the following activity:

• The MAC address of the controller will be locked and can only be changed via manual 
MAC entry once Auto MAC is disabled.

• The user has the responsibility to ensure he does not create an address conflict.

Note: If the controller reset back to factory default settings, the Auto MAC feature is enabled for 
that controller. 

Note: MAC Address Configuration applicable for the live controllers for the existing stations.

Note: If the Auto MAC feature is disabled, make sure to add a unique MAC address to that 
controller.

Update MAC Address Configuration from Station

You can enable or disable the Auto MAC feature for all the controllers in the station with 
the Update MAC Address Configuration option.

Step 1. Navigate to the BacnetNetwork > IrmConfig>Actions> Update MAC 
Address Configuration.

This opens the confirmation message box.

Step 2. Click Yes. This opens Update MAC Address Configuration option.
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Step 3. Enter the Max Master and enable or disable Auto MAC option.

Note: If the Auto MAC feature is disabled, make sure to add a unique MAC address to that 
controller.

Step 4. Click OK.

Auto MAC Configuration on multiple Controllers 

You can enable or disable the Auto MAC feature for single or multiple controllers from 
the IrmBacnet Device Manager view.

Step 1. Navigate to the Irm Bacnet Device Manager view and click on MAC Config.

This opens the confirmation message box.

Step 2. Click Yes. This opens Update MAC Address Configuration window.
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Step 3. Enter the Max Master value and enable or disable Auto MAC option.

Note: If the Auto MAC feature is disabled, make sure to add a unique MAC address to that 
controller.

Step 4. Click OK.
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Synchronizing Device Time
Synchronizes the time of the devices with the time either from the work bench PC that is 
used for device engineering or from the supervisor. This depends on where the function 
is performed.

Procedure
Step 1. In the Database pane, select TSynch.

Step 2. Confirm the message by clicking Yes.

Result: The time of the devices is set to the time of the supervisor.
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SYLK DEVICE PROGRAMMING

Sylk Device Programming Includes:

The IRMNX controller family supports Sylk Devices. Using Sylk-enabled sensors saves 
I/O on the controller and is faster and cheaper to install since only two wires are needed 
and the bus is polarity insensitive.

IRM controllers support Sylk Bus. Sylk is a two-wire, polarity insensitive bus that pro-
vides both 18 VDC power and communications between a Sylk-enabled sensor and a 
Sylk-enabled controller. Using Sylk-enabled sensors saves I/O on the controller and is 
faster and cheaper to install since only two wires are needed and the bus is polarity 
insensitive. Sylk sensors are configured using the latest build version of the IRM engi-
neering tool for Niagara N4. The IRM Tool palette comes with inbuilt SylkDevices and 
SylkParams. honIrmControl palette device contains the following Sylk modules: 

Figure  21. Sylk Device and Sylk Parameters

Sylk Devices Sylk Parameter Summary
Sylk Parameters Sylk Parameter Example
Sylk Wall Module Usage Deleting Sylk Device
Steps to configure and Install Sylk 
application in Sylk devices

EnumSchedule Configuration

SylkDevices SylkParams
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Sylk Devices
The Sylk devices are part of the IRM family. These devices are designed to seamlessly 
integrate with IRM controllers using only Sylk™ for communication. These devices 
increase the controller's ability to expand the operation, which is configured with applica-
tions that require a large amount of physical I/O. The Sylk devices are programmable 
using existing IRM engineering tool wire sheets through the Niagara Framework® soft-
ware.

The Sylk devices are intended for use in HVAC applications that require a programma-
ble controller. All devices provide flexible, universal inputs for external sensors.

Note: During clearing the controller as well as while loading the SYLK configuration to the 
controller (Proxy file to the controller), 20 VDC output will be turned off for 30 seconds 
and all I/O terminals will be down for 30 seconds. This will only happen when Niagara is 
changing the SYLK application in the controller or deleting the application from the 
controller. This will not happen once the application teach is completed and the controller 
is running.

Following are the supported Sylk device:

Sensors: C7400S Sylk™ Sensor

Sylk Actuator: MS3103, MS3105, MS4103, MS4105, MS7403, MS7405, MS7503, 
MS7505, MS8103, MS8105 Spring Return Direct Coupled Actuators (DCA) are used 
within heating, ventilating, and air-conditioning (HVAC) systems.

They can drive a variety of quarter-turn; final control elements requiring spring return 
fail-safe operation.

Module-TR7X

TR75H TR75
TR71H TR71
Module-TR4X

TR42 TR42H
TR42CO2 TR42HCO2
TR40 TR40H
TR40CO2 TR40HCO2
Module-TR120X

TR120 TR120H
Module - C7400S (Zeleny)
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Sylk Parameters

To get more details about Sylk parameters, refer to NIAGARA IRM FUNCTION 
BLOCKS User Guide: EN2B-0415GE51

A brief view of the various Sylk parameters supported by Sylk device in IRM program-
ming tool. 

Table 3 :  General Sylk Parameters

Parameter Description

BypassTime To provide the bypass time to a wall module
CO2 CO2 concentration in the space
ControllerValue Value from the controller to the wall module
FanCommand To provide commands to the fan from the wall module
HUMIDITY Percent humidity of the Space
HomeScreen To configure the LED display of the wall module
NetworkSetpoint To provide the setpoints to the wall module
OccupancyOverrideCommand To override the Unoccupancy Mode to Occupied Mode
OccupancyStatus Occupancy status in the wall module
ROOMTEMP Temperature of the space
SensorOffset To provide the sensor offset to wall module
SylkTime To configure and change the value of Sylk module and platform time as well
SystemCommand To override the system command from the wall module
SystemStatus System status in the wall module
TimeField To configure the time format of the wall module 
TimeOfDay Time of the day to show on Sylk Device
ValueFromWallModule To provide the value from the wall module to the controller

Table 4 :  TR120X supported parameters

PARAMETER
Module-TR120X

TR120 SBusWallModule TR120H SBusWallModule

ROOMTEMP Y Y
HUMIDITY N Y
OccupancyOverrideCommand Y Y
ValueFromWallModule Y Y
TimeOfDay Y Y
SystemStatus Y Y
OccupancyStatus Y Y
ValueFromController Y Y
SystemCommand Y Y
TimeField Y Y
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BypassTime Y Y
SensorOffset Y Y
HomeScreen Y Y
NetworkSetpoint Y Y
SylkTime Y Y
FanCommand Y Y
EnumSchedule Y Y

Table 5 :  TR7X supported parameters

Parameter
Module-TR7X

TR75H 
SBusWallModule

TR75 
SBusWallModule

TR71H 
SBusWallModule

TR71 
SBusWallModule

ROOMTEMP Y Y Y Y
HUMIDITY Y N Y N
OccupancyOverrideCo
mmand

Y Y Y Y

ValueFromWallModule Y Y Y Y
TimeOfDay Y Y Y Y
SystemStatus Y Y Y Y
OccupancyStatus Y Y Y Y
ValueFromController Y Y Y Y
SystemCommand Y Y Y Y
TimeField Y Y Y Y
BypassTime Y Y Y Y
SensorOffset Y Y Y Y
HomeScreen Y Y Y Y
NetworkSetpoint Y Y Y Y
SylkTime Y Y Y Y
FanCommand Y Y Y Y
EnumSchedule Y Y N N

Table 6 :  TR42X supported parameters

Parameter
Module-TR42X

TR42 
SBusWallModule

TR42H 
SBusWallModule

TR42CO2 
SBusWallModule

TR42HCO2 
SBusWallModule

ROOMTEMP Y Y Y Y
HUMIDITY N Y N Y
CO2 N N Y Y
OccupancyOverrideCo
mmand

Y Y Y Y

OccupancyStatus Y Y Y Y

Table 4 :  TR120X supported parameters
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BypassTime Y Y Y Y
NetworkSetpoint Y Y Y Y
FanCommand Y Y Y Y

Table 7 :  TR40X supported parameters

Parameter
Module-TR40X

TR40 
SBusWallModule

TR40H
SBusWallModul

TR40CO2 
SBusWallModule

TR40HCO2 
SBusWall Module

ROOMTEMP Y Y Y Y
HUMIDITY N Y N Y
CO2 N N Y Y

Table 8 :  C7400S (Zeleny) supported parameters

Parameter Module - C7400S (Zeleny)

ROOMTEMP Y
HUMIDITY Y

Table 6 :  TR42X supported parameters
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Sylk Wall Module Usage
When using a Sylk or external wall module, only one wall module per controller can be 
added and its address is fixed to one. 

Procedure

Step 1. Double-click Event Program or Periodic Program in the tree.

Step 2. Open the honIrmControl palette.
Step 3. Scroll down to the Wallmodule group, and then expand it.
Step 4. Select the 'WmConfigHvacA' entry and drag & drop it onto the wiresheet.

Step 5. In the Name dialog box, change the name if desired and then click OK.
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Step 6. Double-click the WmConfigHvacA icon to display the Property Sheet.
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Step 7. Once TR42H is saved, the window will pop up to configure the 
SylkWallmodule address.

Step 8. On the property sheet, select the Sylk Wall module type in Wm Model.

Step 9. Under SylkWallmodule, the fixed Wm Address can be viewed.
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Steps to configure and Install Sylk application in Sylk 
devices

IRM controllers are Sylk Enabled controllers. Sylk enabled sensors can be configured 
with the IRMNX controller. 

Follow the below steps to configure and install the Sylk application in Sylk devices:

Step 1. Adding Sylk Device – Add Sylk device to the Periodic program or Event pro-
gram wiresheet view.

Step 2. Adding and Mapping Sylk Parameters with Sylk Device – Map the required 
Sylk Parameters with Sylk Device

Step 3. Configuring Sylk Parameters – Configure the Sylk parameters as per 
requirement

Step 4. Configuring Sylk Device – Configure the Sylk device as per requirement. 
Step 5. Validate Sylk Device – Use Validate the Sylk devices option to verify all the 

Sylk device configurations in the wiresheet view.
Step 6. Teach to a Controller – Teach to a Controller option install the Sylk device 

application file in the Sylk device models like TR120, TR75, etc.

Adding Sylk Device

Step 1. Navigate to Station > Config > Drivers > BacnetNetwork > IrmBacnetDe-
vice > IRM Program and open Wire Sheet view of Periodic program or 
Event program.

Step 2. Navigate to the Palette section select honlrmControl > SylkDevices.
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Step 3. Select the Sylk device from the SylkDevices list and drop it in the Wire Sheet 
view of the Periodic program or Event program.

If you want to add multiple Sylk devices — Press and hold Ctrl while selecting multiple 
Sylk devices from the Palette using clicking the right mouse button and drop it to the 
Wire Sheet view of Periodic program or Event program.

Double-click on the added Sylk devices to view the property sheet of the Sylk device. On 
the Sylk devices property sheet, you can check the power consumption and configure 
the Sylk device. Also, you can check Is Configuration Downloaded status true or false.

Figure  22. Total Sylk Power Consumption data checking



EN2B-0414GE51 R1021 253

NIAGARA IRM ENGINEERING TOOL - USER GUIDE

Adding and Mapping Sylk Parameters with Sylk Device

Once you have added the Sylk device under the Periodic program or Event program, 
you can configure the parameters of the Sylk devices. Refer Sylk Parameters section to 
get details on supported Sylk parameters for all the Sylk devices.

To add and map Sylk Parameters:

Step 1. Navigate to Station > Config > Drivers > BacnetNetwork > IrmBacnetDe-
vice > IRM Program and open Wire Sheet view of Periodic program or 
Event program.

Step 2. Navigate to the Palette section select honlrmControl > SylkParms.
Step 3. Select the Sylk device from the SylkDevices list and drop it in the Wire Sheet 

view of the Periodic program or Event program.
Step 4. Drag and drop the Sylk parameters modules from the SylkParams into the 

wire sheet or under the Periodic program or Event program.
Once you added all the required parameters in the wiresheet view, now you 
need to map all the parameters with the Sylk device.

Step 5. Double-click on the added Sylk parameters modules. This action opens the 
Property Sheet of the Sylk parameter. 

Step 6. Select the supported Sylk device from the drop-down list in the sylkDevice 
option

Figure  23. Figure 20: List of supported Sylk devices

Or 
If you want to configure multiple parameters with a Sylk Device. Right-click on 
the Sylk Device > Actions > select Attach unassigned Params. This action 
assigns all the supported unassigned parameters to the Sylk device. 
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If you want to create a specific group of parameters.
Step 7. Navigate to the palette, add the IrmFolder in the Wire Sheet view, and double 

click on the IrmFolder. 
Step 8. Navigate to the palette, select Sylk parameters and SylkDevices and drop it 

in the Wire Sheet view.

Step 9. In wiresheet view, right-click the Sylk Device > Actions > select Attach 
unassigned Params. This action assigns all the unassigned Parameters to 
the Sylk Device.

Similarly, you can create multiple folders and configure them with the Sylk devices. Also, 
you can re-use those folders, you need to copy and paste those folders in the Wire 
Sheet view.
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Configuring Sylk Parameters
After mapping the Sylk device with the Sylk parameters, configure the required Sylk 
parameters.
Sylk Parameters are divided into three categories:
• Sylk In Parameters 
• Sylk Out Parameters
• Sylk In Out Parameters

Sylk In Parameters
These parameters act as input to the Sylk controller.

Sylk Out Parameters
These parameters capture input from various sensors and act as output for the Sylk 
controller.

Sylk In Out Parameters
These parameters are used as input as well as output for the Sylk controller.

All the Sylk parameters have many features, refer NIAGARA IRM FUNCTION BLOCKS 
User Guide: EN2B-0415GE51 for more details.

Properties Description

ControllerValue Value from the controller to the wall module 
OccupancyStatus Occupancy status in the wall module
SystemStatus System status in the wall module
TimeOfDay Time of the day to show on Sylk Device

Properties Description

CO2 CO2 concentration in the space
HUMIDITY Percent humidity of the Space
OccupancyOverrideComm
and

Override the Unoccupancy Mode to Occupied Mode

ROOMTEMP Temperature of the space
SensorOffset Provide the sensor offset to the wall module
ValueFromWallModule Provide the value from the wall module to the controller

Properties Description

BypassTime Provide the bypass time to a wall module
FanCommand Provide commands to the fan from the wall module 
NetworkSetpoint Provide the setpoints to the wall module 
SystemCommand Override the system command from the wall module 
TimeField Configure the time format of the wall module
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Configuring Sylk In Parameters

ControllerValue Parameter Configuration

Figure  24. ControllerValue Property Sheet

Procedure

Step 1. Categories - Enter the category name in the field. This helps to differentiate 
between parameters.

Step 2. paramPermissions - Change Param Permissions (Contractor Only, Tenant 
Read-only, and Tenant Read Write) as per requirement from the drop-down 
list.

Step 3. enableFD - Fail Detect is the time until the Sylk controller is notified of a failure 
on this point.
• YES - If the parameter has not received an update from the IRM network 

source in the fail detect time, then an alarm is generated, and the present 
value is set to Invalid.

Note: Fail detect time depends on the update rate configured. 

• No - False means the object retains the last value that was written to it until 
an IRM network source changes.
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Step 4. enumerated - Use this option allows to enable multiple states of the Enum 
setpoint. 

Step 5. enumDefinition - If the Enumerated is set to “Yes” then the user can set the 
multiple states of the Enum setpoint.
To set the Enum states of the Setpoint 
• Click on the >> button.

• Set the states Ordinal & Display as per requirement. For example, 

• Click Ok to save. 

Note: Enumerated option applicable to Sylk module type is TR 71 and TR 75. Select the 
parameter type as Controller Value, Value from Wall Module, or Network Setpoint to 
enable the Enumerated option.

Step 6. defaultEnumValue - This option displays the list of default Enum values from 
the defined enum range.

Step 7. selectLabelsToShowOnScreen – This option allows to config Sylk device 
label display for Sylk parameter.
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OccupancyStatus Parameter Configuration

Figure  25. OccupancyStatus Property Sheet

Procedure

Step 1. enableFD - Fail Detect is the time until the Sylk controller is notified of a fail-
ure on this point.

• YES - If the parameter has not received an update from the IRM network 
source in the fail detect time, then an alarm is generated, and the Present 
Value is set to Invalid.

Note: Fail detect time depends on the update rate configured. 

• No - False means the object retains the last value that was written to it until 
an IRM network source changes.

Step 2. tR7XConfig – This option provides options to select how to override status is 
required to be displayed in the LCD. Following available options:
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• Show effective occupancy status: LCD shows the actual occupancy 
status considering the IRM application. 

• Show occupancy override status: LCD shows the occupancy override 
status initiated from the LCD, independent of the IRM application. 

• Do not show occupancy or override status: LCD does not show 
occupancy or override, regardless of what the user initiates and the IRM 
application. 

SystemStatus Parameter Configuration

Figure  26. SystemStatus Property Sheet

Procedure

Step 1. enableFD - Fail Detect is the time until the Sylk controller is notified of a fail-
ure on this point.

• YES - If the parameter has not received an update from the IRM network 
source in the fail detect time, then an alarm is generated, and the present 
Value is set to Invalid.

Note: Fail detect time depends on the update rate configured. 

• No - False means the object retains the last value that was written to it until 
an IRM network source changes.
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Step 2. systemStatusValues – This option allows to config the system values as per 
requirement in the defined range.

TimeOfDay Parameter Configuration

Figure  27. TimeOfDay Property Sheet

Procedure
Step 1. Categories - Enter the category name in the field. This helps to differentiate 

between parameters.
Step 2. paramPermissions - Change Param Permissions (Contractor Only, Tenant 

Read only, and Tenant Read Write) as per requirement from the drop-down 
list.

Step 3. enableFD - Fail Detect is the time until the Sylk controller is notified of a failure 
on this point.
• YES - If the parameter has not received an update from the IRM network 

source in the fail detect time, then an alarm is generated, and the present 
Value is set to Invalid.

Note: Fail detect time depends on the update rate configured. 
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• No - False means the object retains the last value that was written to it until 
an IRM network source changes.

Step 4. selectLabelsToShowOnScreen – This option allows to config Sylk device 
label display for Sylk parameter.

For more detail about Sylk In Parameters type, refer NIAGARA IRM FUNCTION 
BLOCKS User Guide: EN2B-0415GE51
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Configuring Sylk Out Parameters 

Humidity Parameter Configuration

Figure  28. Humidity Property Sheet

Procedure

Step 1. Categories - Enter the category name in the field. This helps to differentiate 
between parameters.

Step 2. paramPermissions - Change Param Permissions (Contractor Only, Tenant 
Read-only, and Tenant Write only) as per requirement from the drop-down list.

Step 3. enableFD - Fail Detect is the time until the Sylk controller is notified of a failure 
on this point.
• YES - If the parameter has not received an update from the IRM network 

source in the fail detect time, then an alarm is generated, and the Present 
Value is set to Invalid.

Note: Fail detect time depends on the update rate configured. 

• No - False means the object retains the last value that was written to it until 
an IRM network source changes.



EN2B-0414GE51 R1021 263

NIAGARA IRM ENGINEERING TOOL - USER GUIDE

Step 4. tR7XConfig – This option allows you config additional param options.

Step 5. tR4XConfig - This option allows you config additional param options.

CO2 Parameter Configuration

Figure  29. CO2 Property Sheet

Procedure

Step 1. Categories - Enter the category name in the field. This helps to differentiate 
between parameters.

Step 2. paramPermissions - Change Param Permissions (Contractor Only and 
Tenant Read-Only) as per requirement from the drop-down list.

Step 3. enableFD - Fail Detect is the time until the Sylk controller is notified of a failure 
on this point.
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• YES - If the parameter has not received an update from the IRM network 
source in the fail detect time, then an alarm is generated, and the present 
Value is set to Invalid.

Note: Fail detect time depends on the update rate configured. 

• No - False means the object retains the last value that was written to it until 
an IRM network source changes.

OccupancyOverrideCommand Parameter Configuration

Figure  30. OccupancyOverrideCommand Property Sheet

Procedure

Step 1. enableFD - Fail Detect is the time until the Sylk controller is notified of a fail-
ure on this point.

• YES - If the parameter has not received an update from the IRM network 
source in the fail detect time, then an alarm is generated, and the present 
Value is set to Invalid.

Note: Fail detect time depends on the update rate configured. 

• No - False means the object retains the last value that was written to it until 
an IRM network source changes.

Step 2. tR7XConfig – This option allows you to configure occupancy override 
additional settings.
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Properties Description

Override To Occupied 

Allows you to enable Override To Occupied setting.

Override Type 

Continuous Override:  The default setting, this setting disables 
the time override type options.
Time Override in Hours (Bypass): This option enables the 
Time Setting Details, wherein the Minimum Time and Maximum 
Time can be set in Hours and Minutes. The default setting is Min 
= Max = 3 hours. Make sure that the Maximum Time is greater 
than the Minimum time or that the Minimum Time is lesser than 
Maximum Time. If either case is not TRUE, an error message 
appears informing that the min value is greater than max value. 
The range is from 0 - 24 hrs/0-59 min. 
Time Override in Days (Bypass): This option enables the Time 
Setting Details, wherein the Minimum Time and Maximum Time 
can be set in Days. In this case, the Hours and Minutes options 
are disabled. The default setting is Min = Max = 1 day. The range 
is from 1 to 99 days. 

If the range is exceeded, an error message appears to inform 
about the same. 

Use Network Bypass 
Time Only

Use Network Bypass Time Only: If this option is selected, then 
all other override details are disabled. The timed override details 
will be determined by the IRM application. 
Note: The Use Network Bypass Time Only option only applies 
to Occupied override type settings. This option is not available 
for Unoccupied and Standby override type settings. 

Override Settings 



266 EN2B-0414GE51 R1021

NIAGARA IRM ENGINEERING TOOL - USER GUIDE

Override To Unoccupied 

Allows you to enable Override To UnOccupied setting.

Override Type 

Continuous Override:  The default setting, this setting disables 
the time override type options.
Time Override in Hours (Bypass): This option enables the 
Time Setting Details, wherein the Minimum Time and Maximum 
Time can be set in Hours and Minutes. The default setting is Min 
= Max = 3 hours. Make sure that the Maximum Time is greater 
than the Minimum time or that the Minimum Time is lesser than 
the Maximum Time. If either case is not TRUE, an error 
message appears informing that the min value is greater than 
the max value. The range is from 0 - 24 hrs/0-59 min. 
Time Override in Days (Bypass): This option enables the Time 
Setting Details, wherein the Minimum Time and Maximum Time 
can be set in Days. In this case, the Hours and Minutes options 
are disabled. The default setting is Min = Max = 1 day. The range 
is from 1 to 99 days. 

Override Settings 

Override To Standby 

This allows you to enable Override To Standby setting.

Properties Description
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Override Type 

Continuous Override:  The default setting, this setting disables 
the time override type options.
Time Override in Hours (Bypass): This option enables the Time 
Setting Details, wherein the Minimum Time and Maximum Time 
can be set in Hours and Minutes. The default setting is Min = 
Max = 3 hours. Make sure that the Maximum Time is greater 
than the Minimum time or that the Minimum Time is lesser than 
the Maximum Time. If either case is not TRUE, an error 
message appears informing that the min value is greater than 
the max value. The range is from 0 - 24 hrs/0-59 min. 
Time Override in Days (Bypass): This option enables the Time 
Setting Details, wherein the Minimum Time and Maximum Time 
can be set in Days. In this case, the Hours and Minutes options 
are disabled. The default setting is Min = Max = 1 day. The range 
is from 1 to 99 days. 

Override Settings 

Occupancy Values 

Provides options to define the different values within the 
mentioned ranges. 

• Show effective occupancy status: LCD shows the actual 
occupancy status taking into account the IRM 
application. 

• Show occupancy override status: LCD shows the 
occupancy override status initiated from the LCD, 
independent of the IRM application. 

• Do not show occupancy or override status: LCD does 
not show occupancy or override, regardless of what the 
user initiates and the IRM application. 

Properties Description
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Step 3. tR4XConfig - This option allows you config additional param options.

RoomTemp Configuration

Figure  31. RoomTemp Property Sheet

Procedure

Step 1. Categories - Enter the category name in the field. This helps to differentiate 
between parameters.

Step 2. paramPermissions - Change Param Permissions (Contractor Only and 
Tenant Read Only) as per requirement from the drop-down list.

Step 3. enableFD - Fail Detect is the time until the Sylk controller is notified of a failure 
on this point.
• YES - If the parameter has not received an update from the IRM network 

source in the fail detect time, then an alarm is generated, and the present 
Value is set to Invalid.

Note: Fail detect time depends on the update rate configured. 

• No - False means the object retains the last value that was written to it until 
an IRM network source changes.

Step 4. TemperatureUnit – This option allows you to select temperature unit (oF/oC)
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Step 5. tR7XConfig – This option allows you config additional param options.

Step 6. tR4XConfig - This option allows you config additional param options.
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SensorOffset Parameter Configuration

Figure  32. SensorOffset Property Sheet

Procedure

Step 1. Categories - Enter the category name in the field. This helps to differentiate 
between parameters.

Step 2. paramPermissions - Change Param Permissions (Contractor Only, Tenant 
Read-only, and Tenant Write only) as per requirement from the drop-down list.

Step 3. selectSensor – Select Sensor displays the list of sensors that needs to be 
configured an offset for. All available sensors are listed, but the selection is 
based on the selected model. The default selection is Temperature. This field 
is displayed only for a parameter of the category OFFSET.

The default value for the following parameter types:
• Temperature from wall module

• Humidity from wall module

• CO2 from wall module
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The default value has a limit of 5 characters.

Note: For the Parameter Types Temperature/Humidity/CO2 from the wall module, if this value 
is edited and the changes are saved, the Default Value of the Sensor Offset Value of the 
corresponding sensor also changes to the edited value.

Step 4. Increment/Decrement - Depend on the Number of decimal places selected. 
If the number of decimal places = 0, then increment/decrement = 1, 5, 10, 100. 
If the number of decimal places = 1, then increment/decrement = 0.1, 0.5, 1, 
5, 10, 100. 
If number of decimal places = 2, then increment/decrement = 0.01, 0.1, 0.5, 
1, 5, 10, 100.

Note: The increment of 5 and 0.5 is only available for the Value from Wall Module, Network 
Setpoint, and Sensor Offset Value (Internal) parameters in TR71/TR75 model wall 
modules.

Step 5. Default value - Indicate the value that will be initially downloaded to the wall 
module. This value must be between the Low and High limits. This field is 
displayed for the following parameter types: 
• Value from wall module 

• Sensor offset value. By default, it is set to 0.

Step 6. limitConfig – This option allows to set the high & low limits of the parameter. 
• Low Limit From Sylk Param: To select the Low limit value from the other 

Sylk parameter of the respective system device. 

• High Limit From Sylk Param: To select the High limit value from the 
other Sylk parameter of the respective system device.

• Low Limit: Allows to set the low limit

• High Limit: Allows to set the high limit

Step 7. Number of Decimals - Apply to all parameter types except Time. This value 
affects Increment/Decrement options

Step 8. selectLabelsToShowOnScreen – This option allows to config Sylk device 
label display for Sylk parameter.
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ValueFromWallModule Parameter Configuration

Figure  33. ValveFromWallModule Property Sheet

Procedure

Step 1. Categories - Enter the category name in the field. This helps to differentiate 
between parameters.

Step 2. paramPermissions - Change Param Permissions (Contractor Only, Tenant 
Read-only, and Tenant Read Write) as per requirement from the drop-down 
list.

Step 3. enableFD - Fail Detect is the time until the Sylk controller is notified of a failure 
on this point.
• YES - If the parameter has not received an update from the IRM network 

source in the fail detect time, then an alarm is generated, and the Present 
Value is set to Invalid.

Note: Fail detect time depends on the update rate configured. 

• No - False means the object retains the last value that was written to it until 
an IRM network source changes it or the
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Step 4. allow null values - Indicate whether null values can be set for the adjustable 
value. If enabled, when the LCD user reaches a low/high limit, an additional 
button press will send the null value.

Step 5. enumerated - Use this option allows to enable multiple states of the Enum 
setpoint. 

Step 6. enumDefinition - If the Enumerated is set to “Yes” then the user can set the 
multiple states of the Enum setpoint.
To set the Enum states of the Setpoint 
a click on the >> button.

b Set the states Ordinal & Display as per requirement. For example, 

c Click Ok to save. 

Note: Enumerated option applicable to Sylk module type is TR 71 and TR 75. Select the 
parameter type as Controller Value, Value from Wall Module, or Network Setpoint to 
enable the Enumerated option.

Step 7. defaultEnumValue - This option displays the list of default Enum value from 
the defined enum range.

Step 8. Number of Decimals - Apply to all parameter types except Time. This value 
affects Increment/Decrement options.

Step 9. Increment/Decrement - Depend on the Number of decimal places selected. 
If the number of decimal places = 0, then increment/decrement = 1, 5, 10, 100. 
If the number of decimal places = 1, then increment/decrement = 0.1, 0.5, 1, 
5, 10, 100. 
If number of decimal places = 2, then increment/decrement = 0.01, 0.1, 0.5, 
1, 5, 10, 100.

Note: The increment of 5 and 0.5 is only available for the Value from Wall Module, Network 
Setpoint, and Sensor Offset Value (Internal) parameters in TR71/TR75 model wall 
modules.

Step 10. Default value - Indicate the value that will be initially downloaded to the wall 
module. This value must be between the Low and High limits. This field is 
displayed for the following parameter types: 
• Value from wall module 

• Sensor offset value. By default, it is set to 0.



274 EN2B-0414GE51 R1021

NIAGARA IRM ENGINEERING TOOL - USER GUIDE

Step 11. limitConfig – This option allows to set the high & low limits of the parameter. 
• Low Limit From Sylk Param: To select the Low limit value from the other 

Sylk parameter of the respective system device. 

• High Limit From Sylk Param: To select the High limit value from the other 
Sylk parameter of the respective system device.

• Low Limit: Allows to set the low limit

• High Limit: Allows to set the high limit

Step 12. Number of Decimals - Apply to all parameter types except Time. This value 
affects Increment/Decrement options

Step 13. selectLabelsToShowOnScreen – This option allows to config Sylk device 
label display for Sylk parameter.

For more detail about Sylk Out Parameters type, refer NIAGARA IRM FUNCTION 
BLOCKS User Guide: EN2B-0415GE51
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Configuring Sylk In Out Parameters 

BypassTime Parameter Configuration

Figure  34. BypassTime Property Sheet

Procedure

Step 1. enableFD - Fail Detect is the time until the Sylk controller is notified of a fail-
ure on this point.

• YES - If the parameter has not received an update from the IRM network 
source in the fail detect time, then an alarm is generated, and the Present 
Value is set to Invalid.

Note: Fail detect time depends on the update rate configured. 

• No - False means the object retains the last value that was written to it until 
an IRM network source changes it or the
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FanCommand Parameter Configuration

Figure  35. FanCommand Property Sheet

Step 2. enableFD - Fail Detect is the time until the Sylk controller is notified of a failure 
on this point.
• YES - If the parameter has not received an update from the IRM network 

source in the fail detect time, then an alarm is generated, and the Present 
Value is set to Invalid.

Note: Fail detect time depends on the update rate configured. 

• No - False means the object retains the last value that was written to it until 
an IRM network source changes it or the

Step 3. fanStates - Enable the fan command. Only if this option is checked will the 
Valid Fan States options be enabled. Select one from the three valid fan states
• 2 State

• 3 State

• 5 State

Default Fan State: The following are fan state options:
• State: Auto/On. The default option is On.

• 3 State: Auto/On/Off. The default option is On.
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• 5 State: Auto/Off/Low/Medium/High. The default option is Auto.

Step 4. fanStateValues – Set the fan state values for Auto/Off/On/Low/Medium/High.

Step 5. Configure TR 7x Fan command Additional configuration
Step 6. Set as Network setpoint: This option is to connect the System command 

block with the Network input/set point and the Network output point. If the Set 
as Network setpoint got disabled, then the System command block can be 
connected with the Network output point, but not with the Network input/set 
point.

Note: By default, Set as Network setpoint it is enabled. User cannot disable this option.

Note: Set as Network Setpoint option is available only for the TR71/TR75/TR42 model wall 
modules.
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NetworkSetpoint Parameter Configuration

Figure  36. NetworkSetpoint Property Sheet

Procedure

Step 1. Categories - Enter the category name in the field. This helps to differentiate 
between parameters.

Step 2. paramPermissions - Change Param Permissions (Contractor Only, Tenant 
Read only, and Tenant Write Read) as per requirement from the drop-down 
list.

Step 3. enableFD - Fail Detect is the time until the Sylk controller is notified of a failure 
on this point.
• YES - If the parameter has not received an update from the IRM network 

source in the fail detect time, then an alarm is generated, and the Present 
Value is set to Invalid.

Note: Fail detect time depends on the update rate configured. 

• No - False means the object retains the last value that was written to it until 
an IRM network source changes it or the

Step 4. allowNullValue - Indicate whether null values can be set for the adjustable 
value. If enabled, when the user reaches a low/high limit, an additional button 
press will send the null value.
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Step 5. tR7XConfig – This option allows you config additional param options.

Properties Description

enumerated Use this option allows to enable multiple states of the Enum 
setpoint. 

enumDefinition 

If the Enumerated is set to “Yes” then the user can set the multiple 
states of the Enum setpoint.
To set the Enum states of the Setpoint

a Click on the >> button.

b Set the states Ordinal & Display as per requirement. For 
example, 

c Click Ok to save. 
Note: Enumerated option applicable to Sylk module type is TR 
71 and TR 75. Select the parameter type as Controller Value, 
Value from Wall Module or Network Setpoint to enable the 
Enumerated

defaultEnumValue This option displays the list of default Enum value from the 
defined enum range.

Number of Decimals Apply to all parameter types except Time. This value affects 
Increment/Decrement options.
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Step 6. tR4XConfig – This option allows you config additional param options.

Increment/Decrement 

Depend on the Number of decimal places selected. 
If the number of decimal places = 0, then increment/decrement = 
1, 5, 10, 100. 
If the number of decimal places = 1, then increment/decrement = 
0.1, 0.5, 1, 5, 10, 100. 
If number of decimal places = 2, then increment/decrement = 
0.01, 0.1, 0.5, 1, 5, 10, 100.
Note: The increment of 5 and 0.5 is only available for the Value 
from Wall Module, Network Setpoint, and Sensor Offset Value 
(Internal) parameters in TR71/TR75 model wall modules.

Default value 

Indicate the value that will be initially downloaded to the wall 
module. This value must be between the Low and High limits. 
This field is displayed for the following parameter types: 

• Value from wall module 

• Sensor offset value. By default, it is set to 0.

limitConfig 

This option allows to set the high & low limits of the parameter.

• Low Limit From Sylk Param: To select the Low limit 
value from the other Sylk parameter of the respective 
system device. 

• High Limit From Sylk Param: To select the High limit 
value from the other Sylk parameter of the respective 
system device.

• Low Limit: Allows to set low limit

• High Limit: Allows to set the high limit

selectLabelsToShowOn
Screen 

This option allows to config the Sylk device label display for Sylk 
parameter.

Properties Description
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SystemCommand Parameter Configuration

Figure  37. SystemCommand Property Sheet

Procedure

Step 1. enableFD - Fail Detect is the time until the Sylk controller is notified of a fail-
ure on this point.

• YES - If the parameter has not received an update from the IRM network 
source in the fail detect time, then an alarm is generated, and the Present 
Value is set to Invalid.

Note: Fail detect time depends on the update rate configured. 

• No - False means the object retains the last value that was written to it until 
an IRM network source changes it or the

Step 2. systemCommands - Indicate an option to enable/disable tenant 
commanding the system. 
Following are the five valid system command options available: 
• Off / Heat (Heat only)

• Off / Cool (Cool only)

• Off / Heat / Cool (No Auto changeover)

• Off / Auto / Heat / Cool (Auto changeover)
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• Off / Auto / Heat / Cool / Emergency Heat (Heat Pump)

Step 3. defaultSystemCommand – Allow to set the default value for the system 
command options:
• Heat - Off / Heat

• Cool - Off / Cool

• OFF - Off / Heat / Cool: 

• Auto - Off / Auto / Heat / Cool: 

• Emergency Heat: - Off / Auto / Heat / Cool / Emergency Heat

Step 4. SystemCommandValues - Set the system command state values for Off / 
Auto / Heat / Cool / Emergency Heat

Step 5. Set as Network setpoint: Select this option to connect the System command 
block with the Network input/set point and the Network output point. If the 
option is not selected, then the System command block can be connected 
with the Network output point, but not with the Network input/set point.

Note: Set as Network Setpoint option is available only for the TR71/TR75 model wall modules.
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TimeField Parameter Configuration

Figure  38. TimeFied Parameter

Procedure

Step 1. Categories - Enter the category name in the field. This helps to differentiate 
between parameters.

Step 2. paramPermissions - Change Param Permissions (Contractor Only, Tenant 
Read only, and Tenant Read Write) as per requirement from the drop-down 
list.

Step 3. enableFD - Fail Detect is the time until the Sylk controller is notified of a failure 
on this point.
• YES - If the parameter has not received an update from the IRM network 

source in the fail detect time, then an alarm is generated, and the Present 
Value is set to Invalid.

Note: Fail detect time depends on the update rate configured. 

• No - False means the object retains the last value that was written to it until 
an IRM network source changes it or the

Step 4. timeComponent – This option allows to configure time and date format. The 
following are the available time components.
• Hours (Network Setpoint)

• Minutes (Network Setpoint)
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• Day (Network Setpoint)

• Month (Network Setpoint)

• Year (Network Setpoint)

Step 5. selectLabelsToShowOnScreen – This option allows to config Sylk device 
label display for Sylk parameter.

If you want to display any data to the Sylk wall module like temperate from the controller, map 
the UI terminal of the controller with the Sylk parameter.
Steps to Map UI terminal of the controller with Sylk parameter:

Step 1. Open the Wiresheet View, right-click on the UI terminal of the controller 
and select Link Mark.
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For more detail about Sylk In Out Parameters type, refer NIAGARA IRM FUNCTION 
BLOCKS User Guide: EN2B-0415GE51

Step 2. Navigate to the Sylk application, right-click on the Sylk parameter, and 
select Link To UI terminal.

This opens Link windows.
Step 3. Select Out from the Source and In from the Target.

Step 4. Click OK
This maps the UI Controller terminal with the Sylk parameter terminal. 
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Configuring Sylk Device

The Property Sheet on the right pane displays the details of the Sylk Device port. The 
details include Network Number, Address, Status, Power consumption, and other 
options.

Steps to Configure SylkDevice

Step 1. Address - This option allows you to select a device address from the drop-
down list. 

Note: When you drop down the Sylk device to the Wire Sheet view, it will automatically assign 
a unique address. You can change the assigned address manually also.

Step 2. Time Format – Set the time format of the Sylk device (12 hours or 24 hours)
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Step 3. Home Screen Options - This option allows you to configure Home Screen 
settings.

Properties Description

Set As Default Select this option if the current Home screen needs to be set as default.
Option Type Select the type of screen that is required

• Single Parameter (One Value with Custom Eight Character Label) – This option 
displays any of one label in the homescreen.

• Multiple Parameter (Up To Three Values with Fixed Label) – This option displays 
all three labels on the homescreen.

Label Name Add the label name as per requirement
Note: “Specify the parameter you want to show (For Single Parameter HomeScreen, only 
Middle Param will be considered).”

Left Parameter Map the parameter that needs to be shown on the left side of the home screen
Middle 
Parameter 

Map the parameter needs to be shown in the middle of the home screen
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Right Parameter Map the parameter that needs to be shown on the right side of the home.

To map parameter with homescreen:

Step 1. Click the Folder icon ( ) and select Component Chooser from the drop-
down list.

Step 3. On the Select Ord window, Click Drivers > BacnetNetwork > 
IrmBacnetDevice > IRM Program > Periodic program> Humidity and 
click OK.
This action fetches the scheduler location to the Scheduler Block Location 
filed.
Or

Step 4. Go to Nav Window, navigate to the Station > Drivers > BacnetNetwork > 
IrmBacnetDevice > IRM Program > Periodic program wiresheet.

Step 5. Select the parameter and press Ctrl + L. This action opens the Ord window,
Step 6. Copy the Ord link.
Step 7. Navigate to the Home Screen settings option in the Sylk device and paste 

in the Ord link in the any of parameter fields.

Note: The Sylk parameter linked to the Left Param displays the parameter value on the 
middle of the Sylk device,  Sylk parameter linked to the Middle Param display the parameter 
value on top of the Sylk device, and the Sylk parameter linked to the Right Param display the 
parameter value on the bottom of Sylk device.

Properties Description
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Step 2. Password Protection - The option allows to set the password for the Sylk 
device. This feature restricts the tenants to do the changes in the Sylk 
controller.

• Enable Password Protection – This option allows you to enable 
password protection for the Sylk controller.

• Password Label – This option allows you to add password label 
information. The label length should be eight characters.

• Password – This option allows you to set the password. Numeric 
characters are allowed in the password.

Step 3. Categories And Parameters Node - Categories and Parameters node 
allows users to reorder Sylk categories and Sylk parameters from the 

Select Labels To 
Show On Home 
Screen

Select the required option (Room top or Room Bottom) to show the parameter on the home 
screen shown below:

• Labels displayed on the top with Middle Param – Room (Top), Setpoint (Top), and 
Temperature

• Labels displayed on the middle with Middle Param – Room (Bottom) and Setpoint 
(Bottom)

• Labels displayed on the bottom with Middle Param – Humidity and Outside

• Only one engineering unit label is supported by the Sylk device (Ppm, Cfm, L/S, 
Cm, and Inch). If you enable multiple engineering unit labels, then the system will 
consider the topmost unit label in the sequence in the Home Screen. Example – 
If you enable Cfm, L/S, and Inch unit label in the Home Screen, then Sylk device 
will display Cfm unit, as in topmost unit label. 

Properties Description
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workbench and browser. Sylk device will display the categories and 
parameters in the order specified in this place.

Reordering can be done once the user is completed with Sylk device and parameters 
configuration.

Reordering Parameters and Categories
The parameters can be reordered across the categories as well as in a category. Also, users 
can reorder Categories.
Steps to perform reordering

Step 1. Navigate to TR7X from the Nav window and double-click Categories and 
Parameters Node.

Or 
Navigate to Wiresheet view > double click on TR7X Sylk device > in the 
TR7X Sylk device property sheet > double-click on Categories and 
Parameters Node option.
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Step 2. Right-click on Categories and Parameters Node > Actions > Load 
Categories And Parameters.

Step 3. This will load all the categories and parameters associated with this Sylk 
device.

Step 4. Right-click on Categories and Parameters Node from the Property Sheet 
and select Reorder.

Step 5. Use Move Up or Move Down to reorder the Category and Click 
Ok.
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Note: To select multiple parameters, press Ctrl and click Move Up or Move Down. 
Similarly, you can reorder parameters associated with the Category also.

Once re-ordering is completed and Sylk commission is done, you can then view the 
same order of Categories and Parameters Node in the connected Sylk device.

Categories and Parameters Node, allows you to see all the parameters associated 
with that device and also provides an option to navigate to the parameter using the 
ord.

Renaming Parameter and Categories

The categories and Parameters option allows you to rename categories as well as 
parameters from the workbench.

Steps to rename Parameter

Step 1. Select parameter from the category, right-click and select Rename.

Step 2. This action brings Rename window, enter the new name, and click Ok.
Step 3. Navigate to Categories and Parameters node, right-click and select Actions 

> Load Categories And Parameters. This action loads the changes.
• In the wiresheet, you can view the changed parameter name.

Similarly, the user can rename the Categories also.

Disassociating Parameter and Categories

The categories and Parameters option allows you to disassociate categories and 
parameters from the associated Sylk Device.

To disassociate Parameter, select parameter from the category > right-click and 
select Delete. This action disassociates that parameter from the Sylk device, and 
none will be displayed for that Sylk parameter.

• To disassociate Category, select category > right-click and select Delete. This 
action disassociates all the parameters from the Sylk device, and none will be 
displayed for all the parameters associated with that category.
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Step 6. Schedule – The schedule option allows you to configure the Sylk device with 
EnumSchedule and Calendar.

Steps to configure Schedule

a. Open Sylk device property sheet and navigate to the Schedule option.

b. Set the Schedule Editable From Zio field to Yes.
c. Change Param Permissions (Contractor Only, Tenant Read-only, and Tenant 

Read Write) as per requirement.
d. Change the Schedule Type as per requirement (8-day schedule/ 7-day schedule/ 

5-2-1-day schedule/ 5-2-day schedule).
e. Enter the schedule block location in the Schedule Block Location field.

To Enter Scheduler Block Location:

i. Click the Folder icon ( ) and select Component Chooser from the drop-
down list.

ii. On the Select Ord window, Click Drivers > BacnetNetwork > 
IrmBacnetDevice > IRM Program > Periodic program> EnumSchedule, 
and click OK.
This action fetches the scheduler location to the Scheduler Block Location 
filed.
Or

i. Go to Nav Window, navigate to the Station > Drivers > BacnetNetwork > 
IrmBacnetDevice > IRM Program > Periodic program> EnumSchedule, 
and press Ctrl + L.

ii. This action opens Ord window, copy the location, and paste in the Scheduler 
Block Location field

f. Click Save to apply the changes. 

Step 7. Time - Time option allows you to enable Time component for Sylk Device. To 
add this Time component, enable Time editable From Zio option set to Yes 
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and set the Param Permission to Contractor Only, Tenant Read Only, or 
Tenant Read Write from the drop-down menu.

• If Contractor Only is selected, only the contractor can view the time in the 
Sylk device. 

• If Tenant Read Only is selected, the tenant can view the time, but cannot 
make any changes in the time. 

• If Tenant Read Write is selected, the tenant can view as well as modify the 
time. Time includes the year, month, date, hour, and minutes so this 
option enables everything in the time component.

If you want to give limited access to contractor or tenant. For example, the contractor is 
allowed to change time but not date, to provide this type of controlled access use the 
TimeField parameter. TimeField parameter allows you to customize access for contrac-
tor and tenant. For details, more details about the TimeField parameter, refer to NIAG-
ARA IRM FUNCTION BLOCKS User Guide: EN2B-0415GE51

Validate Sylk Device

After configuring Sylk Devices with the Sylk parameters, you need to validate the Sylk 
device configuration. Validating Sylk device to verify the configuration of added Sylk 
device. Also, it verifies any incorrect value entered in parameters or limitations for the 
configured Sylk device. 

To validate Sylk Device:

Step 1. Navigate to Station > Config > Drivers > BacnetNetwork > IrmBacnetDe-
vice.

Step 2. Right-click on the IRM Program and select Actions > Validate Sylk Devices. 
This validates all the Sylk devices in the wiresheet view.
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Or

If you want to validate a single Sylk device, then follow the below steps

Step 3. Navigate to Station > Config > Drivers > BacnetNetwork > 
IrmBacnetDevice > IRM Program > Periodic program or Event program.

Step 4. Right-click on the Sylk Device and select Actions > Validate Sylk Devices.

After you run the Validate Sylk Device, on the Job Log window, you view the status of 
the configured Sylk Devices. Using the job log details, you can locate and correct all the 
issues.
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You can perform this operation in online mode as well as while configuring Sylk devices 
on the workstation in offline mode.

Teach to a Controller

After you validate the Sylk device, run Teach to Controller command, this installs the 
Sylk device application file in the Sylk device models like TR75, TR40, etc. 

To run Teach to Controller:

Step 1. Right-click on IRM Program > Actions > click Teach to Controller.

Step 2. Select Overwrite BACnet objects values in Device or Overwrite BACnet 
object values in Application.
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• Overwrite BACnet objects values in Device - This option overwrites 
BACnet object values in the controller and directly teaches application in 
the controller.

• Overwrite BACnet object values in Application – This option first 
performs update all BACnet object values and default values from 
controller to application, then it teaches application in the controller.

Result: The changes are written to the controller. The applications are 
synchronized. The successful action is displayed via Irm Operations 
Monitor.

The changes are written to the controller. The applications are synchronized. The suc-
cessful action is displayed in Workbench job service. 

After the Sylk application gets installed in the Sylk controllers, the Sylk controllers reboot 
and display all the configured values in the Sylk controllers.

Figure  39. Sylk device display

After loading the Sylk application file into the Sylk controller, you can verify the Sylk 
Device Resource Usage - This option is the read-only point, that displays Sylk Device 
resource usage. After you install the Sylk application in the Sylk controller, the Sylk 
Device Resource Usage displays how many resources are utilized by each parameter 
and the proxy size of data by the Sylk controller.

To Verify the Sylk Device Resource Usage:

Step 1. Open the workstation and navigate to the Sylk application.

Note: Make sure the Sylk controller is connected to the workstation.
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Step 2. Open the Sylk Device and click Sylk Device Resource Usage.

In the device property, you can see the Is Configuration Downloaded option is True. 

If any configuration changes are done in the Sylk device or Sylk parameter, then In Con-
figuration Downloaded option is changed to False, then you validate the configuration 
and perform Teach to Controller on the Sylk Device to update the changes.
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Sylk Parameter Summary
If you want to view all the associated parameters to the Sylk Device. Navigate to the 
IRM Program > Views > select Sylk Parameter Summary.

Figure  40. Sylk Parameter Summary View

By following the above procedures, you can add Sylk devices and Sylk parameters, and 
associate those Sylk parameters with the supported Sylk devices. After you configured 
the Sylk parameters with Sylk devices, generate the Sylk proxy file and commission it to 
the controller.

Also, if you want to replace the TR42 with the TR75 Sylk device, you just need to 
replace TR42 with the TR75 Sylk device and re-associate all the parameters with the 
device. Then, commission and download it to the controller, this will help you to re-con-
figure the device with less modification. Also, it helps in link creation when the function 
block remains the same, but the associated parameters change from one device to 
another device. 

Sylk Device Resource Usage - This option is the read-only point, that displays Sylk 
Device resource usage. After you install the Sylk application in the Sylk controller, the 
Sylk Device Resource Usage displays how many resources are utilized by each param-
eter and the proxy size of data by the Sylk controller.
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Sylk Parameter Example
Users can configure the Sylk parameters according to their requirements as shown in 
the below modules:

TR75H Sylk Configuration and Logic

TR75H Sylk Configuration:

Once the wall module is wired to the controller, you configure the wall module using the 
PC-based, Niagara Workbench Tool. This tool is used to configure the wall module for 
IRM controllers. The model tab under the TR7x configuration would be auto-selected 
based on the function block dropped in the wire sheet.

Check to ensure that the Wall Module’s bus address dial (located on the back of the 
module) matches exactly with the setting of the configuration tool. Select 12 or 24-hour 
format.

TR75H Logic Configuration:

The function blocks are configured according to the requirement of the user. The sylk 
parameters are present in the palette, the user has to drag and configure the parame-
ters according to the need. Following are the blocks with their function:

• ROOMTEMP: To measure the temperature of the space

• OccupancyOverrideCommand: To override the Unoccupancy Mode to Occupied 
Mode

• OccupancyStatus: explains the occupancy status in the wall module

• SensorOffset: To provide the sensor offset to the wall module

• ValueFromWallModule: To provide the value from the wall module to the controller

• SystemCommand: To override the system command from the wall module
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• PassThru: The PassThru block passes temperature inputs and transfers the value to 
network outputs.

• SavePermanent: It is used to save values in non-volatile memory. The value is not 
lost when the supply voltage is switched off. 

• Encode: The Encode function translates enumerations of a digital value into different 
enumeration numbers, allowing standard and custom enumerations to be combined 
and used together.
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TR71H Sylk Configuration and Logic

TR71H Logic Configuration

The function blocks are configured according to the requirement of the user. The sylk 
parameters are present in the palette, the user has to drag and configure the parame-
ters according to the need. Following are the blocks with their function:

• ROOMTEMP: To measure the temperature of the space

• OccupancyOverrideCommand: To override the Unoccupancy Mode to Occupied 
Mode

• PassThru: PassThru block passes temperature inputs and transfers the value to 
network outputs.

• SavePermanent: It is used to save values in non-volatile memory. The value is not 
lost when the supply voltage is switched off.

• Encode: The Encode function translates enumerations of a digital value into different 
enumeration numbers, allowing standard and custom enumerations to be combined 
and used together.
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TR120H_TR75E Sylk Configuration and Logic

TR120H_TR75E Logic Configuration

The function blocks are configured according to the requirement of the user. The sylk 
parameters are present in the palette, the user has to drag and configure the parame-
ters according to the need. Following are the blocks with their function:

• ROOMTEMP:  To measure the temperature of the space

• OccupancyOverrideCommand: To override the Unoccupancy Mode to Occupied 
Mode

• OccupancyStatus: explains the occupancy status in the wall module

• SensorOffset: To provide the sensor offset to the wall module

• ValueFromWallModule: To provide the value from the wall module to the controller

• SystemCommand: To override the system command from the wall module

• PassThru: PassThru block passes temperature inputs and transfers the value to 
network outputs.

• SavePermanent: It is used to save values in non-volatile memory. The value is not 
lost when the supply voltage is switched off. 

• Encode: The Encode function translates enumerations of a digital value into different 
enumeration numbers, allowing standard and custom enumerations to be combined 
and used together.
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TR42H Sylk Configuration and Logic

TR42 Sylk Configuration

The TR40 and TR42 are 2-wire, non-polarity sensitive, Sylk communicating wall mod-
ules, which communicate with all IRM, IRM® programmable controllers that are enabled 
with Sylk. 

The TR40 and TR42 are simple temperature wall modules with basic setpoint, override, 
and fan options, and are designed for a broad range of applications.

The TR40 and TR42 wall modules include:

• Two-wire, polarity insensitive Sylk provides both power and communication to the 
device.

• Models available with display (TR42) or without display (TR40).

• Models available with or without built-in humidity or CO2 sensors.

TR40 Sylk sensors are basic temperature sensors with no display & any option to over-
ride the current schedule or remote commanding capabilities.

Once the wall module is wired to the controller, you configure the wall module using the 
PC-based, Niagara Workbench Tool. This tool is used to configure the wall module for 
IRM controllers. The model tab under the TR42 configuration would be auto-selected 
based on the function block dropped in the wire sheet.
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Check to ensure that the Wall Module’s bus address which is configured using the dip 
switches (located on the back of the module) matches exactly with the setting of the 
configuration tool.

TR42 Logic Configuration

The function blocks are configured according to the requirement of the user. The sylk 
parameters are present in the palette, the user has to drag and configure the parame-
ters according to the need. Following are the blocks with their function:

• ROOMTEMP:  To measure the temperature of the space

• SensorOffset: To provide the sensor offset to the wall module

• PassThru: PassThru block passes temperature inputs and transfers the value to 
network outputs.

• SavePermanent: It is used to save values in non-volatile memory. The value is not 
lost when the supply voltage is switched off. 

• Encode: The Encode function translates enumerations of a digital value into different 
enumeration numbers, allowing standard and custom enumerations to be combined 
and used together.

• HUMIDITY: Measures the percent humidity of the Space.
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• CO2: Measures the CO2 concentration in the space
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TR42 Configuration (Encode-Snap)
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TR40 Sylk Configuration and Logic

The function blocks are configured according to the requirement of the user. The Sylk 
parameters are present in the pallet, the user has to drag and configure the parameters 
according to the need. Following are the blocks with their function:

• ROOMTEMP: To measure the temperature of the space.

• HUMIDITY: Measures the percent humidity of the Space.

• CO2: Measures the CO2 concentration in the space

C7400S Configuration and Logic

Once the wall module is wired to the controller, you configure the wall module using the 
PC-based, Niagara Workbench Tool. This tool is used to configure the wall module for 
IRM controllers. The model tab under the C7400S configuration would be auto-selected 
based on the function block dropped in the wire sheet.

Check to ensure that the Wall Module’s bus address which is configured using the dip 
switches (located on the module) matches exactly with the setting of the configuration 
tool. No other configuration is required to be configured for C7400S sylk sensors.
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Deleting Sylk Device
If you want to remove the Sylk Device from a configured station, follow the below steps.

To delete a Sylk Device

Step 1. Right-click on the required Sylk device from the Nav window. 

Step 2. Select Delete.

Or 

Double-click on Periodic program or Event program and navigate to Wire 
Sheet view, select the Sylk device, and press Delete.

Note: Whenever you add or delete any Sylk device or modify any Sylk params, an effective Sylk 
device will not perform a read and write function. This modification will not impact the read 
and write function of other commissioned Sylk devices.
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EnumSchedule Configuration
Step 1. Double-click ScheduleCofig on the EnumSchedule Property Sheet to con-

figure the scheduler properties.

Step 2. Select Master Sync Enabled to true. 
Step 3. Click ConfigData to view the AX Scheduler.

Note: Before you configure the ConfigData schedule properties, add supported devices into the 
Wire Sheet.

Figure  41. AX Scheduler

Step 4. Click Save to save the changes made.

Or click Refresh and then click No if you do not want to save the changes.
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The Sylk commissioning operation displays the error when the following conditions did 
not validate.

Note: Sylk wall module supports only 4 events per day, but IRM BACnet schedule supports 
more than 4 events per day. So, the user cannot edit the schedules in-wall module when 
more than 4 events are configured per day. 

Configuring Schedule event with a supported device

Step 1. Open the property sheet of the supported device model (Example: TR75 and 
TR120) 

Step 2. Set the Schedule Editable From Zio field to Yes.
Step 3. Change Param Permissions (Contractor Only, Tenant Read-only, and 

Tenant Write only) as per requirement.
Step 4. Change the Schedule Type as per requirement (8-day schedule/ 7-day 

schedule/ 5-2-1-day schedule/ 5-2-day schedule).
Step 5. Enter the schedule block location in the Schedule Block Location field.

Configuring Scheduler Block Location:

Step 1. Click Folder icon ( ) and select Component Chooser from the drop-down 
list.

Step 2. On the Select Ord window, Click Drivers > BacnetNetwork > 
IrmBacnetDevices > IRM Program > Event Program > EnumSchedule, 
and click OK.

Step 3. This action fetches the scheduler location to the EnumSchedule Block 
Location filed. 

Step 4. Click Save Or click Refresh to cancel the changes.
Or

Step 1. Go to Nav Window, navigate to the Station > Config > Drivers > BacnetNet-
work > IrmBacnetDevices > IRM Program > Event Program > Select Enum-
Schedule, and press Ctrl + L.

Or select Enumschedule in Wire Sheet, right-click select copy and then 
navigate to Schedule Config option and paste in the Scheduler Block 
Location field.

Step 2. This action opens the Ord window, copy the location, and then paste in the 
Scheduler Block Location field.

Step 3. Click Save Or click Refresh to cancel the changes.



312 EN2B-0414GE51 R1021

NIAGARA IRM ENGINEERING TOOL - USER GUIDE

Configuring Global Schedule event with Supervisor station

BacnetScheduleExport pushes schedules or calendars components to specific BACnet 
Schedule or Calendar objects in the Supervisor station.

Prerequisites: A working Workbench connected to a remote host station. The BACnet 
device should contains a schedule or calendar object to export.

The BacnetNetwork Bacnet Device > Schedules contains a Bacnet Schedule Export 
Manager view, which permits exposing schedule components in the station as either 
BACnet schedule objects or calendar objects. However, this server-type export makes 
exported components available to any networked BACnet device. It does not write to 
specific objects in a BACnet device, which acts as a client.

For exporting Schedule event using Bacnet Schedule Export Manager, refer Niagara 
4 BACnet Driver Guide or Niagara help file pages.

• Exporting a schedule: module://docBacnet/doc/ExportingAScheduleBACnet-
50F9036A.html

• Bacnet Schedule Export Manager: module://docBacnet/doc/bacnet-
BacnetScheduleExportManager.html

• BacnetScheduleExport: module://docBacnet/doc/bacnet-
BacnetScheduleExport.html

Note: IP VAV controller does not support priorityForWriting function for Global Schedule 
event. User need to disable priorityForWriting function for Schedule event. 
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To disable priorityForWriting function - After adding discovered Global schedule event 
in the database.Select the Global schedule event from the database, click Edit. 
In the schedule event edit window, click the skip writes property, and set 
priorityForWriting property to True. 

Configuring Enum Range

To define Enum range:

Step 1. Double-click on ConfigData > Properties tab > Facets option, select default 
range (honIrmControl: ScheduleStatesEnum), and click (>>) icon. 

Figure  42. Defining Enum range
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Step 2. Select the default EnumRange, click the (…) icon, and click the (>>) icon.

Figure  43. Default Enum Range

To add an entry in the Zio Enum Library:



EN2B-0414GE51 R1021 315

NIAGARA IRM ENGINEERING TOOL - USER GUIDE

Step 1. Select the blank fields.

Step 2. Enter the Ordinal value and Display information in the respective field and 
click Add.

Note: It is recommended to work with default facets configuration when the schedule is linked 
to the Sylk Device. If the user configures the facets value other than the default 
configuration, the Sylk module may not operate correctly.

To modify the entry in the Zio Enum Library:

Step 1. Select the entry.

Step 2. Modify the Ordinal value, Display field, and Tag field and click Modify.
Or 

Step 3. Change the Ordinal value, Display field, and Tag field and click Add.

Additional details about the Schedule are as follows:

• Event time tuning

• Event Output

• Right-click menus

Event time tuning – User can set the start and finish time for any selected event by 
selecting the hour's portion or minutes portion from the calendar (see below screenshot) 
Or directly entering the Event Start and Event Finish values in the respective fields.
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Figure  44. Schedule Event Time Selection

Event Output – The user can select the required output value from the drop-down list.

Figure  45. Schedule Output Value Selection

Right-click menus – The below table describes the available right-click menus (in the 
Schedule area) and their details/descriptions.

Options Descriptions

Delete Event Deletes the selected event.
Paste Day Appears only if the copy day option was used first. Copies all events into 

the selected day.
All Day Event Makes currently selected (or last entered) events extend to an entire day.
Apply M-F Copies all events in the selected day to Mon, Tue, Wed, Thu, and Fri (and 

overwrites any existing events on those days).
Copy Day Copies all events in the selected day, to use with paste day option.
Clear Day Clears all events on the selected day
Clear Week Clears all events in the entire weekly schedule
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Figure  46. Schedule -Right-Click menus
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Special Events

Each schedule functional block has its special events configured on a Special Events 
tab in its scheduler view. Event times and values entered for any special event apply to 
that schedule only. 

However, if the special event is a “reference” type, days of its occurrence are specified 
in the Calendar Schedule functional block that is referenced. This allows to globally 
change the days that special events occur in schedules, by editing one or more refer-
enced CalendarSchedules.

Figure  47. Schedule -Special events

Options Descriptions

Date (default) By various combinations of weekday, numerical date, month 
or month combinations, and year.

Date Range By start and end range, using for each a combination of day, month, 
year.

Week and Day By the combination of day of the week, week in the month, month.
Note: Calendar Week type will not support.

Custom BY combination of any day, month, weekdays, any week, and year
Note: Custom type events for Special events not supported by IRM 
Compact VAV.

Reference By reference to a specific Calendar Schedule component in the station
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Special Event Priority 

Note: Sylk wall module supports only 1 exception schedule to configure for holiday, but IRM 
BACnet schedule supports more than 1 exception schedule. So, the user can edit one of 
the first exception schedules in-wall module, the second exception schedule onwards 
cannot be edited in-wall module.

To implement this limitation, users need to configure the calendar object with multiple 
holidays and use calendar references to create an exception schedule in the IRM 
schedule.

Note: Wall modules, TR120X and TR75X got provision to edit the schedule for one holiday. 
Since IRM NX devices support a unique schedule for each holiday, when you integrate 
with TR120X and TR75X, the user can edit only the first holiday created in the schedule. 

When working with wall modules TR120X and TR75X, use the Calendar object to create 
multiple holidays and assign one schedule for all the holidays, so when the holiday 
schedule is edited, it will be applicable to all the holidays. 

Options Descriptions

Add Add a new special event (same as using Add button).
Edit Edit day(s) selection criteria (but not changing special event type). 

(Same as Edit button).
Rename Rename selected special event (same as using Rename button).
Priority (up) Move special events up in the priority list (same as using the Priority 

button).
Priority (down) Move special events down in the priority list (same as using the Priority 

button).
Delete Removes selected special events from the schedule component.

Limitation
If you want to create one event and apply to multiple days, follow the below steps:

Step 1. Add a Calendar function block in the wiresheet, define all the holidays 
dates and date ranges on the calendar.

Note: When using Schedule and Calendar in the application, controller 
time should be synchronized for the current time else the Schedule function 
block will have wrong references and might not work correctly. TSYNC is 
the best way to synchronize time in the controller.

Step 2. Navigate to EnumSchedule > ConfigData > Special Events, create one 
Exception Schedule, select calendar Type as Reference, and click OK.

Step 3. Now define the time events for this Exception Schedule. The schedule will 
execute these time events for all the dates defined in the Calendar.

Step 4. Wall module displays this exception schedule time events (as this is the first 
one) as Holiday time events on Display. 

Step 5. You can modify holiday time events. These modified time events get written 
back to the first Exception Schedule which is configured as Calendar Type 
as Reference. Hence same time events get applied to all the defined dates 
on the Calendar.
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Default Output 

Whenever a scheduled event (special or weekly) is not defined, the schedule block’s 
output (“Out” slot) is the default value shown below image. The white area in listed 
events indicates where the default value is used and displays the current default value. 
The default output value is also used whenever the schedule is not effective.

Figure  48. Schedule event default value

Note: Custom type events for Special events are not supported by the IRM Compact VAV 
controller. 

Note: Sylk Commissioning fails if the scheduled holidays have the number of configured events 
per day exceed four.

Note: Schedule configuration workflow changes - after changing any schedule changes in the 
tool perform Sylk commission.

Note: A total of maximum of 255 entries can be added in a Zio enum library.
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OTHER OPERATIONS OF IRM TOOL

Other Operations included in this IRM tool:

Firmware Download

Allows updating the firmware in the controller via download.

Procedure

Step 1. In the Database pane, select the controller.

Step 2. Click Download Firmware.

Firmware Download Bulk Operations
Commissioning IRM devices using 
HAWK 8000 Controllers Making Controller/Application Backup

Value Updates after Device Power 
Failure Reset to Factory Delivery

Hiding Slots Efficient commissioning from HAWK 
8000/ EAGLEHAWK controller

Bulk Operations
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Step 3. Navigate to the folder where the firmware file is located, then select the 
firmware file (IRMN4-IMG_Vxxxx.bin), and then click the Open button.

Result: The firmware download process is started as indicated on the top in the 
Firmware Download progress bar. When the firmware download is 
finished successfully, it is indicated by the "Success" message.

Note: While doing firmware upgrade on the MSTP VAV Controller, if a Station/ BACnet Server 
is moved from one device to another (in this case PC to JACE/Eagle Hawk OR vice 
versa), then MSTP VAV Controller may go to an unreachable state.

Solution

Reset/ Power Cycle the Controllers, those which have Ref In / Ref Out mapped to points 
to the Station / BACnet Server
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Commissioning IRM devices using HAWK 8000 Controllers

To commission IRM devices using HAWK 8000 controllers, HAWK 8000 station is either 
licensed for the CentraLine brand or licensed for the “honBeatsUnitaryProgramming-
Tool” feature.

If in the case in a job where IRM tool is installed in the third-party HAWK 8000 controller, 
i.e. non-CentraLine branded HAWK 8000. Then, the user needs to request to the offer-
ing channel to get the host ID licensed with the “honBeatsUnitaryProgrammingTool” fea-
ture. Once the host ID is licensed with the “honeywellBeatsProgrammable” feature, the 
user can commission the IRMNX controller on the third-party HAWK 8000 controller.

Note: User can upgrade an IRM tool from lower version to higher version, once upgrade to a 
higher version, user cannot downgrade to a lower version.

Example: Upgrade IRM tool from 4.8.0.2.1.0.14 to 4.8.0.2.2.0.19 version, once upgrade 
completes, user cannot downgrade to 4.8.0.2.1.0.14 version.

Value Updates after Device Power Failure 

If a device had a power failure and the device is restarting, it will take 3 - 5 minutes until 
the values will be updated in the wire sheet. To accelerate the value update on the wire 
sheet, please manually refresh the wire sheet by navigating to another page and return-
ing to the wire sheet. 

RJ45 Connector for BACnet WiFi Adapter

A BACnet Wifi Adapter can be connected to the controller's RJ45 connector in order to 
establish wireless communication with a PC with COACH NX so that the application 
engineer can commission the controller.

Recommendation:
• Maximum10 devices connected to the controller's BACnet MS/TP interface.

• Max Master for all the controllers which is connected to the Adapter via MSTP has to 
be 35,since BAC-A Adapter Max Master is 35.

Note: When the BACnet Wifi Adapter is connected to the controller's RJ45 connection, it is 
powered by the controller. It is then prohibited to simultaneously power the BACnet WiFi 
Adapter via a wall adapter. When, on the other hand, the BACnet WiFi Adapter is instead 
connected to the controller's BACnet MS/TP interface, it is prohibited to simultaneously 
use an RJ45 plug; instead, the BACnet WiFi Adapter must then be powered by a wall 
adapter (standard 5-V USB wall adapter with micro USB connector).

Note: When using the BACnet WiFi Adapter (BACA-A) to commission the controllers, the 
following steps should be followed:
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1) Set the property maxMaster to a value of 35 for all controllers on the MS/TP bus to 
which the BACnet WiFi Adapter is to be connected.

2) Ensure that one of the following MAC addresses is free on this MS/TP bus: 31 or 32 
or 33 or 34.

3) Connect the BACnet WiFi Adapter to the MS/TP bus.

Caution:  It is permitted to connect only the BACnet WiFi Adapter to this RJ45 connector. Do 
not connect IP.

For more details on install BACnet Wifi Adapter, refer BACnet Wifi Adapter (BACA-A) - 
Mounting / Operating Instructions guide - MU1B0592-GE51.

Steps to configure BACnet WiFi Adapter

Step 1. Run Niagara Workbench and add BacnetNetwork under supervisor station.

Step 2. Expand BACnetNetwork. 
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3.Expand Bacnet Comm > Network > double-click on IP Port.

Step 3. Select the BACnet Wifi adapter from drop-down list. Make sure the Station 
and BACnet Wifi adapter in same subnet in the computer.

Step 4. Click Save. 
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Hiding Slots 

Procedure

Step 1. Right-click the function block icon, of which you want to hide slots. 

Step 2. In the context menu, click Pin Slots.
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Step 3. Click the slot you want to hide.

Step 4. Click OK.
Step 5. The function block symbol redisplays. The hidden slots are removed from the 

display

Note: Any slots manually hidden in the Pin Slots dialog are not stored in the controller. After 
clearing the project and learning the application back from the controller, the hidden slots 
will be visible again.
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Bulk Operations

Changing Multiple Datapoint Names

Purpose: Quickly edit multiple datapoint names of the same type in batch process to 
maintain unique names across the project.

Procedure

Step 1. In the Nav tree, expand the Services folder and double-click ProgramSer-
vice.

Step 2. Click the Find Objects button. This action opens the Bql Query Builder dialog 
box.

Step 3. In: click the magnifier search symbol to search for the device. 
Step 4. The Choose Root dialog box displays.

Step 5. Select the device, and then click OK.
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Step 6. The Bqi Query Builder dialog box redisplays and shows the selected device 
name.

Step 7. From the Of type drop-down listbox, select 'Custom Type'.

Step 8. From the drop-down listbox added right to the Of type drop-down listbox, 
select honIrmControl.
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Step 9. From the next drop-down listbox, added right to the Of type drop-down 
listbox, select the datapoint type, e.g. 'BACnet Boolean Input'.



EN2B-0414GE51 R1021 331

NIGARA IRM ENGINEERING TOOL - USER GUIDE

Step 10. Click OK.
Step 11. The datapoints found are listed on the Batch Editor pane.

Step 12. On the bottom of the Batch Editor pane, click the Rename button. The 
Rename dialog box displays.

Step 13. In the Replace field, enter the name you want to use for replacing the current 
datapoint names, e.g. 'D017' should be added as a prefix to the existing 
datapoint name 'BBI'. If desired, check additional options Match case and/ or 
Match the whole word.

Step 14. Click OK. The replacement results are displayed in the Batch Editor Results 
message box.
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Step 15. On the wire sheet, the datapoint names are changed accordingly.

Step 16. Perform Teach to Controller operation in the application. This action 
implement all the changes in the BACnet points.
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Making Controller/Application Backup 

There are two ways of backup the controller:

• Backup the station of the controller 

• Backup the application of the controller 

Station Backup Of The Controller 

Steps to perform Station Backup

Step 1. Navigate to the controller station.

Step 2. Right-click the Station node and select Backup Station.

The station continues running while first, it saves its configuration locally, then saves a 
backup.dist file in the backups folder of your niagara_home (install) folder.

Backup The Application Of The Controller 

Steps to perform application Backup

Step 1. Navigate to the File system in the Niagara Workbench.

Step 2. Right-click the location > New > click Pallete file.palette
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Step 3. Enter the Pallete name and click OK.

This adds the backup palette folder in the user local system.

Step 4. Navigate to the Palette and open the Palette window.
Step 5. Enter baja and select the Niagara Framework module.

Step 6. Select the UnrestrictedFolder and drag-drop under the Pallete folder. 
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Step 7. Enter the name of the UnrestrictedFolder and click OK. 

Step 8. This creates the backup folder.
Step 9. Navigate to BACnetNetwork, right-click on the device/controller and click 

Copy.

Step 10. Navigate to the backup folder and paste the device/controller configuration. 
This saves the device/controller configuration on the user's local system.

Note: No change should be made in the device/controller configuration file, once it is pasted in 
the backup folder.  
Any change in the pasted device/controller configuration file will damage the file. 

This completes the device/controller backup. 

Users can restore this device/controller backup file on any other station. 

Steps to Restore the Backup

Step 1. Open the Palette and click browse using a file chooser. 

Step 2. Locate the backup file in the user's local system and open the file.
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Step 3. This opens the device/controller backup file in the Palette window. 

Step 4. Drag-drop the device/controller backup under the new BacnetNetwork.
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Reset to Factory Delivery

In case you want to factory reset the IRMNX controller, follow the below steps:

Step 1. Power off the controller

Step 2. Power on the device, while holding service pin button pressed
Step 3. Wait for about 10-15 seconds till communication LEDs (Rx & Tx) blinks
Step 4. After that release the service pin button.

After performing the factory reset, the following changes happen in the controller.

• All the configuration of the application is cleared from the controller.

• The MAC address will be set to 0xFF, meaning that the controller will now search for 
a new mac address. Auto MAC will be triggered once the controller receives the “you 
are” command.
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Efficient commissioning from HAWK 8000/ EAGLEHAWK 
controller

While commissioning more than 30 controllers on a single MS/TP two factors impact the 
performance.

• CPU of the controller

• Memory available in the controller

Navigate to Resource Monitor to check CPU and Memory available in the controller.

Note: HAWK 8000/ EAGLEHAWK has limited memory available on the controller. Follow the 
below recommended step to perform commissioning effectively.

Recommendation for batch commissioning
• Recommendation in terms of CPU load – Controller memory usage is up to 70% for 

all the Unitary Controllers while working on HAWK/EHN4/Supervisor 
Station.
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• Recommendation in terms of Memory load – It is advised not to load more than 50% 
of the controller memory (Heap used). 

Note: Before you initiate the batch operation, it is advised to disable all the configured points, 
histories, and alarms. Disabling points, histories and alarms will help to reduce the load 
on the BACnet channel and help to commission the application faster.
After the batch operation completes, you can enable all the configured points, histories, 
and alarms.

Steps to run batch commission

Step 1. Create a station. 

Note: Make sure to keep the offline controllers in Swap Out mode.

Step 2. Commission all the controllers (By default the controllers will be in swap-in 
mode).

Step 3. Navigate to the IRM BACnet Device Manager view.
Step 4. Select the controllers and click Swap In.

Note: Based on the available memory, select the controllers. It is advised not to load beyond 
50% of the available memory space.

Step 5. Now perform any of the following operations on controllers.
• Application Full Teach to the Controller or Teach to Controller

Note: For first time commissioning, "Full Teach" is recommended

Step 6. Wait till the operation get completed.



EN2B-0414GE51 R1021 340

NIGARA IRM ENGINEERING TOOL - USER GUIDE

Step 7.  Click Swap Out.

Note: If more than 50% of the memory space is utilized. Then perform the operation in slots.

Example: Select 10 devices or (determine the number of devices based on the load). Perform the 
batch teach to the controller, then Swap Out. Similarly, select the next 10 devices and 
perform the same steps.

Best Practices and Troubleshooting TIPs

Below listed are recommendations for larger sites that include more than 30 controllers 
per MS/TP channel. 

• Make sure the IRM BACnet Device Manager view is closed always unless required, 
mainly after initiating the Bulk Actions like

• Normal Teach to Controller or Full Teach to the Controller

• Clear Controller

• Learn from Controller

• Working on wire sheet under Periodic/Event Program at the device level.

This will help the User to avoid MS/TP Traffic in the Bus and the Time taken/response to 
complete the actions will be faster 

• When the BACnet Points/Schedule is modified over the BACnet or the Sylk Wall 
Module then IRM Synch states change to “Controller differs from Project” State. To 
get it Synch State. user must Clear the project and Learn from the Controller.

• When Application Full Teach is initiated with 30+ controllers, there may be a failure 
for 1 or 2 controllers with App Power Cycle Error/Lockup Error. 

• Retry Application Full Teach to the failed devices then it will be successful.

• Similarly, while performing actions like Clear/Teach/Learn, it may fail with Transaction 
Id error. 
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• Retry the same action again for the failed devices then it will be successful.

• Teach fails with Buffer Overflow which is a very rare observation. 

• Retry discover devices and Teaching again will be successful.

• Before initiating the Firmware download, Swapping Out IRM Application could 
improve the Firmware download time.

• It is highly recommended to Swap Out the IRM Program after commissioning, this will 
avoid unwanted traffic in the system and reduce HEAP usage in the HAWK 8000/ 
EAGLEHAWK controller restarting of Station in HAWK 8000/ EAGLEHAWK will be 
less than 5 minutes.

• When you see Rejection Proprietary during teach, make sure the IRM tool and 
Firmware versions are compatible, refer to Release Bulletin.

• Refer to the Help document before configuring the Special events in Sylk WM

• ORD: local:|module://honIrmControl/doc/honIrmControl-WmConfigHvacA.html.

• Don’t delete any of the nodes below the IRM Program, which will lead to re-add the 
complete IRM program from the palette, if no backup is maintained.

• Always see BACnet Device Manager View or Control Manager to view the sync status 
of the device

• It is always advised to take a snapshot of controllers and station backup once all the 
necessary configurations and device status are in sync and operational.

• Users can upgrade an IRM tool from a lower version to a higher version, once 
upgrade to a higher version, the user cannot downgrade to a lower version. 

Example: Upgrade IRM tool from 4.8.0.2.1.0.14 to 4.8.0.2.2.0.19 version, once upgrade completes, 
user cannot downgrade to 4.8.0.2.1.0.14 version.
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